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1 Viz World Classic Introduction

This is the user guide for Viz World Classic (previously known as Viz Curious Maps). It is designed to fit people with
no or little experience in using the Viz World Client and Server. The purpose of this document is to help new users
become familiar with the client; to illustrate the client’s editor, and to show the available options.

This guide provides reference information about the program’s more advanced features. These include selecting
map details, working with style sheets, importing and working with street data, adding text and graphics, creating
drawings from vector shapes, adding effects with lighting and effects, and controlling animation.

1.1 Document Structure

Title

Quick Tour

Working with
Maps

Working with
Styles

Reusing
Design
Elements

Working with
Street Maps

Adding Text to
a Project

Working with
Images and
Movies

Content

Provides a complete introduction to using Viz World Classic on the PC, and is
the recommended starting point for anyone learning to use the program. It
provides a series of short worked examples, each of which takes you on a
quick guided tour of the program’s key features to show what it can achieve
and help you become familiar with the user interface.

Explains the options for creating and working with map layers, including using
the Properties panel to define the projection, and using the Contents panel to
select countries and places for incorporation into the map.

Explains how to use the style sheets to make it easy to set up a series of house
styles, and convert projects between house styles with a single click. It also
explains how style sheets help to establish consistency across projects, or
between designers.

Explains how you can easily reuse styles, layers, and colors created in
earlier projects and gives recommended techniques for setting up and sharing
style sheets, templates, and projects between users.

Explains how to import street data and draw it on your maps to create maps
from the whole world, down to a single street corner or building.

Explains how to incorporate text into projects, and describes how to control
the appearance of the text and the way it is animated.

Explains how to incorporate bitmap images and movies into animations, and
describes the controls available for altering their appearance, and controlling
the way they are animated.
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Working with
Shapes

Working with
ESRI Shape
Files

Lighting and
Effects

Controlling
Animation

Rendering a
Project
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Content

Explains how to add drawings to a map by creating vector shapes, either using
separate shape layers or by adding shape details to map layers. It also explains
how you can create and edit shapes, and change their appearance to achieve
exactly the effect you want.

Describes how to import map data in ESRI Shape File Format, and configure it
for use with Viz World Classic.

Explains how to use the lighting and effects features, to enable you to add
shading and depth to your map animations and give them a unique and
distinctive appearance.

Explains how to use the time slider to control the progress of an animation. It
also describes how to use the tool to set up impressive animations with a few
simple clicks, and the Keybars panel to provide individual control over each
component of a project.

Explains how to render your animation as a preview, or as a finished movie. It
also describes the options for exporting an image or a 3D model from a
project.

1.2 Related Documents

For complementary information, see the following documents:

e Viz Artist User Guide: Information on how to create graphics scenes in Viz Artist.
e Viz World User Guide: Information on how to use Viz World Client and Server to setup a map server solution
and build map template graphics for newsroom and control room systems.

For more information about all of the Vizrt products, visit:

* www.vizrt.com

e Vizrt Documentation Center

* Viz University

1.3 Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback and/or
suggestions, please contact your local Vizrt customer support team at www.vizrt.com.
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2 About Viz World Classic

Viz World Classic, formerly called Viz Curious Maps, is the standalone edition of Viz World that allows designers to
create branded, animated 2D maps.

Viz World Classic is ideal for designers, program researchers, and producers who need to create high-quality map
animations for news, documentary, promotional videos, and the World Wide Web.

It is designed to be simple and intuitive to use, so that users with no specific training in computer graphics or video
editing can create professional maps on demand and at short notice.

This section contains information on the following topics:

® Comprehensive Map Database

¢ Street Data Configured Ready for Use

® Projects, Layers and Other Elements

¢ Establish House Styles for Consistency Across Projects
® Shapes

* Rotoscoping with Shapes

* Animation

® Compositing and Animation

¢ Painting and Effects

¢ Sophisticated Lighting and Filtering Effects
® High-quality Output

2.1 Comprehensive Map Database

At the heart of Viz World is the comprehensive Collins Bartholomew database of the world, defining countries,
towns, and other features such as lakes, rivers, roads and railways. You can choose between a range of alternative
projections for each map, with control over the scale and viewpoint.

Individual items can be selected from the database and incorporated into the project with complete control over
their appearance.

You can also combine maps at different scales, such as to include an inset showing an enlarged view of one region
from another map.

The Viz World database also include height information, from satellite images, giving you the option of displaying
mountain ranges in relief to give physical information about the area being displayed, or simply for an impressive
visual effect.

2.2 Street Data Configured Ready for Use

In addition to the database, Viz World Classic can also import street data in its own street data format. This provides
a wide range of roads, railways, rivers and lakes, parks, buildings, and other municipal features, labeled and
configured ready for immediate use, so you can create maps and animations that take you down to the level of
towns, street corners, and single buildings.
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2.3 Projects, Layers and Other Elements

Viz World Classic offers an integrated paint, rotoscoping, effects, compositing, and animation system. Designed
around a powerful multi-layer approach, Viz World Classic is equally applicable to the creation of still images and
movies.

When working in Viz World Classic, you are always working on a project. The resolution, bit depth, frame rate, and
duration of the output movie are all settings of the project. These are set at the start, but may be changed at any
time.

A project can be built up from an unlimited number of layers. There are five different types of layer: image layers
(still images), movie layers, text layers, rotoshape layers, and map layers. All layer types have two components: the
RGB image itself, and an alpha channel which determines how the layer is composited.

Image layers and movie layers also have an associated mask. The mask is essentially an additional single-channel
image which can be painted and processed using the same tools as for the main image. Image layers have a single
mask, while movies have a mask for each frame of the movie.

Masks can be used in several different ways: to protect portions of the image from change during painting or image
processing operations, to define the arbitrary shape of an element to be cut from a layer (a cutout), to control the
way in which the layer is composited, or to protect portions of the layer from change by other layers composited
above.

Various other types of elements can be created and used within Viz World Classic. These are collectively referred to
as overlays. There are three types of overlay: text, shapes, and cutouts (from an image, often using the mask to
define the form). Overlays are not associated with any particular layer. They are retained as floating objects and
may be stuck down at any time onto any image or movie layer. Alternatively any overlay can be converted to a layer
for animation, and cutouts can also be converted into brushes for painting.

2.4 Establish House Styles for Consistency Across Projects

The Viz World Classic style sheets make it a simple matter to create map animations to a specific house style, and
once you have created an animation changing it to a different house style is simply a matter of loading in the
appropriate style sheet. Style sheets control all the important aspects of a map animation, including the color
schemes, typefaces, line weights, and lighting or relief effects. The style sheets also maintain consistency across
projects or between designers.

You can also create template files containing predefined elements, such as background maps, standard graphics,
logos, and titles for reuse in a range of related animation projects.

2.5 Shapes

Viz World Classic includes a complete range of drawing tools to allow you to create and edit drawings directly within
the program. You can create drawings by combining shapes in one or more shape layers, with complete control
over the animation and appearance of each shape in the drawings. You can also add shape overlays to map layers,
to allow you to highlight or annotate any features of the map, with a powerful tracing tool to allow you to construct
shapes by tracing map features.
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2.6 Rotoscoping with Shapes

Viz World Classic allows you to create, edit, and animate vector shapes. These may be polygons, B-Spline or Bezier
curves, or freehand shapes. They can be used to create masks, rendered directly into images, or exported for use at
a later time.

Shapes can be animated using a combination of key-framing of individual points and the movement, rotation, and
scaling of complete shapes. This gives great flexibility when using shapes to create rotoscoped mattes for moving
elements. The underlying movement of a feature can be captured by setting a few key-frames for complete shapes
and then the shapes can be refined at any frame by editing individual points.

You can also soften specified edges of each shape, which is invaluable when making mattes to match something
that is moving quickly and has motion blur on each frame.

2.7 Animation

Viz World Classic provides an Auto Animate feature that lets you add animation to your project by selecting a few
simple options. You can fade objects in or out of view, and slide objects in or out of frame, with acceleration or
deceleration to give a natural appearance.

For more sophisticated effects Viz World Classic gives you complete control over each component of your
animation, allowing you to animate objects along an arbitrary animation path with complete control over their
shape and position.

2.8 Compositing and Animation

Straightforward compositing is simply at matter of arranging the layers in the order in which they are to be
composited, by dragging and dropping. Sophisticated composites can also be created very easily by using masks
and alpha channels, and their associated controls, to determine how layers interact.

All layers remain separate and editable right up to the point of generating the final artwork. Layers can be moved,
scaled, rotated, and filtered independently, can have any number of animated effects applied. They can also have
independent transparency settings, drop shadows, and lighting.

Every image and movie layer has a selection of built-in Keyers available for direct compositing using either
luminance, chroma, or color keying. The quality of the edges can be carefully controlled to achieve the most
convincing

results possible.

Every image and movie layer also has an integrated Roto Matte which allows you to add rotoshapes directly to the
layer to cut out selected features. The results are displayed dynamically as you adjust the shapes, and the same
flexible range of editing and animation options as for shape layers is available.

You can change the source material or content of any layer in a single operation at any time, without losing any of
the animation or other control settings. This makes it easy to set up templates and then generate a series of images
or movies

based on the same underlying design, but with varying content.
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2.9 Painting and Effects

Viz World Classic provides a large range of painting, graphic, and image processing tools for use on image and
movie layers. These are ideal for the freehand origination of artwork, or for retouching and editing existing material.

In contrast to the animatable transformations, lighting, and effects which can be applied to all layers, painting work
explicitly changes the actual content of an image or movie layer.

A wide range of built-in and user-definable brushes are provided for work on images or masks, including color,
offset merge, clone, drag, blur, and other effects. The brushes are pressure sensitive with user-definable profiles,
and optional onion skinning facilitates accurate cloning, merging, and wire or rig removal.

Many tools are provided for creating, editing, and applying text, shape, and cutout overlays, and a very large
number of different filters and effects can be applied. Any operations can be repeated over multiple frames using
macros.

The changed material created by painting operations is stored independently, leaving your original materials
unaffected. At any stage you can render a finished version, incorporating all your edits, or revert to your original
material if you want to discard changes.

2.10 Sophisticated Lighting and Filtering Effects

Viz World Classic allows you to add lighting effects to each layer in your project to add realistic shading and
highlighting to the images, or to emphasize specific features. You can also add one of a range of effects to the
animation to blur images, or adjust the brightness or contrast.

2.11 High-quality Output

As you create your animation the frame you are working on is rendered complete with anti-aliasing to show you the
quality of the finished result. At any time you have the option of previewing the complete animation, or rendering it
at high quality as single frames or as a movie file to create a finished broadcast quality video.

With suitable video output hardware the animations can be played out as broadcast-quality PAL or NTSC
sequences. The following video hardware is supported: DPS Reality Studio Digital Disk Recorder, and video output
boards capable of playing QuickTime or AVl movies, or accepting single-frame-per-file output. Contact your local
Vizrt representative for updated information about supported hardware configurations.
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3 Installing Viz World Classic

Viz World Classic is installed in two steps; first the database and then the actual design application.
This section contains information on the following procedures:

¢ To Download the Software

To Install Viz World Data

To Install Viz World Classic

To Add the License File

To Add the License File Using Viz World Classic

3.1 To Download the Software

While you have an active map support contract, you have a personal login to the Vizrt FTP server. Download the
software from the Vizrt FTP at http://download.vizrt.com/ or ftp://download.vizrt.com/ under the Viz World folder.

Please use the FTP server to find the latest Vizrt software releases, documentation, help files, drivers and more. You
can also use the FTP to upload and exchange files with Vizrt.

3.2 Tolnstall VizWorld Data

1. Start the Viz World Data installer.

2. Click Next.

3. Click Install to begin the installation.
4. Click Finish.

3.3 Tolnstall VizWorld Classic

Before Viz World Classic is installed, you have to install the Viz World Data.

Note: Exit all Windows programs before running the Setup Program.

. Start the Viz World Server installer VizWorld24.1.0.msi.

. Click Next.

. Read the End-User license agreement and accept it.

. Click Next.

. Select destination directory, and click Next. Default installation directory is: C:\Program Files\vizrt\Viz World

. Click Install to start the installation.

. Click Finish.

. Optional: Install QuickTime if it is not previously installed. If a newer version of QuickTime is installed the
installation is stopped.

o ~NoUbh WN R

° Tip: If you do not already have QuickTime installed you can download the installer from the Apple website.
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3.4 To Add the License File

Once Viz World Classic is installed, drop the supplied license into your license folder: C:\ProgramData\vizrt\Viz
World\Licenses\curiousmaps.lic.

3.5 To Add the License File Using Viz World Classic

When starting Viz World Classic without a license, a window appears telling that no license can be found.

1. Start the Viz World Classic application.

2. Click the License button to open the Software License window.

3. Click the Edit License File ... button to open the Edit License window.

4, Click the Add License from a File... button to browse for the License file (*.lic).

5. Select the License file and click Open. The license becomes visible in the Edit License window.
6. Click OK to save the License. The license is saved to the License folder.

7. Exit the application and run Viz World Classic.
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4  Quick Tour

This section provides a quick tour of the key features of Viz World Classic, including the components of the Viz World
Classic window, and an explanation of how they are used in the creation of map animations.

This section contains information about the following topics:

Getting Started with Viz World
Toolbar

View Options

Viewer

User Interface Font

Layers List

Using the Content Manager
Controlling Layer Compositing
Animation Controls

Move and Pan Tool

Path Tool

Text Tool

Zoom Tool

Map Rectangle Tool

Browse Map Tool

Browse Street Shape Data Tool
Ruler Tool

Pick Color Tool

VWC Navigator

Panels
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4.1 Getting Started with Viz World

This section contains information about the following topics:

* Creating a New Project
® Changing the Project Settings

4.1.1 Creating a New Project

When you run Viz World Classic the following Welcome dialog box is displayed to allow you to open an existing
project, create a new default project, or use a project template:

p
Viz World Classic - Welcome @

(") Open an existing project

() Create empty project
() Create paint project

(@) Create map project

(") Use a project template

Show on Startup

¢ Select Create map project and click the OK button to continue.

4.1.2 Changingthe Project Settings

When you create a new project it is created with the frame size, frame rate, and map database you last used; initially
these default to:

* Frame size: PAL 768 x 576
¢ Rate: 25 frames per second
e Database: World Database

To Change the Project Settings

1. On the File menu, click Project Settings.... The Project Settings dialog box allows you to specify the frame
size, frame rate, and duration for the animation, in addition to several other more advanced settings
associated with the project:
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Project Settings @

Frame Size
HDTY v | Width 13920
Fix Aspect Ratio
Height 1080
@ 8 bit 16 bit

For video projects choose a Square Pixel frame size.
Images will be automatically scaled to the correct Video frame size when rendering.

Time
Duration 00:00:02:00 Rate 25 v frames per second

@ Preserve animation timings
() Retime animations ta fit new project duration

Units @ Timecode
() Frames
Painted Images
@ Save in the same folder as the project file (Recommended)
(") Save in central Painted Material folder, as set in the Options... window

[ 0K ][ Cancel ] _?I

2. Choose the settings as required and click the OK button to save the changes. The first time you create or
open a project there is a short delay while the map database you have selected is loaded. The Viz World
Classic window is then displayed, initially showing a map layer containing the world in a default globe
projection, scaled to fit in the project area.

The following image shows the key features of the Viz World Classic window:
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Each component is described in greater detail in the following sections.
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4.2 Toolbar
DEFE sB2EX JEEITY 3 468 B8 O 00 A4 T

The toolbar provides toolbar button equivalents to the most frequently used menu commands.

The toolbar options, from right to left, are:
.0 New
. & Open

Save project

b Cut

.
o
[}
[e]
2

[ ]

—
-
Q
(%]
—+
(0]

X Delete selection

Refresh
Load image

8 .
== | oad movie

3 Add map
m

4 Add text layers
o 7

{0
=* Auto animate

4 Styles editor
. & Project Settings

=
Street data

o % Import map data

&

a Render project

Symbols

“ Render preview

2 Movie player

1A Windows media player

. &R
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4.3 View Options

Viz World Classic allows you to choose whether or not to display the Layers list, Panels, Navigator, and Animation
controls. You can also turn the Layers list, panels, or Navigator into floating palettes, so you can position them
where you like on the screen. These options are particularly useful if you are working on a screen with a resolution
of less than 1280x1024 pixels.

4.3.1 To Turnthe Layers List, Panels, or Navigator into a Floating Palette

On the View menu, point to Layers, Panels, or Navigator as appropriate, and then click Floating.

4.3.2 To Hide the Layers List, Panels, or Navigator

On the View menu, point to Layers, Panels, or Navigator as appropriate, and then click Hidden. You can also hide a
floating palette by clicking its close box.
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4.4 \iewer

Displays the currently selected frame of the animation. You can display Viewer controls to allow you to scale or
scroll the image displayed in the Viewer.

4.4.1 Keyboard Shortcuts
The following keyboard shortcuts can be used in the Viewer:

¢ Pan: Hold down SPACE and drag with mouse.

® Zoom In: Press CTRL + ARROW UP, or hold down ALT + SPACE or CTRL + SPACE and click or drag with the
mouse.

® Zoom Out: Press CTRL + ARROW DOWN, or hold down SHIFT + SPACE and click or drag with the mouse.

¢ Zoom 1:1: Press CTRL + ENTER.

* Next Frame: Press CTRL+ ARROW RIGHT.

* Previous Frame: Press CTRL + ARROW LEFT.

To Show or Hide Viewer Controls
¢ Click the Viewer controls button to the left of the Viewer.

The following Viewer controls are provided:

R || | IR R ,

* Viewer Controls: Enables and disables the viewer controls bar and scroll bars.

RGB and Gray: Enables and disables the RGB values and grayscale value.

Scale: Scales the map according to the viewer.

Fit: Fits the map according to the viewer’s available space.

1:1: Fits the map according to the project’s frame size settings (the defined aspect ratio).

4y

To Scale the Image in the Viewer

Edit the value in the scale box, or choose a predefined scale from the drop-down menu.

To Fit the Image to the Viewer
Click the Fit button.

To Restore the Scale to 100%

Click the 1:1 button. The scale is also restored to 100% if you hide the Viewer controls.
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4.5 User Interface Font

Viz World Classic allows you to select the font used throughout the user interface. You should only need to do this if
you are using international characters, such as accented characters, and they are not displayed correctly.

4.5.1 To Change the User Interface Font

Options X

General | - ‘ Intemationalised User Interface Font
Map Labels

{International Font:
Shape Controls -
LUT Settings File | Tahoma =) 12 [z
Proxies

= Keyboard
Shortcuts
Tool Modifiers

Template

= Map Data
Shared
DEM
Database
Locations
Attribution
Map Legend
Map Projection
Virtual Earth
Digital Globe

| Amabione

Use this option to specify the font for those controls in the
user interface which can show interational strings.

111

|"

1. On the View menu, click Options...
2. In the Display section select International Font.
3. Select the font and size you want to use.
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4.6 Layers List

ach of the layers in the project is shown in the Layers list to the right of the Viewer. For each layer this shows
whether the layer is visible, the name of the layer, an icon representing the composite mask options, and a
thumbnail image of the layer. For map and image/movie layers, a thumbnail image of the contents of the layer is
shown.

A selected layer is highlighted, and the panels, controls, and tools all operate on the currently selected layer.
The order of the layers in the Layers list determines the order in which they are composited in the Viewer.
The displayed names for layers are as follows:

¢ Layer type: Name displayed.

* Map: Map layer.

¢ Image/Movie: The filename of the image.

¢ Text: The text on the layer.
Shape: Shape.

For text, image, or shape layers a pin icon to the left of the name shows whether the layer is pinned to the map layer
below it.

For map layers, a lock icon is displayed if the layer is locked to another map layer below it.
This section contains information about the following procedures:

® To Display the Composite of All Layers
¢ To Display an Individual Layer

® To Show or Hide a Layer

® To Create a New Layer

® To Select a Layer

¢ To Rearrange the Order of Layers
® To Cutor Copy a Layer

* To Paste a Layer

® To Delete a Layer

® To Duplicate a Layer

® To Pin a Layer to a Map

® To Lock Two Map Layers Together
® To Rename a Layer

4.6.1 To Display the Composite of All Layers

Display: @ Composite () Single Layer
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Select the Composite display option above the Layers list. This displays the result of compositing all the layers in
the project, taking into account the layer mask options for each layer.

4.6.2 To Display an Individual Layer

Display: () Composite @ Single Layer

Select the Single Layer option above the Layers list. The Viewer then shows only the currently selected layer. This is
convenient if you want to work on a single layer without seeing the effect of other layers within the project.

In single-layer mode the Layers list shows an eye-dropper icon to indicate which layer is used as the background
layer, for operations such as onion skinning and the merge brush. Click the eye-dropper icon to change the
background layer.

4.6.3 To Show or Hide a Layer

Click the eye icon to the left of the layer name.

4.6.4 ToCreate a New Layer

On the Layer menu, point to Add Layer, and then click the appropriate option. See the appropriate chapter Working
with Maps, Adding Text to a Project, or Working with Images and Movies, or Working with Shapes for information
about adding a map, text, image, or shape layer respectively.

4.6.5 To SelectaLayer

950412.jpg

€«

Click the layer in the Layers list. The currently selected layer is shown highlighted in the Layers list.
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4.6.6 To Rearrange the Order of Layers
K 950412, =
G 2

@ Map Layer

Drag the layer to the new position in the Layers list.

4.6.7 To CutorCopy alLayer
Either:

1. Select the layer.
2. On the Edit menu, click Cut or Copy, or click the Cut Selection or Copy Selection button on the toolbar.

Or:
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Cut Layer

Copy Layer k
Paste Layer

Paste Insert Layer

Delete Layer

Hidden
Duplicate Layer

Rename Layer...

Convert Fields...

Render Layer...

Render Layer Preview...
Render Mask...

Render Matte...
Conform Layer...
Conform Mask...

Export Painted Frames...
Export Painted Masks...

Match Time Range to Movie...

Text
Ctrl+X

Ctrl+C
Ctrl+V

Del
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¢ Right-click the layer and from the appearing context menu select Cut Layer or Copy Layer.

4.6.8 To PasteaLayer
Either:
1. Select the layer.

2. 0n the Edit menu, click Paste or Paste Insert, or click the Paste button in the toolbar.

Or:

¢ Click the layer with the right mouse button, and click Paste Layer or Paste Insert Layer on the pop-up menu.
¢ Paste Layer: Adds the layer to the top of the Layers list.

* Paste Insert Layer: Adds the layer above the currently selected layer.
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4.6.9 To Delete alLayer

Either select the layer, then in the Edit menu, click Delete Selection , or click the Delete Selection button in the
toolbar. Alternatively, you can click the layer with the right mouse button, and click Delete Layer on the pop-up
menu.

4.6.10 To Duplicate a Layer
Hold down CTRL and drag the layer you want to duplicate to the appropriate position in the Layers list.

4.6.11 ToPinalLayertoaMap

Click the pinicon to the left of the layer name. The text or image then moves (and optionally scales) with the map
layer below it. To unpin the layer click the pin icon again.

4.6.12 ToLock Two Map Layers Together

| Map Layer h

Click the lock icon to the left of the layer in the Layers list. Locking a map layer fixes it at the same size, scale, and
projection as the base map. This is useful for drawing selected regions of a map using a different style sheet from
the main map. For more information see the chapter Working with Maps.

4.6.13 ToRename alLayer

1. Either:

a. Select the layer.

b. On the Layer menu, click Rename.
2.0r:
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Rename layer m

Map of Burgundy ‘

I DK ] [ Cancel ]

a. Right-click the layer and from the appearing context menu click Rename Layer. The above dialog
box allows you to enter a new name for the layer.
3. Then enter the name and click OK.
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4.7 Usingthe Content Manager

The Content Manager displays an entry for each layer in the project, showing the image associated with the layer,
the alpha channel, and the paint mask. The Animation controls in the lower right corner of the Content Manager
allow you to select which frame is displayed.

4.7.1 To Display the Content Manager
Either:

¢ On the Tools menu, click Content Manager.
Or:

¢ Click the Content... button above the Layers list.

4.7.2 To Copy Content

You can copy any image, alpha channel, or mask within a layer or to another layer, by dragging and dropping it
within the Content Manager.

1. Select Current Frame to affect only the current movie frame, or Multiple Frames to copy multiple frames.

2. Select the appropriate Destination option to determine how the dragged cell is combined with the
destination cell.

3. Drag the required cell and drop it onto the required destination cell:

butterfly.jpg

butterflyjpg

Raster Image
280 x 210, 8 bit RGB

poppIeS.|pg
popples.|pg

Raster Image

280 x 210, 8 bit RGB

clouds.jpg
clouds.jpg

Raster Image

280 x 210, 8 bit RGB

If you selected Multiple Frames the Copy Content dialog box is displayed to allow you to specify which
frames to change.

4. Specify the range you want to change and click the OK button.

5. Click the Close button to close the Content Manager. You can perform a range of useful functions within the
Content Manager simply by dragging a cell and dropping it onto another cell. The following sections
describe some typical operations:
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4.7.3 To Create a Luminance Mask

1. Set the Destination option to Replace.
2. Drag an Image cell and drop it onto a Mask cell.

4.7.4 To KeyanImage Using a Mask

Drag a Mask cell onto the Alpha Channel cell for the image you want to key.

4.7.5 To Create a Composite

1. Set the Destination option to Composite.
2. Drag an Image cell and drop it onto another Image cell.

The image you dragged is superimposed on the destination image, using the dragged image’s alpha channel as a
key.
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4.8 Controlling Layer Compositing

By default, layers are simply composited one over the other using only their own alpha channel to determine which
parts are visible in the finished composite, and which are not.

More sophisticated levels of compositing can be achieved using the blend mode, opacity, and composite mask.

4.8.1 To Specify the Compositing Options

Each layer provides compositing options to allow you to specify how the layer is combined with the other layers in
the project, and its opacity.

V Compositing Options -
Blend Mode Normal
Opacity £ m =
Use Paint Mask as a

Obey Composite Mask

1. Select the layer in the Layers list, and click the Properties tab to display the Properties panel for the layer.
2. Click the right arrow button to the left of the Compositing Options heading to display the compositing
options for the layer:

Blend Mode specifies how the layer is combined with the other layers, and can be one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten Only, Dodge, Color
Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.

Use Paint Mask as a Key (image layers only) and Obey Composite Mask are equivalent to the same options in the
Composite Mask dialog box; see below.

4.8.2 To Specify the Composite Mask Options

The composite mask allows you to make one layer appear to pass in front of some parts of a layer below, but
behind other parts.

For example, if you want to insert a character into a forest scene, you can make it appear behind some trees, but in
front of others.

The composite mask is generated layer by layer as a composite image is built up, and can be used to protect parts
of a layer from change by layers above in much the same way as the paint mask is used to protect images from paint
operations.

For each layer, you can specify:

¢ Whether the layer’s paint mask is used as a key for the layer.

* Whether the layer makes any changes to the composite mask which is passed on for use by layers above.

¢ Whether the layer obeys the composite mask (whether the composite mask is used to protect the layers
below from change by this layer).
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You set options for each layer using the Composite Mask dialog box which is displayed by clicking the mask icon to
the right of the layer name in the Layers list. This allows you to set the compositing options for the layer.

4.8.3 To Use the Layer’s Paint Mask as a Key
This provides a quick way of cutting out a feature in an image.

1. Use the paint tools to create the mask:

2. In the When Compositing this Layer section select Use the paint mask as a key. The layer’s paint mask is
added to the alpha channel, and used to key the image:

Copyright © 2025 Vizrt Page 44



Viz World Classic User Guide - 24.1

4.8.4 To Specify whether the Current Layer Obeys the Composite Mask

In the When Compositing this Layer section: Select Obey the Composite Mask. To use the composite mask at
least one layer should have this option selected. This option is irrelevant for the lowest layer in the Layers list.

4.8.5 To Specify whether the Current Layer Affects the Composite Mask

In the After Compositing this Layer section: Select Create new Composite mask to update the composite mask
with the new composite mask.

To use the composite mask at least one layer should have this option selected. The default action is for the layer’s
paint mask to replace the existing composite mask, making those elements of the layer that are covered by the
mask appear in front of layers above that obey the mask.

Alternatively, you can specify that the paint mask is combined with the composite mask as described below. This
option is irrelevant for the highest layer in the Layers list.

4.8.6 To Specify How the Current Layer Affects the Composite Mask
Click the right arrow button to the left of the Advanced Options to show the advanced options.

Once a layer has been composited, you can use either its alpha channel or, in the case of an image or movie layer,
its paint mask to modify the composite mask. You can also choose to invert the mask or alpha channel before use:

In the Use this layer’s... section:

¢ Select Paint Mask or Alpha channel.
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¢ Select Inverted to invert the paint mask or alpha channel before using it.

The composite mask can also be affected in different ways. You can either replace the existing composite mask, or
combine the composite mask with the mask or alpha channel of the current layer.

In the To... section:

¢ Select Replace the existing mask to create a new composite mask which is a copy or inverted copy of the
layer’s paint mask or alpha channel.

¢ Select Add to the existing mask to add the layer’s paint mask to the existing composite mask.

¢ Select Intersect with the existing mask to create a new composite mask which is an intersection of the
existing mask and the layer’s paint mask or alpha channel If you do not select Create new Composite mask,
the existing mask is left unchanged and may be used to protect the composite image from change by any
number of layers above.

4.8.7 To Make anImage Go behind Selected Featuresin a Scene

The following example illustrates one of the most powerful uses of layer compositing to control how one image
interacts with components of another image. In this example, we use composite masks to make a butterfly go
behind the front most poppy in an image of several poppies.

In this example, both the images have alpha channels, to allow a background image to show through. The first step
is to create a mask defining the foreground image; in this case the front most poppy:

This can be done using the mask extract tools on the Mask panel, followed by painting on the mask using the
brushes on the Brushes panel.

1. Load the butterfly image, and create a mask for the butterfly.

2. Position the butterfly layer above the poppies image.

3. Load the clouds image, and move it to the bottom of the Layers list. The composite image reflects the order
of the individual images in the Layers list:
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You can view the components of the project in the Content Manager:

butterfly.jpg
butterflyjpg

Raster Image

280 x 210, 8 bit RGB

poppies.jpg
popples.jpg

Raster Image

280 x 210, 8 bit RGB

clouds.jpg
clouds jpg

Raster Image

280 x 210, 8 bit RGB

4. Click the mask icon, to the right of the layer name on the poppies image layer in the Layers list, and select
Create new Composite mask:

Composite Mask =
When compositing this Layer

| Use Paint mask as a key
| Obey Composite mask

After compositing this layer

Create new Composite mask

5. Likewise, click the mask icon for the butterfly layer and select Obey the Composite Mask:
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(&3]

Composite Mask
When compositing this Layer

| Use Paint mask as a key
Obey Composite mask

After compositing this layer

| Create new Composite mask

Advanced >>

The composite mask is a copy of the mask on the poppies layer. This can then be used to protect the front most
poppy from change by layers above. Since the butterfly is composited obeying the composite mask, the effect is
that the area of the butterfly corresponding to the front most poppy is masked out, so the butterfly appears to go
behind the poppy:

The Composite Mask options can be animated, so a butterfly could be made to fly behind the poppy in one part of
the movie, and in front of the poppy in another part of the movie.
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4.9 Animation Controls

(ela) (> ) m ][] [)[ J[ J[ ] 00:00:0015 Duration 00:00:02:00

00:00:00:00 ,

7

(®) Timecode ) Frames @ @

00:00:01:24

The Animation controls allow you to select which frame of the animation you are working on in the Viewer, and
preview the animation.

The following animation controls are available:

e Start, step back, play, step forward, and end.

Show full frame, lower/odd and upper/even fields.

e Current time, duration, display formats (timecode or frames).
Slider range.

® Previous and next key.

Time slider and last frame.

You can hide the Animation controls to give more space for the Viewer when working on a single frame of an
animation.

This section contains information about the following procedures:

® To Show or Hide the Animation Controls
¢ To Specify the Time Display Format

® To Move to a Specific Frame

® To Move to the Next or Previous Key

To Expand the Slider Scale

To Show the Whole Project

49.1 To Show or Hide the Animation Controls

Click the Animation Controls (E']) button to the left of the Animation controls.

4.9.2 To Specify the Time Display Format
Choose the format as follows:

¢ Timecode: Hour:Minute:Second:Frame
¢ Frames: Frame number.

4.9.3 To Move to a Specific Frame

Either edit the Current frame field or drag the time slider.
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4.9.4 To Move to the Next or Previous Key
Click the Next key or Previous key button in the Animation controls.

A key is a frame in which one or more properties have been edited; for more information see the chapter Controlling
Animation.

4.9.5 To Expand the Slider Scale

Frame Range 3

() Whole project
(%) Part of project

Start  00:00:00:00
End  00:00:01:24
Duration  00:00:02:00

Match Maovie...

| 0K RI | Cancel

1. Click the Slider Range button. Either select Part of project, and specify the Start time, and the End time or
Duration, of the section of the project you want to work on, or click the Match Movie... button to match the
slider range and/or project settings to the movie in the currently selected layer.

2. Click the OK button.

4.9.6 To Show the Whole Project

1. Click the Slider Range button.
2. Select Whole project and click the OK button.

See Also

® Controlling Animation
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4.10 Move and Pan Tool

¢ Map layers: Allows you to drag the map layer.
¢ Image, text, and shape layers: Allows you to move, resize, or rotate the image, text, or drawing.

In a map layer, clicking the right mouse button displays a pop-up menu that allows you to add a country or region
to the map, fit the map to a country or region, center the map on a country or region, add a new label to the map, or
clear the selection:

Add to map > Bergen

Fit map to » Hordaland
Center map on 4 Norway
New Label...

Load Street Data...

Clear Selection

In an image/movie, text, or shape layer clicking the right mouse button displays a pop-up menu:

Move here

Apply Track Data to Layer ...

This section contains information about the following procedures:

® To Resize an Object

* To Rotate an Image, Text Item, or Drawing
® To Temporarily Select the Zoom Tool

® To Move the Pin Position

4.10.1 To Resize an Object

1. Drag one of the yellow handles at the corners or midpoints of the image or text item. The image or text item
is resized about the pin position specified in the Transformation dialog box for the image or text layer.
2. To keep the aspect ratio fixed hold down CTRL while resizing.

4.10.2 To Rotate an Image, Text Item, or Drawing

1. Point to the rotation handle, which is a yellow square to the right of the pin position. The cursor changes to a
rotation symbol.
2. Drag the handle to rotate the image, text item, or drawing about its pin position.
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4.10.3 To Temporarily Select the Zoom Tool

¢ Hold down CTRL until the cursor changes to the Zoom cursor to zoom in, or hold down SHIFT until the
cursor changes to the Zoom cursor, and click to zoom out.

4.10.4 To Move the Pin Position
¢ Hold down SHIFT + CTRL and drag the mouse pointer.
See Also

¢ Working with Maps
* Working with Street Maps
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4.11 Path Tool

Allows you to edit the animation path along which a map layer, image, text item, or drawing is animated.

4.11.1 To Change the Animation Path

1. Point to a point on the animation path. The cursor changes to a triangle.
2. Drag the point with the mouse pointer.

4.11.2 To Change the Curvature of the Animation Path

Hold down CTRL and drag from a point on the animation path to extend tangent handles from that point.

4.11.3 To Move the Tangent Handles Independently
Hold down CTRL and drag one tangent handle.

4.11.4 To Move the Tangent Handles Symmetrically
Drag one tangent handle.
See Also

® Controlling Animation
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412 TextTool

b

¢ Map layers: Allows you to move, resize, or rotate the label of a map detail.
¢ Text layers: Allows you to edit the text in a text item, or resize the box.

Add to map » Cote-d'Or
Fit map to » Bourgogne
Center map on » France
New Label...

Load Street Data...

Clear Selection

Right-clicking the layer displays a context menu that allows you to add a country or region to the map, fit the map
to a country or region, center the map on a country or region, add a new label to the map, or clear the selection.

See Also

* Working with Maps
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4.13 Zoom Tool

Map layers: Allows you to change the scale of a map layer.

Add to map » Yonne

Fit map to » Bourgogne
Center map on » France
New Label...

Load Street Data...

Clear Selection

Right-clicking the layer displays a context menu that allows you to add a country or region to the map, fit the map
to a country or region, center the map on a country or region, add a new label to the map, or clear the selection.

4.13.1 ToZoomin

Either click with the Zoom tool to zoom in by a factor of two, or drag with the Zoom tool to select an area to fill the
map rectangle.

4.13.2 To Zoom out

Hold down SHIFT and click with the Zoom tool to zoom out by a factor of two.

4.13.3 To Temporarily Select the Move/Pan Tool
Hold down CTRL and drag the mouse pointer.

4.13.4 To Move the Pin Position
¢ Hold down SHIFT + CTRL and drag the mouse pointer.
See Also

* Working with Maps
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4.14 Map Rectangle Tool

=

Map layers: Allows you to move or resize the map rectangle.

Right-clicking a map layer displays a context menu that allows you to move the center of the layer to the position of
the mouse pointer:

Move here h
Apply Track Data to Layer ...

Clear Selection

See Also

¢ Move and Pan Tool
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4.15 Browse Map Tool

Map layers: Allows you to display the names of countries and regions in the map layer by pointing at them, and
optionally add them to the Details list.

Add to map » Nievre

Fit map to > Bourgogne
Center map on » France
New Label...

Load Street Data...

Clear Selection

Right-clicking the layer displays a context menu that allows you to add a country or region to the map, fit the map
to a country or region, center the map on a country or region, add a new label to the map, or clear the selection.

See Also

* Working with Maps
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4.16 Browse Street Shape Data Tool

Map layers: Allows you to display the names of features in imported data by pointing at them, and optionally label
them or add them to the Details list.

As you move this over the map the tool tip shows you the name of each imported data feature.

Street Highlight

T 8

5 Harvard Blvd [
S Harvard Blvd n |
S Hobart Blvd

S Hobart Blvd
S Kenmore Ave - - -
S Kingsley Dr

S Mariposa Ave
S Normandie Ave

S Normandie Ave O
Venice Blvd | enice Blvd: 2147 ‘ ﬂ
W 14th St

W 14th St ‘
W 15th St !

W Pico Blvd
[ Add Whole ] [Add Section] Show Direction

—

Right-clicking the map layer displays a context menu that allows you to filter the data, add a new label to the map,
add the feature to the Details list, or label the feature:

New Label...
Filter » Freeways/Motorways
Add Venice Blvd [alizses
Label Venice Blvd luMainBoads S
Secondary Roads
Clear Selection All Roads

If you are labeling a street the label is drawn aligned with the direction of the street. You can use the Text tool to
move or rotate the label as desired.

4.16.1 To Add a Section of a Street

1. Click the Browse Street/Shape Data button.
2. Left-click the map layer to display the Street Highlight tool.
3. Select the street and click the Add section button.
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4, Left-click the street on the map to set start and end points for your section. The street section is added to
the Details list.
5. Close the Street Highlight tool.
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4.17 RulerTool

ada)

e Map layers: Allows you to measure distances on maps, and displays other useful information.
* Image and movie layers: Allows you to measure distances on images and movies.

4.17.1 To Measure a Distance

Drag from the start point to the end point of the distance to be measured. The display shows the location and
height above sea level of the end point, and the distance between points:

4.17.2 To Specify the Distance Units

Add to map »

Fit map to »

Center map on »

Measure Distances in > Miles

Measure Height in » Km

New Label.. Mees

Load Street Data... Vs
Feet

Clear Selection l

Right-click the map, point to Measure Distances in or Measure Height in on the context menu, then click the
appropriate unit on the submenu.
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4.18 Pick Color Tool

Displays a window showing the color of the layer, and composite project, under the mouse pointer:

#|Layer: R: 79, G: 70, B: 32 A:100
Project: R: 79, G: 70, B: 32

Clicking the mouse pointer copies the current color to the palette.
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4.19 VWC Navigator

>

2 S
(GPS] View | | [
Allows you to select which part of the map is displayed in the map rectangle. The view drop-list contains all defined
preset views and the possibility to add Custom preset views.

See Also

* Working with Maps
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4.20 Panels

Allow you to control the characteristics of the object on the currently selected layer. The following panels are
provided.

This section contains information about the following topics:

® Properties
¢ Contents
¢ Lighting
® |ayer Fx
* Keybars

4.20.1 Properties

Shows settings affecting the entire layer including compositing options, transform options, drop shadow, frame,
and trail.

4.20.2 Contents

Shows information about the contents of the layer. On a map layer it allows you to locate and select features from
the map database or from imported street data, or add shape overlays. On a text layer, it allows you to add and edit
text items. On a shape layer it allows you to draw and edit shapes.

4.20.3 Lighting

Allows you to add lighting effects to a layer. For more information see the chapter Lighting and Effects.

4.20.4 Layer Fx

Allows you to add image effects to a layer. For more information see the chapter Lighting and Effects.

4.20.5 Keybars

Allows you to control the animation of each feature of the currently selected layer that can be animated. For more
information see the chapter Controlling Animation.
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5 Working with Maps

This section explains the options for creating and working with map layers. It describes how to use the Properties
panel to define the projection, with advice on choosing the appropriate projection for specific applications.

It also explains how to use the Contents panel to select countries and places for incorporation into the map, and
control their appearance using the style settings.

This section contains information on the following topics:

® Creating a Map Layer

* Map Rectangle

¢ Setting the Map Properties

® | ocating Features by Name

* Adding Map Details

¢ Adding Features to the Map Database
® | ocating Features in Street Data

* Locating Features in Imported Data

¢ Adding Shape Overlays to Map Layers
¢ Adding Satellite Imagery

¢ Adding Symbols

¢ Defining the Style of Details

¢ Setting the Properties for Details

® Setting Map Features

¢ Displaying Disputed Regions

® Using the Navigator

* Measuring Distances on the Map

¢ Locating Features by Country or Region
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5.1 Creating a Map Layer

Most Viz World Classic projects contain at least one map layer, containing the regions, countries, and other details
you want to feature in the animation. You can include more than one map layer to show two areas of the world, or
one area at two different scales, in the same animation. You can add a map layer when you create a new project, or
using the appropriate option on the Layer menu.

The map layer will show the region detailed by the map database using the Globe projection.
This section contains information on the following procedures:

® To Create a New Project with a Map Layer
® To Add a Map Layer
® To Insert a Map Layer between Existing Layers

5.1.1 To Create a New Project with a Map Layer
(\ﬁz World Classic - Welcome &J\

(") Create empty project
(") Create paint project
@) Create map project

() Use a project template

OK || Cancel

- oy

When you start Viz World Classic, or create a new project by clicking New on the File menu, you can choose to
include a map layer:

1. Select Create map project.
2. Choose the map database you want to use from the drop-down menu.
3. Click the OK button to create the project.

¢ The first time you load a new map database there will be a delay while the data is loaded. All the map
layers in one project use the same map database.

e Earlier versions of Viz World Classic (Viz Curious Maps) supported having access to databases of the
World, Europe, and USA, and a Combination database which combines these into a single database.
More recent versions of Viz World Classic are only installed with the combination database; however,
you can change this under View > Options... > Map Data > Locations.
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5.1.2 ToAdd aMap Layer

¢ On the Layer menu, point to Add Layer, and then click Map. The new layer is added above the existing
layers.

5.1.3 TolInsert a Map Layer between Existing Layers

1. Select the layer in the Layers list above or below which you want to add the map layer.
2. On the Layer menu, point to Insert Above Selection or Insert Below Selection as appropriate, and then
click Map.
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5.2 Map Rectangle

The map is drawn in a rectangular window called the map rectangle. You can change the size and position of the
map rectangle to create inset maps in larger animations.

5.2.1 To Display the Map Rectangle

Select the Map Rectangle () tool: Handles are displayed on the edges of the map rectangle.

5.2.2 To Resize the Map Rectangle

Drag one of the handles.

5.2.3 To Move the Map Rectangle

Australia
b

el New South Walus

s O

{

r New!South Wales

o

2
1

4
y 4
W
¥ PRV R
e’
Y
[\
P

Drag anywhere within the map rectangle. The above example uses a second map layer as an inset by resizing and
moving the map rectangle to a corner of the main map.
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5.3

Setting the Map Properties

Properties ]Contents Paint | Lighting | Layer Fx | Keybars

[> Compositing Options Projection
> Transform ‘
=[] Drop Shadow [Globe |> ‘ [ Apply ]
> Frame
> Trail

[> Locator

>["] Map Legend

Globe projection

Supports Geotiff export

Automation
Style Sheet

[Physical Selection \ v:

Auto Animate

[ Virtual Earth Fade... ]

The options in the Properties panel allow you to specify the position and scale of the map, choose the map

projection, and specify the style sheet.

This section contains information on the following topics:

Compositing Options
Transform Options
Drop Shadow Options
Frame Options

Trail Options

Locator

Map Legend
Projection
Automation

5.3.1 Compositing Options

V Compositing Options

Blend Mode

[Normal \ v

Opacity —0 | 100% %]

Blend Mode specifies how the layer is combined with the other layers, and can be one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten Only, Dodge, Color

Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.
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5.3.2 Transform Options

WV Transform =
Locked

Map Center Long| 14316423 = Lat -31.88903 =

Rotations Lonc 0 = Lat 0=

Pin Position X 50% (= Y 50% =
y)

v

Scale ,W =
Position X | 38400 5 Y | 288.00 /3

Size X 768 5 Y 576 =

Curved Paths ]

Set Using GPS

Allows you to specify the position, scale, rotation, and origin numerically. The following fields are provided:

Option Description

Locked When selected, this map layer is locked to the position and zoom setting of the
map layer below it; see Setting the Map Properties#To lock the map layer to the
map layer below it.

Map Center The longitude and latitude at the pin position, in degrees.

Revolutions The number of globe revolutions in each direction, to create an animation that
spins the globe.

Pin Position The point, relative to the map rectangle, about which the map is centered,
where X=0%, Y=0% corresponds to the bottom left-hand corner of the map

rectangle.
Scale The zoom ratio, where 1.00 corresponds to showing the entire globe.
Position The position of the center of the map rectangle, where X=0, Y=0 corresponds to

the bottom left-hand corner of the project area.
Size The size of the map rectangle in pixels.

Curved Paths When selected, moves the camera in a smooth curve between keys when
panning the map.
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Option Description

Set Using GPS Displays the GPS Position dialog box to allow you to center the map at a specific
longitude and latitude.

See To Enter a GPS Location.
Longitude and latitude values can either be entered in decimal degrees, such as 20.175, or in degrees, minutes and

seconds, such as 20d10m30s.

To Lock the Map Layer to the Map Layer below

¢ Select Locked in the Transform options.

Locking a map layer fixes it at the same size, scale, and projection as the base map. This is useful for drawing
selected regions of a map using a different style from the main map.

In the above example, the upper map layer has all styles other than Selected Region set to a Fill color of None, and
no relief. The lower map layer has Relief and Ocean Contours selected.

To Change the Pin Position

The map is centered on the pin position, which is drawn as a + symbol on the map when you select one of the map
manipulation tools. Initially, the pin position is centered in the map rectangle, but you can change it to create an
off-center globe in the map rectangle.

Either:

1. Select the Move/Pan or Zoom tool.
2. Hold down Sc and drag in the Viewer.

Or:

¢ Edit the Pin Position values in the Transform options.
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The above example was created using two map layers, each with a different pin position.

5.3.3 Drop Shadow Options
Allows you to add a drop shadow which is cast by the map layer onto other layers.

The following parameters are provided:

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the range 0-5 are
recommended.

Color The color of the drop shadow.

5.3.4 Frame Options

V|| Drop Shadow -
Offset X[ 3002 v|[ 3002
Opacity 0 060 =
Softness ' |72 A T
Color -

The following options allow you to define the frame:
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Description

The fill color, for areas outside the globe if the edges of the globe are

visible.

Border and Border The frame border color, and its shape: Rectangle or Circle.

Color

The width of the frame border in pixels.

Border Width

For example, the above inset map uses a circular frame with a white 5-pixel border.

5.3.5 Trail Options

W Trail ‘
Trail Width ~r 5.00 fjf
Trail Color | ‘
Trail [Off v]

Trail Above [

¢ Use Trail Width and Trail Color to define the width and color of the trail.
¢ Choose Behind, Ahead, or Full from the Trail drop-down menu to leave a trail behind, ahead of, or on both

sides of the path.
¢ Select Trail Above to display the trail above the layer.

Copyright © 2025 Vizrt Page 72



Viz World Classic User Guide - 24.1

5.3.6 Locator

V Locator -
Map [Image.bmp v] 5
Locator Corner [Bottom Left v] _
Locator Line Color ]|

Locator Line Width 200 =
Locator Offset = 0=

Locator Rectangular [

The map locator enables you to create a map that can be used to highlight the location of your main map.

To Create a Locator Map

-

1. From the main menu click Layer, and select Create Pre-rendered Map and then Locator...

2. From the Export Locator Map dialog box you can name the file, set format, image format/quality options,
frame size and alpha options

3. Click Render to render the locator image to disk

4. In the Locator options select the locator image from the Map drop-list

5. Set the parameters for the locator and save the map project

5.3.7 Map Legend

Map legend allows you to add a legend to the map, position and customize its design.
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Master Opacity y

Units [ ] |

[Bottom Center v]

N 10

Km/Metres

Position

BG Offset

BG Color
BG Opacity

Border Size

o
1

10
150

44>

Line Length

¢ Master Opacity: Sets the opacity of the legend.
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v

-

1.00

v
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¢ Units: Defines the legend’s units in kilometers/meters, miles/yards and miles/feet.
* Position: Defines the position of the legend. Available options are bottom and top left, right and center.

BG Offset: Defines the offset of the legend’s background.
BG Color: Defines the legend’s background color.
BG Opacity: Defines the opacity of the legend’s background.

¢ Border Size: Defines the legend‘s border size (in pixels).

¢ Line Length: Defines the legend’s length (in pixels).

Line Thickness (B

Line Color -

Type [Line Up VI

Font | Arial v|
8

Text Color -

Default Text

Units Title [km

Sub-units Title [metres

¢ Line Thickness: Defines the thickness of the legend’s line (in pixels).

e Line Color: Defines the legend’s line color.

¢ Type: Defines the type of line. Alternatives are line up/down, alternate filled and open and staggered open/

filled.
¢ Font: Defines the font and the font parameters.
¢ Text Color: Defines the color of the text.

¢ Default text: Allows you to enable and define the default unit text (for example, setting Km to km,

kilometers, kildmetros, etc.).

¢ Units Title: Allows you to manually enter the units title text instead of using the default text.

e Sub-units Title: Same as for Units Title.
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Sub-units Title [ metres I
Title Alignment [Left v]

Halo Size Y | 05 :

Halo Color _l

Shadow On ]

Shadow x[ 30005 v[ 300

Shadow Opacity - 9, ,W =]

Shadow Softness g ,72 = (3
Shadow Color !l L

e Title Alignment: Aligns the unit titles. Available options are Left, Center and Right.

¢ Halo Size: Defines the size of the legend’s halo. Note that the halo only has an affect on the legend itself and
not the legend’s background (use shadow).

¢ Halo Color: Defines the color of the legend’s halo.

¢ Shadow On: Enables the legend’s shadow.

¢ Shadow Position: Defines the (X and Y) position of the legend’s shadow.

¢ Shadow Opacity: Defines the opacity of the legend’s shadow.

¢ Shadow Softness: Defines the softness of the legend’s shadow. The higher the softness, the wider the
shadow spreads.

¢ Shadow Color: Defines the color of the legend’s shadow.

To Create a Map Legend

1. Open the Properties panel.
2. Enable the Map Legend and set the parameters.
3. Save the map project.
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5.3.8 Projection

Projection

[Globe v] [ Apply

Globe projection

Supports Geotiff export

To Choose the Projection

® Choose the projection from the drop-down menu. Selecting a projection previews it in the window below
the drop-down menu.

¢ Click the Apply button to apply the projection to the map layer. Which map projection you choose depends
on what you are using the map for, the part of the globe displayed, and the type of animation.

In the majority of cases the Globe projection is most suitable as it is ideal for zooming in animations, and land

shapes look familiar when in the middle of the picture. Its chief disadvantages are that shapes get distorted near
the horizon, and only half the world can be seen at any one time.

The other projections are divided into four main groups:

¢ Cylindrical projections: Have shapes that look familiar for certain latitudes, but is more distorted at other
parts.

¢ Equal Area projections: Show the relative size of countries more accurately but the shapes can look
unusual.

¢ Conical projection: Is really only useful for maps of the Continental USA.

¢ Stereographic projections: Have familiar shapes at the center of the image, but is very distorted at the
edges. They can be useful for combining with satellite images.

Copyright © 2025 Vizrt Page 76



5.3.9 Automation

Automation
Style Sheet

[Political v

Auto Animate

@ Apply Track Data

| Mask... | | Quick... |

[ Virtual Earth Fade... ]

To Change the Stylesheet

Choose a style sheet from the Style sheet drop-down menu.

To Auto-animate the Map Layer

=
Click the Auto Animate (=*I) button:
See Also

* Working with Styles
* Automatically Animating a Layer
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5.4 Locating Features by Name

The Search tab in the Contents panel is used for searching the entire map database for a feature, using a string or
sub string typed in the Named text box. Search results can be filtered by using the radio buttons and the drop down

list.

Searching is instant (after the first three characters) and optimized according to relevance; hence, if you search for
Paris yourresult shows all places named Paris, but if you search Paris TX you will get Paris, Lamar County

which is in Texas, USA.

Search map database for features:
Fiterr ®al O Visible

Type: Al

Named: paris tx

Intersection:

Source: (3) Database

() 'web

)

1. Select All or Visible to search all of the features of specified type in the database, or only those visible in the

current map view.

2. Choose the type of feature you want to search for from the Type drop-down menu.
3. Enter the text you want to search for in the Named field. The text can include the wildcards ? or * to

match any single character, or any sequence of characters, respectively. For example, typing *erest finds

all features containing erest:

Explorer| Search lStreets

Imported Data | Overlays

Search map database for features:
Fiter:  ®al O Visible
|l

Type:

)

MNamed: *grest

Intersection:

Source:

© Database O 'Web ﬂ Mount Everest (Qomolangma Feng]]?|

ﬁé Somerest Junction, Somerset Cou... ’;|
sz Barrage de Villerest, France

s Tasserest, Mali

z QOzero Verestovo, Russian Federat...
Tz Kerest', Russian Federation

o Berestova, Ukraine

"™ Kerest', Russian Federation

E

If you have street data (see Locating Features in Street Data) you can also search for crossroads using AND or & (for
example, E Tudor RD AND Lake Otis Pky):
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Explorer | Search | Streets | Imported Data | Overlays

e -

27 ETudor Rd & Lake Otis Pky

? E Tudor Rd, Anchorage, Ak, Usa
E Lake Otis Pky, Anchorage, Ak, Usa

Search map database for features:

Fiterr ®al O Visible
Type: |l ~

Named: Tudor AND Lake Otis

Intersection:

Source: (3) Database () 'web

gy )

5.4.1 Search Parameters

¢ Find All: Displays all matching entries in the database when selected.

¢ Find Visible: Displays only the matching entries visible in the current map when selected.

® Addr and Cross st.: Enables the user to search for specific addresses.

¢ Type: Limits the result list according to the selected Type. For example, region, capitals, tourist attraction,
and so on.

¢ Named: Text box for entering search criteria. Can also use AND or & to search for crossroads/intersections.

¢ Intersection: Searches for an intersection of the street entered in the Named field. This is an alternative to
the search option described for the Named field.

¢ Source: Searches the Viz World database.

Note: Searching for addresses requires licensed street data installed on the server.

5.4.2 To Display the Currently Listed Features

Click the Locate Features (@) button: The currently selected features are labeled on the map, and you can click
on one to select it in the Search list.
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5.5 Adding Map Details

The Details list on the Contents panel shows a list of all the details currently selected for incorporation in the
current project:

Details Style Sheet

i Birmingham, West Midl... Place
ﬁé London, Greater London Place
ﬂ England Selected Region

b United Kingdom Selected Region
[] Scale labels with map E] E] [Oveuide Style [+] ]

Each entry shows an icon representing the type of feature, the name of the feature, and the name of the style
applied to the feature. The icons are as follows:

Icon Description
b Country
ﬂ Region

: Town
B
z Place
- River

E i Mountain

The Details list also includes any area or line shapes drawn on the map layer:
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Icon Description
¢ Area shape
@ Line shape

This section contains information on the following procedures:

¢ To Specify How Labels Scale with the Map

® To Reorder the Map Details

* To Remove a Map Detail

® To Add a Feature from the Explorer or Search Panel to the Details List
* To Add a Country or Region from the Map to the Details List

® To Redraw the Map to Fit a Feature

¢ To Center the Map on a Map Detail

5.5.1 To Specify How Labels Scale with the Map

Select Scale labels with map below the Details list to cause the labels of map details to remain the same
proportion relative to the map’s scale. If you deselect this option the labels will remain fixed size irrespective of the
map scale.

Note: This option affects all labels on the map layer.

5.5.2 To Reorder the Map Details

Entries in the Details list are drawn on the map from the bottom of the list upwards, and you can change the order
to determine how features overlap.

Either:

1. Select the detail you want to move.

2. Click the arrow buttons (E] E]) to move it up or down in the list:
Or:

* Drag the detail to the required position in the list:
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Details Style Sheet

4 Manchester, Greater Ma... Place
gé Birmingham, West Midl.[\Place
| London, Greater London Piste
n England Selected Region
b United Kingdom Selected Region

[]Scale labels with map [E] E] [Uvenide Style (+) ]

Or:

Click the detail with the right mouse button and click the appropriate Ordering option on the context menu.

5.5.3 To Remove a Map Detail

Either:

1. Select the detail you want to remove.
2. Press D.

Or:

¢ Click the detail with the right mouse button and click Remove on the context menu.

5.5.4 To Add a Feature from the Explorer or Search Panel to the Details List

Either:
1. Select the feature in the Explorer or Search lists.
2. Click the Add Feature to Details () button:
Or:

¢ Click the detail with the right mouse button and choose Add to map from the context menu.

5.5.5 ToAdd a Country or Region from the Map to the Details List

Click the Browse Map () tool.

As you move the pointer over the map, the name of each country and region is displayed:
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0.0861, 51.4928): 33 meters above sea level
: 29X 1130190.2556, 5743873.7195
3 km from map centre.

Click the map with the right mouse button and point to Add to map on the context menu, and click the feature you
want to add:

Add to map » Greater London
Fit map to » England

Center map on 4 United Kingdom
New Label...

Load Street Data...

Clear Selection

5.5.6 To Redraw the Map to Fit a Feature

Add to map
Fit map

Center map

Click the feature in the Explorer, Search panel, or Details list with the right mouse button and click Fit map on the
appearing context menu.

5.5.7 To Center the Map on a Map Detail

Click the feature in the Explorer, Search panel, or Details list with the right mouse and click Center map on the
appearing context menu.

See Also

* Working with Shapes
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5.6 Adding Features to the Map Database

Viz World Classic allows you to add user-defined features to the map database. You can share user map details with
other users; see the Sharing Databases section.

This section contains information on the following procedures:

® To Define a New Feature on the Map
® To Define a New Feature from the Explorer

5.6.1 To Define a New Feature on the Map

You can define a new feature at a specified map position and add it to the map database, associated with the
country and region you clicked on.

1. Select any tool except the Path tool or the Map Rectangle tool.

Add to map »
Fit map to 13
Center map on »
New Label...

Load Street Data...

Clear Selection

2. Click the map where you want to add the feature with the right mouse button and click New Label... on the
context menu. The following dialog box allows you to define the new feature:

'Add New Label x|

Name |

Style Place ’
Default Symbol r

Labelled Symbol

Traffic Incident

Traffic Accident

Traffic Construction ’

1]

l 0K ] [ Cancel ] ?

3. Enter a name for the feature, and specify the style.
4. Click the OK button to add the new feature to the user map details database and Details list.
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5.6.2 To Define a New Feature from the Explorer
@ You can define a new feature of any type and add it to the map database associated with a specific county and
region.

1. Click the New Feature button in the top right corner of the Explorer panel. The following dialog box allows
you to define the new feature:
-

Add New Feature W

Name London Eyel

[Town> 100k |~

Style | sea ‘
Unselected Land ‘
Selected Region
Place
Latitude/Longitude .
Lakes ‘:’

Region Isle of Man ™
Jersey B |
[+ Luxembourg
[+ Netherlands B |
[=)- United Kingdom
+- England L
- Northern Ireland 1
[+ Scotland
[+ Wales ™

Find Visible regions

Once the place has been added you can use the Text
Tool to move the feature to the required location.

[ 0K ] [ Cancel ] P

2. Enter a name for the feature, and specify a category and style.

3. Enter the latitude and longitude, if you know them, or use the Text tool to move the new feature to the
correct position after you have defined it. The Region list is identical to the left list in the Explorer and you
can use the Find box to scroll to an entry, and the Visibleregions checkbox to show only regions visible in the
image window.

4. Click the OK button to add the new feature. The feature is added to the user map details database and to the
Details list.

See Also
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® Reusing Design Elements
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5.7 Locating Features in Street Data

The Streets tab on the Contents panel allows you to explore imported street data, and add selected features to the

Details list:

 Explorer| Search | Streets
Find

Imported Data | Overlays|

Find SantaM

>

[=)- Los Angeles, Ca, Usa

[=]- Streets
Motorways
Primary Roads
Main Roads
Secondary Roads
Other Roads

Land Use A

F-1andllse R

1]

Y)[E]

[Jvisible Data

(Vi

T~ Santa Fe Ave s

WHLE

T Santa Fe Ave
ff? Santa Fe Springs Rd

=]

WHLY =

Santa Monica Blvd

T Santa Susana Pass Rd

%?P Santiago Rd [:]

It works in a similar way to the Explorer.

See Also

* Working with Street Maps
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5.8 Locating Features in Imported Data

The Imported Data tab on the Contents panel shows imported third-party map data in the widely-used ESRI Shape
File Format, and allows you to explore it by data set, data layer, and subset:

Explorer | Search | Streets | Imported Data | Qverlays
Find Find

Q_
@2 ALASKA, USA

@3 ARIZONA, USA

@2 ARKANSAS, USA

@3 CALIFORNIA, USA

@4 COLORADO, USA

@4 CONNECTICUT, USA -

[ | Visible Data [ visible N

- USA

It works in a similar way to the Explorer.
See Also

* Working with ESRI Shape Files
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5.9 Adding Shape Overlays to Map Layers

The Overlays tab on the Contents panel allows you to add shape overlays to the map layer, either by drawing
them, or by tracing map features:

Explorer | Search | Streets | Imported Data| Overlays

E]Polygon

&) New Bezier [ Add Satelite Image |
New B-Spline [ Bird's Eye... ]
New Freehand

New Circle
New Ellipse
New Rectangle

See Also

* Working with Shapes

Copyright © 2025 Vizrt Page 89



Viz World Classic User Guide - 24.1

5.10 Adding Satellite Imagery

You can add geo-referenced satellite imagery to your base map. Other features like street data appear on top of it.

5.10.1 To Add Satellite Imagery to the Base Map

Natural Earth Imagery

. - Resolution is View Dependent B
DigitalGlobe ... (US Domestic) | jcensed OK. Does ...tpsupport Overlays.
AitPhoto USA 15m %153(210&9( a)(IIIE%’QGOOO 15 Meters/Pixel
Overlays

I 15m-BASE-N...apan-CMR.cmr 17588 x 31841 11 Meters/Pixel

?’ 45cm-Sendai-Japan-CMR.cmr 27646 x 36536 0.39 Meters/Pixels

ﬂ 45cm-Soma-Japan-CMR.cmr 18799 x 16245 0.40 Meters/Pixels

(3
i> Colour Corection [ Reset | [ Export | [ Import |
1

Path:  C:\Wizrt SoftwarehViz Curious Maps\JAPAN-CMRs\d45cm-Minamisoma-) apan-CMR\45 Edit...

1. From the View menu select Options.....

2. Select Locations and click Installed Imagery....

3. Click the + button and open the CMR files.

4. Click the Fitimages to selected map button and close the window.
5. From the Styles menu select Styles Editor....

6. Select the Topography tab.

7. Select your style sheet and set it to Natural Earth. All satellite images appear as part of your map; however,

they only appear if you use style sheets based on Natural Earth.
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8. Optional: From the Contents tab select the Streets tab and load the street data for your region to see how
streets are overlaid.

See Also

¢ Working with Images and Movies
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5.11 Adding Symbols

=

f
# | Symbols 3|

Page [Defet -+
2| (@

et

File tornado.png

Symbols can be added to map layers.

-

5.11.1 To Add Symbols

12}

—
@

1. Click the Symbols button on the toolbar, or click Symbols on the Tools menu.
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2. In the Symbols dialog box select the symbol and click the Add to Layer button or Drop Symbols button. All
symbols are visible in the Details list.

5.11.2 To Manage Symbols

1. Click the Symbols button on the toolbar, or click Symbols on the Tools menu.

2. Add a page to categorize symbols. Pages can also be renamed.

3. Click the Replace... button to replace the symbol.

4. Add symbols to the page by clicking the + button.

5. Delete symbols from the page by clicking the Delete button.

6. Set properties by clicking the Properties button. The Properties dialog box allows you to set the scale, fix
the aspect ratio, set default text, set preferred style name, add and set drop shadow properties and set it to

loop.
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5.12 Defining the Style of Details

The Style, Properties and Shape panels on the Contents panel allow you to define the individual appearance of
each of the map details and shape details you have added to your project.

Each detail is initially drawn using the style defined in the Styles Editor for the corresponding type of object. These
include:

* Sea.

® Unselected Land.
Selected Region.
Place.
Latitude/Longitude.

You can redefine these styles in the Styles Editor, to change the appearance of all details of the corresponding
type. You can also create your own named styles, and apply these to specific details to draw them in a specific style.

Finally, you can override the style of any selected detail to modify its appearance from that specified in the Styles
Editor.

This section contains information on the following procedures and topics:

® To Apply a Predefined Style to a Detail

To Redefine the Style Applied to a Map Detail
¢ To Override the Style of a Map Detail

Color Panel

Text Panel

Strap Panel
Texture CC Panel

5.12.1 To Apply a Predefined Style to a Detail

1. Select the detail in the Details list.
2. Click the Style tab and choose the style name from the Style list:

Details Style Sheet [Poliﬁcal v] Map Features

~ | Stle | Properties | Shape | Symbol
— — B Sea
Voss Unse... Land Unselected Land
Vaksdal Unse... Land 31—3;}1 Region
. akes
Ulvik Unse... Land Rivers
Ullensvang Unse... Land Ice
Parkland
Tys-nes Unse... Land Building
Sveio Unse... Land Default Area Shape
Sund Unse... Land -
[T Scale labels with map E] E] Override Style (+) ...

5.12.2 To Redefine the Style Applied to a Map Detail
1. Click the Style tab and select the style in the Style list.
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2. Click the Edit... button.
The Styles Editor is displayed to allow you to edit the style. For more information see the Styles Editor.

5.12.3 To Override the Style of a Map Detail

1. Select the detail in the Details list.
2. Click the Override Style (+)... button.

The Settings dialog box displays to allow you to override the style:

Settings (=]

Qverriding Style for: P |
@ygarden 5

Color | Test | Stap | Testure CC|

. = Mix with Topoaraphy
Fill
g | v |
Texture I [None v] ' _' Tile
: ao0 20 Line width in area style
Border !I it z is only for imported data

Internal  ~._
Border =~ <

' Line Width Limits [Pixels]
Coastline -I Min 000 2 Max 500 =

[ Add to Style Sheet ..

If the style has been overridden a +, it is displayed after the style name in the Details list. After overriding a style you
can click the Add to Style Sheet... button to add the new style to the current style sheet, so you can use it for other

details.
The following dialog box displays to allow you to name the new style:

Rename New Style @

Highlight

[ OK ] [ Cancel J
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5.12.4 Color Panel

Color | Test | Stap | Testure CC|

Mix with Topoaraph
Fill -| L

i

Texturel [None ,] '. -' @] Tile
Border -l Width 200 -2 Line width in area style

is only for imported data
Interal L~
Border >\

' Line Width Limits (Pixels)
R -| Min 000 =] Max 500 L=

Allows you to specify the fill, border and coastline colors for the object, the width and line width limits, and an
optional texture.

For more information see the Color Panel when Working with Styles.

5.12.5 Text Panel

Color | Test |Stap | Testure CC|

Text I[Arial v]
20+ Extraspacing 0.00

Alignment [Center V] Estraline spacing 0.00 =<

4

4

Distance 4.00 = [] &l Caps

Drop Shadow... On

Allows you to specify the color, font, size, style, alignment, and opacity of the feature’s label. For point styles it also
allows you to choose the marker which is drawn at the location of the feature.

1. Select On to apply a default drop shadow.
2. Click the Drop Shadow... button to define the characteristics of the drop shadow:
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Drop Shadow =
Shadow for -
Bygarden Map Detail T

On VI

% 300 =

y -300 =
Opacity &

Softhess 2 =

coior [ hd

For more information see Text Panel when Working with Styles.

5.12.6 Strap Panel
Color | Text | Stap | Tewture CC

Markell [None ’v’ Opacity
Fil < | Margin 200 =) Margin Height 0.00 )

Frame | None {v‘ Opacity
| Width 200 =

Width 200 (=

[a)
Gap UUU ‘ = I

Connector | None { v ‘ -l ]

Viz World Classic User Guide - 24.1

Allows you to draw a marker at the label position, and a background (strap) for the label with an optional frame and
connector. You can also add a drop shadow to the strap in the same way as for the label.

After defining a strap with a connector you can move the end of the pointer using the Text tool.

For more information see Strap Panel when Working with Styles.
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5.12.7 Texture CC Panel

| Color | Test | Strap | Textwe CC ‘

| Reset || Ewport || Import |

Brightness - o
Contrast - o
Gamma - (5
Saturation : ",

Tint Color -|

Tint Amount [

Allows you to color correct textures.
See Also

® Texture CC panel when Working with Styles
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5.13 Setting the Properties for Details

The Properties panel on the Contents panel allows you to change individual properties of a detail not defined by
its style:

Properties | Shape | Symbol

Color Opacity

Text Opacity {

Label London <Primary> -
Scale 1.00 2

v

Label Rotation 0.00 2 Image..

v

| FitMap | | Center Map | Auto Animate

This allows you to specify the color and text opacity for the detail, and edit its label.
If the label for the feature is outside the project area you can make it visible by clicking the Make Label Visible (
) button.
¢ Set the size and angle of the label using the Scale and Label Rotation fields.
Alternatively you can scale and rotate a label using the Text tool.

¢ Click the Fit Map or Center Map buttons to fit or center the currently select feature to the map.
¢ Click the Auto Animate button to auto animate the feature.

5.13.1 To Create Multi-line Detail Labels

You can include a \ (backslash) character in the label for map details to split the label onto two or more lines:

Properties | Shape | Symbol

Color Opacity {
Text Opacity {
Label United Arab\Emirates <L =
Scale 1.00 2
Label Rotation 0.00 |2 Image...
| FitMap | [CenterMap| AutoAnimate i

This gives greater flexibility in labeling small features on the map:
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United Arab
Emirates

5.13.2 To Select an Alternative Label

Some features provide alternative labels; for example, Beijing (Peking). Select the alternative you want from the
Label drop-down menu. You can also add your own alternative names; these get saved in an alternate names
database so they are always available.

5.13.3 To Specify the Order of Alternative Place Names
You can specify the order in which alternative place and region names are shown.

1. On the View menu, click Options....
2. In the Display section click Map Labels:
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Options (=]
General & Alternate Label Display
IMap L?be:i Use this option to choose the order in which alternative
- Intemational Font place and region names are presented.
Shape Controls . . . .
- LUT Settings File 1st Choice 2nd Choice 3rd Choice 4th Choice
L. Prosies [Slandard v] [Altemate v] [User v] [Abbrevialion v]
- Keyboard )
- Shortcuts 3 Street Data
“ Tool Modifiers .
- Template Draw streets with square ends
=) Map Data Square ends for pre-connected data, round otherwise
- Shared
- DEM Street Addres Format: | <Number>, <Name> h
Dakapase Sample: 1050, Main Street
- Locations
... Attribution Note that changing the format does not affect features
- Map Legend currently added to the map
- Map Projection
- Wirtual Earth
- Digital Globe
... | analiane

The 1st Choice, 2nd Choice, and 3rd Choice drop-down menus can each be set to one of the following

options:
Option Description
Standard The standard name provided in the map database.
Alternate The alternate name provided in the map database.
Abbreviation The abbreviated version of the name in the map database.
User The user-defined alternate name defined on the Details Properties panel.

It always uses the last entered name.

Map details are listed in the Explorer and Search panel as: First Choice (Second choice). The First Choice is selected
by default for new map details.
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5.14 Setting Map Features

The style sheet selected for a map layer specifies a number of general settings. You can override these using the

Map Features dialog box.

This section contains information on the following procedure and topics:

* To Display the Map Features Dialog Box

® Global Map

Data

e Local Street Data

¢ Scale Roads/Rail with Map and Rivers Master Scale

® Physical Feature Animation

5.14.1 To Display the Map Features Dialog Box

Click the Map Features button in the top right corner of the map layer Contents panel. This provides the following

sections:

Global Map Data
Global Map Data

Lakes [ None

Rivers [ None

Roads [None

Opacity

Rail [ None

Opacity

Allows you to specify the following settings for the selected map layer:

Parameter

Lakes, Rivers

Roads

Rail

Description

Allows you to specify which lakes and rivers are visible.

Allows you to specify which roads are visible.

Allows you to specify which railways are visible.
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Local Street Data

Local Street Data
V|Enable V] Draw land

Lakes [ Major Lakes v
Rivers [\ide Rivers v|
Roads [Al v)
Opacity {
Ral  [Main v
Opacity

Street Data...

Allows you to specify which lakes, rivers, roads, and railways are visible in street data, and the opacity of roads and
railways. The options are the same as for Global Map Data opposite.

Enable allows you to choose whether or not street data is displayed in the map layer.

The Street Data... button displays the Street Data Directory dialog box and is equivalent to the Street Data...
command on the Import menu.

For more information see Working with Street Maps.

Scale Roads/Rail with Map and Rivers Master Scale

V] Scale roads/rail with map: Scale Factor  1.00 =2

Rivers Master Scale  1.00 = | Auto Fix...

Determines how roads, railways, and rivers are scaled as the map is scaled.

The Scale Factor setting is used to scale all line features, such as road, rail, and rivers. You can adjust the value to
achieve particular effects; for example, reduce it below 1.00 to make all line features thinner.

For line features, such as roads and rivers, a minimum and maximum line width is specified in the Styles Editor
dialog box Styles Color panel to ensure that the features have an appropriate appearance at extreme zoom
settings. However, it can look unnatural if a line feature reaches its maximum width before you get to the closest
zoom point as you zoom in to a map.

To solve this problem, choose the closest zoom setting in your animation and click the appropriate Auto Fix...
button. This automatically sets the corresponding scale value to scale the maximum line width so it only reaches its
maximum width at the closest zoom point.

Copyright © 2025 Vizrt Page 103



Viz World Classic User Guide - 24.1

Physical Feature Animation

Physical Feature Animation
0% 100%
Relief
Height :
Relief DEM
Blend i

Ocean
Contour i
Opacity

Land Drop Shadow...

Allows you to animate the relief height, relief DEM blend, ocean contour opacity, and land drop shadow.

¢ Relief Height: Typically used to reduce the amount of relief at close zoom settings, when full scale relief can
appear distracting.

¢ Relief DEM Blend: Imported DEM (Digital Elevation Model) relief data does not always match up exactly with
the built-in relief. As a result, seams may be visible where they meet. This control allows you to hide
imported relief data until you are zoomed in far enough for the seams to fall outside the display window. For
more information about importing relief data see how To Import Relief Data.

¢ Ocean Contour Opacity: Allows you to animate the intensity of ocean contours.

¢ Land Drop Shadow: Allows you to animate the land drop shadow over time.
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5.15 Displaying Disputed Regions

Viz World Classic allows you to choose how several disputed regions in the world are displayed and assigned to the
appropriate countries. Any changes made to this setting applies to all projects.

5.15.1 To Change the Assignment of Disputed Regions

Note: You cannot make any changes to the disputed regions if your project contains map layers, so if
necessary delete any map layers in your project.

=

. On the View menu, click Options....

2. Click Map Data, then the Database option, then click the Disputed Regions... button to display the
Disputed Regions dialog box.

. Choose the region you want to configure from the Region drop-down menu.

4. Choose one of the available configurations from the Configuration drop-down menu. As you select a

configuration the map shows how the regions are displayed.

w
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5.16 Using the Navigator

The Navigator allows you to select which part of the map is displayed in the image area.
This section contains information on the following procedures:

® To Choose a View

® To Change the View

¢ To Choose a Preset View

¢ To Define a Preset View

® To Edit the Name of a Preset
® To Delete a Preset

® To Enter a GPS Location

5.16.1 To Choose aView

L] b
| &<

View IThe YWorld ¥

Drag across the Navigator to draw a rectangle enclosing the area of the world you want to display.

A

Zoom In |

Fit to licensed areaI Zoom Out I

[~
&
View | The world ~| _,
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5.16.2 To Change the View

1. Drag a corner of the rectangle to resize it.
2. Hold down CTRL and drag the rectangle to move it.

3. Move the scale control, to the right of the Navigator, to enlarge or reduce the size of the rectangle.

5.16.3 To Choose a Preset View

-~ A o {
| % The World
‘ 4nited States
MM America
|S. America | e
Americas

:Aafrica
Asia
Middle East
5. Asia v

Europe
United Kingdom |m

E’ Yiew

Choose a preset view from the View context menu.

5.16.4 To Define a Preset View

1. Define the view you want to save.
2. Click the ... button to the right of the Navigator View menu. The Presets dialog box displays:
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N America -
S. America -J
Americas
Africa

Asia

Middle E ast
S. Asia
Europe

United Kingdom
Ftﬂ

-|-J % | Rename..

l')seplace I

3. Click the + button. A new preset is created with a default name, such as Preset0.

5.16.5 To Editthe Name of a Preset

1. Select the preset in the Presets list.
2. Click the Rename... button.

5.16.6 To Delete a Preset

1. Select the preset in the Presets list.
2. Click the X button.

5.16.7 To Enter a GPS Location

GPS Position x|
Long. () [0.00000 = Revs [0 _|:2'
Lat [y) [0.00000 = Revs |0 _|:;|
Radius [395651 = [ Miles ~|

Based on scale at the map focus

Apply Close |
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1. Click the GPS button below the Navigator. The GPS Position dialog box (depicted above) is displayed to
allow you to specify that the map should be centered at a particular longitude and latitude.

2. Enter the longitude and latitude in the Long. and Lat. fields. Longitude and latitude values can either be
entered in decimal degrees, such as 20.175, or in degrees, minutes and seconds, such as 20d10m30s.

3. Optionally enter the amount of the Earth’s surface you want to display in the Radius field. For creating
animations of a revolving globe you can optionally enter a number of revolutions in the Revs fields.
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5.17 Measuring Distances on the Map

The Ruler tool provides a convenient way of measuring distances on maps, and displaying other information.

5.17.1 To Measure a Distance

1. Select the Ruler (Q) tool.

2. Drag from the start point to the end point of the distance to be measured.

The display shows the location and height above sea level of the end point, and the distance between
points:

5.17.2 To Specify Distance Units

Add to map »
Fit map to
Center map on »

Measure Distances in Miles
Measure Height in » Km

New Label... %

[load Street [Vata))
Feet

Clear Selection
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Right-click, point to Measure Distances in or Measure Heights in on the context menu, then click the appropriate
units.
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5.18 Locating Features by Country or Region

The Explorer tab on the Contents panel allows you to explore the map database hierarchically, by country or
region:

Explorer | Search | Streets | Imported Data | Qverlays |

Find United Kingdom Find London @
Ukraine |L| §§ Leeds, West Yorkshire |;|
United Arab Emirates ﬂé Leicester. Leicester
[= United Kingdom v ’ )

England gé leerpool erseyside |E|
) Northern Ireland | London, Greater London 3
Scotiand \=| g4} Luton, Luton

Wales = '

) ) ™ ﬁé Manchester, Greater Manchester
=1 Inited Statee nf America L) ~ -
(] i ] »| | |di) Middlesbrough, Middlesbrough |~ |

[]visible regions [Jwvisible [Towns > 100k { V]

The left list displays an alphabetical list of countries, and regions within each country. The right list displays
specified features within a selected country or region, or a message explaining how to narrow the search to find an
item of interest.

This section contains information on the following procedures:

® To Scroll to Any Country in the List

To List Only Countries Visible in the Current Map View

To Show/Hide Regions

® To Display a List of Features Contained in a Country or Region
To Display the Currently Listed Features on the Map

To Scroll Directly to a Feature

5.18.1 To Scroll to Any Country in the List

Type the first few letters of its name in the Find box above the list.

5.18.2 To List Only Countries Visible in the Current Map View

Select Visible regions.

5.18.3 To Show/Hide Regions
Countries shown with a + to the left of their name in the list are divided into regions.

¢ Click the + to expand the list and show the regions.
¢ Click the - to collapse the list and hide the regions.
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5.18.4 To Display a List of Features Contained in a Country or Region

1. Select the country or region in the left list.

2. Select the type of features you want to list from the drop-down menu below the list. By default, Towns >
100k is selected, to show towns with a population greater than 100,000, but you can select from a range of
alternative options.

3. Select Visible to show only features visible in the current map view.

5.18.5 To Display the Currently Listed Features on the Map

1. Click the Locate Features (@) button. The currently selected features are labeled on the map:

/ Northamplon Ipstvich
ﬁce uton
w ﬁ lo'g‘ﬂ: uthend-on-Sea

hlou

2. Click a feature with the right mouse button and point to Add to map on the pop-up menu, and click the
feature:
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Addto map » Essex
Fit map to » England
Center map on » United Kingdom
New Label... |iLondon
Load Street Data...
Clear Selection
Select London

5.18.6 To Scroll Directly to a Feature

Explorer | Search | Streets | Imported Data | Overlays |

Find Find Sno (BF]
United Kingdom (1) ﬂ Slungie Hill, Scotland lia)
United States of America A Snaip Hill, Scotland

Urugua
Uzbgellds‘t’an ﬁ Snake Pass, England

Vanaty ﬂ_

Venezuela B m Snowhope Hill, England

Vietnam ‘
Viirnin Telands 11 K Y [ } ﬁ SOxEh Lee’ Seotiend

(] m | (v] |24 South Top, Scotland

1]

I

‘
m

Bl

[] visible regions [ visible | Mountain ~ .

1. Select United Kingdom as the region.
2. Select Mountain and check the adjacent Visible check-box.
3. Type the first few letters of a British mountain (for example, Snowdon) in the Find box above the list.

A\ Note: Searching for features in any country by selecting The World may give too many results. Try
narrowing down the search by selecting a specific country or region, or by checking one or both of the
Visible check-boxes.
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6 Working with Styles

This section explains how to use style sheets to make it easy to set up a series of house styles, and convert projects
between house styles with a single click. It also explains how style sheets help you establish consistency across
projects, or between designers.

This section contains information on the following topics:

* How Stylesheets Work

¢ Creating, Saving, and Loading Stylesheets
e Styles Panel

® Topography

® Markers Panel

® Textures Panel

® Lighting Panel

® Map Features Panel

® Options Panel

¢ Using Imported Relief Data
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6.1 How Stylesheets Work

A stylesheet defines all the properties and design conventions used to draw a map. Each map layer has a stylesheet
associated with it which determines its appearance.

The stylesheet defines:

¢ The predefined styles, and any additional user-defined styles.

¢ The markers used to identify map details.

® The textures available for use as textures for regions.

* One or more default lights for the map layer.

Additional properties of the map including land shadow, relief, and line widths.

Once created, a finished project can be changed to a different set of design conventions simply by loadingin a
different stylesheet.

'he.mainawifle-growing regions
L ™ e o e
D)y rrance

j Hf‘f\'\\r"' -Ardenne

The above project was created using the default stylesheet. The project can then be instantly converted to a totally
different house style simply by loading in a different stylesheet.
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wihe-growing regions
[

of/France

> RGNS
(Champagnec-Ardennes

IBOUTEogne

Hrance

> BOrdeaux
Aquitainie
llanguedoc-Roussillon

U 7% AP
WV
n

For another project loading a stylesheet could create a much simpler appearance with flat lighting and thick line
widths.

Copyright © 2025 Vizrt Page 117



Viz World Classic User Guide - 24.1

6.1.1 Multiple Stylesheets

If your project includes more than one map layer you can apply a different stylesheet to each map layer. For
example you might have one house style for the main map in a project and another house style for an inset map.
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6.2 Creating, Saving, and Loading Stylesheets

Styles Editor :
fdz:LeO z:\re;l’e Styles | Topography | Markers l Textures | Lighting l Map Features l Options l Quick Styles|
S o [ e
Physica Selected Region i‘ . Fill j °_°'| _| m ’ 1z with Topography

Physical Selection Place
Political Latitude/Longitude
o A~ = — ] ] =

Virtual Earth Rivers
Ice Available for ) ~ 1| Line width in area style is
Freeways/Motorways ] Map Details Border _I Widh 200 [ only for imported data
Primary Roads - Internal
[¥] Use for new map layers — =T LR Blorders /\ |:I_] Dli,lz;J;e:Eorde;:'D‘als;‘ed
Rename ... ine Width Limits (Pixels
ol Coastline >< oo = 500 [~
Min. U = Max. =

() ) rre. 2] 2

[Export...] [Import...] [Llnk...] [V] &llow overiding of styles

Styles are created and edited using the Styles Editor. You can leave the Styles Editor open while you work with the
project and any changes you make in the Styles Editor are immediately reflected in the current map layer.

This section contains information on the following procedures:

® To Display the Styles Editor

¢ To Create a New Stylesheet

® To Rename a Stylesheet

® To Delete a Stylesheet

¢ To Copy Stylesheets from Another Project
® To Export an Individual Stylesheet

® ToImport a Stylesheet

6.2.1 To Display the Styles Editor

In the Styles menu, click Styles Editor.... When you create a new map layer it initially uses the stylesheet defined
by the default project template. If there is no project template the stylesheet called Political is used. For more
information about creating a default project template containing your own choice of styles see Reusing Design
Elements.

You can create any number of new stylesheets, and modify the styles in those stylesheets to establish the design
conventions you want to use. Stylesheets are saved with the project, and you can import stylesheets from another
project. You can also save individual stylesheets in separate files.

6.2.2 To Create a New Stylesheet
1. Select the stylesheet you want to base the new stylesheet on in the Style Sheet list.
2. Click the + button.

Note: By default the style sheet is called StyleSheet, StyleSheet1, etc.
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6.2.3 To Rename a Stylesheet

1. Select the stylesheet you want to rename.
2. Click the Rename... button.

6.2.4 To Delete a Stylesheet

1. Select the stylesheet you want to delete.
2. Click the X button.

6.2.5 To Copy Stylesheets from Another Project

1. On the Import menu, click From Project....
2. Select the project file you want to import from. The following dialog box then allows you to specify the
features of the project you want to import:

Project Import @

Styles | Presets I Colors | Layers‘

-

Political -
ShadedGlobe —
BrightPolitical
CentreFocus

News1

News2

News3
NewsNoRegionNames
PoliticalRelief

Physical

PhysicalLight T
PhysicalSelection
LowMountains
HighMountains
Desert

m

. Load ][ Cancel

3. Click the Styles tab.

4. Select the stylesheets you want to import from the project, using SHIFT to select contiguous items, and
CTRL to select non-contiguous items.

5. Click the Load button to proceed. The stylesheets are added to the list of stylesheets, replacing any existing
stylesheets of the same name where appropriate.
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6.2.6 To Export an Individual Stylesheet

1. In the Styles Editor click the Export... button. You are prompted to give the stylesheet a name.
2. Enter a suitable name and click the Save button.

6.2.7 Tolmport a Stylesheet

1. In the Styles Editor click the Import... button. An Open dialog box displays to allow you to select a

stylesheet to open.
2. Select the style sheet and click the Open button. The stylesheet is added to the list of stylesheets in the

project. If there is already a style of the same name the stylesheet is renamed.
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6.3 Styles Panel

Styles | Topography I Markers I Textures I Lighting I Map Features | Options I Quick Slylesl

Sea - | @ Area
Unselected Land i
Selected Region a !

Plage ) Paoint
LaEetudeﬂ_ongltude D Available in
Lakes

Rivers Producer
Ice Available for
Freeways/Motorways Map Details
Primary Roads -

Mmim Nande [ Sort Styles

Rename ...
' s

Allow overriding of styles

Color | Text | Stap | TemuecC|

Mix with Topoaraphy

! Four Color
e ;
Texture =— [Desert v] @ @ [ Tile
. + 1| Line width in area style is
Border !l Width 200 1 only for imported data
én;zgrasl ><| [ Disputed Borders Dashed
Coastine ><| Line Width Limitf [Pixels) —

Min. 0.00 Max.

The Styles panel allows you to edit the styles in the currently selected style sheet.

This section contains information on the following sections:

¢ Predefined Styles

¢ To Edit the Attributes of a Built-in or User-defined Style

® To Create a New Style

® To Edit the Name of a Style

® To Delete a Style
e Color Panel
¢ Area Styles
® Line Styles
® To Use a Texture

® To Transform a Texture

® Text Panel

® Drop Shadow
e Strap Panel
e Texture CC Panel

6.3.1 Predefined Styles

Each style is identified by a name, such as Region, and specifies attributes such as fill color, border color, coastline
color, marker color, text color, text typeface, and size. Applying a style to a map detail then sets its attributes to

those defined by the style.

Viz World Classic provides a set of predefined styles for each of the different types of feature in the map database.
These include: Sea, Unselected Land, Selected Region, Place, Latitude/Longitude, and a number of default styles

for use with street data.

This section contains information on the following procedures:

Copyright © 2025 Vizrt

Page 122



Viz World Classic User Guide - 24.1

To Edit the Attributes of a Built-in or User-defined Style

1. Select the style you want to edit in the Styles list. The attributes of the style are shown on the Color, Text,
Strap and Texture CC (color correction) panels:
2. Edit any attributes you want to change.

All objects in the selected style are updated to reflect the changes you have made.

Each predefined style is of type Area, Line, or Point as appropriate, and this determines the attributes displayed in
the Color, Text, and Strap panels.

When you create a user-defined style you specify whether it is an Area, Line, or Point style, and this determines
which features you can apply it to.

To Create a New Style

1. Select the style you want to base the new style on in the Styles list.

2. Click the + button. A new style is created with a default name; for example, Stylel.

3. Select Area, Line, or Point to specify what the style applies to. This determines which options are available
in the Color, Text, and Strap panels.

4. Edit the attributes of the style as required.

To Edit the Name of a Style
1. Select the style in the Styles list.

2. Click the Rename... button.
Note: You cannot edit the names of built-in styles.
To Delete a Style
1. Select the style in the Styles list.
2. Click the X button.
Note: You cannot delete the built-in styles.
Color Panel

The options available on the Color panel depend on the selected style.

This section contains information on the following topics and procedures:
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Area Styles

Color | Test | Stap | TextweCC|

) Four Color V] Mix with Topography
]
| | -

Texture h [Desert v] @ @ ] Tile

200 2/ Line width in area style is
Border _l Width > only for imported data

|| Disputed Borders Dashed
Line Width Limits (Pizels)
Min, 0.00 = Max, 500 =

Internal
Borders

Coastline

Provides some or all of the following options:

Attribute Description
Fill The fill color for the object.
Four Color Cycles between four different colors for the fill color so that

adjacent regions can easily be distinguished. The Auto button
automatically sets the alternative fill colors based on the current Fill
color.

Mix with Topography Moving the slider to the right adds a proportion of the style color to
land colored with topography.

Texture An optional texture for the object; see Using textures below.
Border Specifies the border color.

Width Sets the line width for the borders of imported map features.
Internal Borders Displays the internal borders of the country in the specified color.

Disputed Borders Dashed  Displays disputed borders dashed.
Coastline Specifies the coastline color.

Line Width Limits Restricts the range of line widths when zooming.
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Provides the following options:

Attribute
Inner color and Width
Outer color and Width

Line Width Limits

To Use a Texture

Viz World Classic User Guide - 24.1

Description
Color and width of the body of the line feature.
Color and total width of the edges of the line feature.

Restricts the range of line widths when zooming.

¢ To fill the area with a texture select an existing texture from the drop-down menu, or use the + button to

load a new texture from a file.

e Any image can be used as a texture, including images in the CMR (Curious Multi-Res) format; this is
ideal for using large files, such as satellite images, as textures. For more information see Working with

Images and Movies.

¢ The buttons to the right of the Texture drop-down menu can be used to determine how the texture is

displayed:
Button Name

Add Texture

Position Texture
(Arrows)

D Position Texture

[ Tile Tile

To Transform a Texture

Description

Displays the Open dialog box to allow you to add a texture
from a file.

Click to position the texture on the map. You can then move
or scale the texture in the same way as for images.

Allows you to move and scale the texture by specifying how
two points on the texture should be aligned with the map; see
below.

Specifies whether the texture should be tiled.

1. Click the Position Texture (Arrows) button.
2. Drag the circles to indicate which points on the texture you want to use as the reference points.
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Colorado

3. Drag the arrow heads to indicate where those points should be positioned on the map:

Fit World
Fit Layer

Apply transformation
Make Handles Visible

Fit to Sdo Paulo
Fit to Brazil

Clear Selection

4. Click with the right mouse button and click Apply transformation on the context menu to transform the
texture.
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Colorado

5. Click the Position Texture (Arrows) button again to see the transformed texture. The Make Handles
Visible option on the pop-up menu is useful if the handles are outside your current view.

Text Panel

Color | Text |Stap | Texture CC|

Text | [ia 7]
20+ Exbaspacing I

Alignment [Center '] Extra line spacing  0.00 =

Distance  4.00 |2 [] &l Caps
Drop Shadow... | [V]0On

ol

The text panel provides the following options:

Attribute Description

Marker Point styles only: The image file used for the point. Select an existing
marker from the drop-down menu, or click the + button to load a new
marker.

Text Specifies the text color, font, size, and style (bold, italic) for labels.

Extra spacing Varies the character spacing to compress or expand the text.
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Attribute Description

Extra line spacing Adds extra line spacing.

Alignment Specifies the position of the label relative to the marker.
Distance Sets the distance.

All Caps All letters are written in upper case.

On Adds a default drop shadow.

Drop Shadow... Displays the Drop Shadow dialog box to allow you to define the

characteristics of the drop shadow; see opposite.

Drop Shadow

£3

Drop Shadow

Shadow for g]‘]u

Unselected Land Style

On

% 300 2
y 300 2

Opacity

Softhess 2
Color !l ﬁ

Provides the following options:

Attribute Description

On Turns the drop shadow on.

XY Defines the drop shadow displacement, in pixels.
Opacity Specifies the drop shadow opacity.

Softness Allows you to blur the drop shadow.
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Attribute Description

Color Specifies the drop shadow color.

6.3.2 Strap Panel

Color | Text | Stap | Tewture CC

Marker | None v Opacity

Fil < Margin 200 =) Margin Height 0.00

Frame | None v Opacity
Width 200 =

Connector | None v -l Drop Shadow... O

Width 200 (2 Gap 000 (2

The Strap panel allows you to add a background, frame, and/or connector to the label of a feature.

Provides the following options:

Attribute Description

Marker The image file used for the marker. Select an existing marker from the
drop-down list, or click the + button to load a new marker.

Opacity The opacity of the body of the strap.

Fill, Margin, Margin The fill color, margin and margin height of the strap.
Height

Frame The type, color, width, and opacity of the frame of the strap.
Connector The type, color, width and gap (to the marker) of the connector.
Drop Shadow Adds a drop shadow to the strap.

After defining a strap you can move the end of the pointer with the Text tool.

The following illustrations below show some examples of straps. Fill white and frame black, connector set to
pointed border, and marker to image:
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6.3.3 Texture CC Panel

| Color | Test | Stap | Texture CC |
| Reset || Expot || Import |

Brightness ' 0 0.00 =

Contrast - o 000 £
Gamma ‘ {7 ,W =
Saturation ‘ (5 IW =
Tint Color -

Tint Amount [ 0% =

Allows you to color correct textures.

See Also

e Texture CC panel when Working with Maps
* Working with Images and Movies
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6.4 Topography

Styles | Topography | Markers I Textures I Lighting | Map Features I Options I Quick Styles|

[II-R‘::ief Shacer Shading | Relief Color | Natural Earth | Natural Sea | Dcean Contours|
an
@ Land Styles Scale  5.00 :
) Relief Color -
) Natural Earth Light Direction M aximum Detail
0 Highlight Size This setting tries to maximize visible
cEar:s " o detail when zoomed in very close. |t
atural Sea iahli : may cause noticable artifacts.
[ (Shallow Reefs) Highlight Brightness
(] Contours 8 7] Disable Imported DEM
2

The Topography panel allows you to add relief shading to give a three-dimensional appearance to the map, and
color the land and/or sea using natural colors.

6.4.1 To Specify the Topography

1. Select Relief Shading to apply relief shading to the land.

2. In the Land section select Land Styles, Relief Color, or Natural Earth to specify how the land should be
colored. If Relief Color or Natural Earth is selected, you can blend in a proportion of the land style color using
the Mix with Topography slider on the Styles Color panel.

3. In the Oceans section select Natural Sea and/or Contours to specify how the sea should be colored.

The options are illustrated in the following examples:

Land Styles, no Relief Shading and Relief Shading:

Utah
Nevada

California

Arizona
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Nevada

California

Arizona

Relief Color and Ocean Contours, and Natural Earth and Natural Sea:

CaF thla i

Callforma -'. e
b ‘\, ‘e, l
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The following sections give more information about each of these options:

¢ To Specify the Topography
Shading Panel

Relief Color Panel

Natural Earth Panel
Natural Sea Panel

¢ Ocean Contours Panel

6.4.2 Shading Panel

Shading | Relief Color | Natural Earth | Natural Sea | Dcean Contours

Scale  5.00 %

Light Direction Maximurn D etail
Highlight Size This setting tries to masimize visible
: { detail when zoomed in very close. [t
Highlight Brightness may cause hoticable artifacts.

' Disable Imported DEM

The Shading panel allows you to define the scale of the relief effect and the light direction for the relief. The
following image shows the map with and without maximum detail:

OBang'o‘(J ‘!
¥ v ¥ r

.

sAnglesey

P

:
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sAnglesey

'
o Bango’ '

‘l

~Snowdon

-

Maximum Detail relief rendering is selected by default, and gives improved sharpness and detail, especially when
zoomed in very close. However, in some situations the Maximum Detail option can produce images with a
noticeable grid pattern, in which case you may prefer to deselect it.

The Highlight Size and Highlight Brightness settings allow you to control the appearance of the relief texturing on
your maps.

The following illustrations give examples of the effect of each setting. Minimum highlight size, normal settings, and
maximum highlight brightness:

N ]
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The Disable Imported DEM checkbox allows you to choose whether to use any DEM Relief data you have loaded in
place of the built-in relief data.

6.4.3 Relief Color Panel

| Shading | Relief Color | Natural Earth | Natwial Sea | Ocean Contours
Scale: 8000

i
N

il

mE b
|
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The Relief Color panel allows you to define the colors used for different terrain heights. Click the appropriate
Scale button to change the color gradient scale to show heights from 0 to 8000m, 0 to 800m, or 0 to 80m. To adjust
the terrain height corresponding to a color, drag the dividing line next to the color square. To change a color, click
on the corresponding color square and a color chooser is displayed. To add or remove colors, click on the color
gradient with the right mouse button and click Add Point or Delete Point on the context menu:

Add Point
Delete Point

Load Gradient

Save Gradient

You can save a gradient, or load a gradient saved on a previous occasion, using the Save Gradient and Load
Gradient options on the color gradient context menu.

6.4.4 Natural Earth Panel

The Natural Earth panel allows you to control natural earth land coloring, which shows the Earth with natural
coloring determined from high resolution satellite imagery; for example, deserts are colored yellow, forests green,
and ice caps white:

| Shading | Relief Color | Natwial Earth | Natural Sea | Dcean Contours |

Database
| NASA Blue Marble v|
Jse Matural Earth when zoomed out
Adjust Tint
Brightness 100 - Color |

Amount :
Contrast 100

Gamma 1.00 =

Saturation 100 2 Installed Imagery...

The Database option allows you to select different types of natural earth databases. The Brightness, Contrast,
Gamma, and Saturation controls allow you to adjust the appearance of the natural earth coloring. Tint Color and
Tint Opacity allow you to add a tint, such as to simulate sunset coloring. A Natural Earth stylesheet is provided with
natural earth and natural sea styles already set up.

Note: Natural Earth is an optional feature that requires a separate license; ask your local Vizrt
representative for more details.
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6.4.5 Natural Sea Panel

| Shading | Relief Color | Natural Earth | Natural Sea | Ocean Contours |

Database
[Miaosoft Virtual Earth v]
Adjust
Brightness 100 - mnt |
Contrast 100 = 2roza]

@ Keyonblack () Blend

100 = 50

Saturation = 0 100

The Database option allows you to select different types of natural sea databases (for example, Digital Globe).

The Natural Sea panel allows you to control the appearance of the sea when colored with the Natural Sea option,
which uses satellite imagery of shallow seas and reefs.

6.4.6 Ocean Contours Panel
| Shading | Relief Color | Natural Earth | Natural Sea | Ocean Contours

Scale: [y v
. 199
-3999 Opacity ‘
-5999
-7999
L -9999

The Ocean Contours panel allows you to define the ocean depths corresponding to each color.

The left ramp works in exactly the same way as the ReliefColor ramp. The right scale shows how the color ramp is
applied to the ocean depth steps.

See Also

® Setting Map Features
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6.5 Markers Panel

The Text panel allows you to choose a marker to identify each point feature, and the Strap panel allows you to

choose a marker to be drawn alongside the label.

The Markers panel allows you to display and edit the available markers, and specify the scale and position of each

marker.

Styles | Topography | Markers [ Textures I Lighting I Map Features I Options I Quick Styles]

Scale

-
B % 1.00

Capital <1M
Capital <100K
Capital <10K
Place >1M
Place <1M
Place <100K
Place <10K
Mountain

[ Fix aspect ratio

File C:\Program Files [x86)\Curious Software\Curious
2

= Width 11.00
Y 100 = Height 11.00

4 4

6.5.1 To Load anImage for Use as a Marker

Click the + button and select the image file you want to load.

6.5.2 To Edit the Name of a Marker

1. Select the marker in the Markers list.
2. Click the Rename... button.

6.5.3 To Delete or Replace a Marker

1. Select the marker in the Markers list.
2. Click the X or Replace... button.

6.5.4 To Edit a Marker

1. Select the marker in the Markers list. The marker is displayed in the preview window to the right of the

Markers list.

2. Specify the scale by editing the X, Y, Width, and Height fields, as required.

3. Select Fix aspect ratio to keep the aspect ratio fixed.

4. Click the + button and click on the preview window to set the origin for the marker.
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6.6 Textures Panel

The Color panel allows you to choose a texture to color an area feature.

| Styles I Topography I Markers| Textures ILighting I Map Features I Options I Quick Stylesl

»  Line Stamping Options
Spacing 2.00
Scale 1.00

Animation Speed 0%

Stamp End Only [
Follow Path

E1E )
k!

-
ﬂ File  C:\Usersh\PublichPictures\Sample Pictures\Deser

The Textures panel allows you to display and edit the available textures.

6.6.1 To Load anImage for Use as a Texture

Click the + button and select the image file you want to load.

6.6.2 To Editthe Name of a Texture

1. Select the texture in the Textures list.
2. Click the Rename... button.

6.6.3 To Delete or Replace a Texture

1. Select the texture in the Textures list.
2. Click the X or Replace... button.

6.6.4 To Display a Texture

Select the texture in the Textures list. The texture is displayed in the preview window to the right of the Textures
list.
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6.7 Lighting Panel

Every style sheet can contain one or more lights, called style lights, which are used in addition to any lights you
have added directly to an individual map layer. Since the lights are in the style sheet itself, they are applied to any

map layer using the style sheet.

The Lighting panel allows you to define style lights, and specify their characteristics:

| Styles | Topography | Markers | Testures| Liahting | Map Features | Options | Quick Styles |

Light

LT A Pinonmsp | X 38400
Type | Highlight v

{1 o arg Scale with map Y 288.00

Ambient Level Colar \Width 100.00

Brightness Height 100.00

4ngle 0.00
2|

4/ 4/»

4/»

You can use the Light tool on the Lighting panel to edit style lights in exactly the same way as lights within the

layer.
See Also

e Lighting and Effects
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6.8 Map Features Panel

| Styles I Topographyl Markers I Textutes| Lightingl Map Features \Dptions I Quick Styles

Global Map Data Local Street Data
Enable Draw land
Lakes [None v] Lakes [Maior Lakes v]
Rivers [None v] Rivers [W’ide Rivers ']
Roads [None v] Roads [AII v]
Rail [None v] Rail [Main v]
Scale roads/rail with map: Scale Factor  1.00 -2 _?I

The Map Features panel allows you to define the map and street data to be included in the map layer, and the
scaling of road and rail features.

You can override these for a particular map layer using the Map Features dialog box. See the Setting Map Features
section.

6.8.1 Global Map Data

Allows you to specify which lakes, rivers, roads, and rail features are displayed by choosing the appropriate option
from the corresponding drop-down menu.

6.8.2 Local Street Data

Allows you to specify which lakes, rivers, roads, and rail features are displayed in street data by choosing the
appropriate options from the corresponding drop-down menu.

The Enable option allows you to specify whether or not street data is displayed in the map layer.

The Street Data... button displays the Street Data Directory dialog box, and is equivalent to choosing Street
Data... from the Import menu.

For more information about working with street data see the Working with Street Maps section.

6.8.3 Scale Roads/Rail with Map

Determines how roads and railways are scaled as the map is scaled.

The Scale Factor setting is used to scale all line features, such as road, rail, and rivers. You can adjust the value to
achieve particular effects; for example, reduce it below 1.00 to make all line features thinner.
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6.9 Options Panel

l Styles I Topography I Markers I Textures I Lighting I Map Fealules] Options lQuick Stylesl

Land Drop Shadow Border Widths River Widths Lat/Long Settings
7] On Country 100 = Master Scale 100 = [7] Draw lines on land as well as sea
Alsa draw in: - Smaller Rivers 070 B [ Prune longitude lines at poles

Region 0.50

(V] lakesdwide rivers Scale = Longitude line spacing |10 degrees =
[V] narrow rivers : x : . =
SubRegion 050 [ Max Width (Pixels) 200 [ Latitude line spacing | 10 degrees v

A
[setings.. | 0 om0 .
Customize Spacings...

Line color and width may be set by editing the
""Latitude/Longitude" style.

|-

The Options panel allows you to control the land drop shadow, line widths, and the appearance of latitude and
longitude lines.

Drop Shadow ]

Land Shadow for
Political Style Sheet

On VI

% 300 =

y -3.00 =
Opacity o
Softhess 2 =

coior [ 2|

¢ Land Drop Shadow: Allows you to specify whether land is displayed with a drop shadow, and whether a
drop shadow is also displayed for lakes/wide rivers and/or narrow rivers. Click the Settings... button to
define the shadow.

¢ Border Widths: Allows you to specify the line widths for country, region, sub region, and coast outlines.
¢ River Widths: Allows you to control the width of lines used to draw rivers that are not wide enough to be
drawn as area shapes.
¢ Master Scale: Affects the width of all rivers drawn as lines.
¢ Smaller Rivers Scale: Affects the width of rivers which are classified as minor rivers.
e Max Width (Pixels): Determines the maximum line width at which rivers are drawn. This is useful if
you wish to prevent rivers being drawn as very thick lines as a map zooms in.
¢ Lat/Long Settings: Allows you to control the appearance of the latitude and longitude lines, drawn in the
Latitude/Longitude style.
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* Todraw lines on both land and sea, select Draw lines on land as well as sea. If unchecked, the lines
are drawn on the sea only.

¢ To prevent longitude lines from drawing at the poles, where they are very close together and
eventually meet, select Prune longitude lines at poles.

Customize Lat/Long Spacings s
Spacing
@ Set Lat/Long Spacing
) Set Number of Lat/Long Divisions
Longitude (x) 500 -2

Latitude [y) 5.00 =

Origin
Longitude [x) 0.00 =2
Latitude [y) 0.00 =

hd

* To alter the spacing of the longitude and latitude lines, choose an option from the appropriate line
spacing pop-up menu, or choose Custom and click the Customize Spacings... button to specify the
spacing or number of divisions and origin explicitly:

* The color and width of the lines can be changed by choosing the Latitude/Longitude style on the
Styles panel.
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6.10 Using Imported Relief Data

Viz World Classic allows you to import additional detailed relief data. A wide range of data is available directly from
Vizrt and from third parties. Supported file formats include:

e CDM (Curious DEM) from Vizrt.

¢ Some types of DEM and SDTS from USGS, who provide data for most of the US and a number of other areas
of the world.

* Some BIL images from Global Terrain.

¢ Some types of SRTM and DTED format data.

Please contact your local Vizrt representative for a full list of supported file formats and data products.
This section contains information on the following procedures:

® To Import CDM Relief Data

® To Import Relief Data

To Obtain DEM Data

To Undo DEM Imports

To Use Multiple DEM Databases

6.10.1 ToImport CDM Relief Data

1. On the Import menu, select Curious CDM DEM Data....
2. Choose where the data is to be installed and click the Copy New Data... button.

For each set of CDM data you want to use you need to add a license in the usual way. To show a list of the CDM data
you have installed, and its license status, click the Check existing data for bad files or licenses button.

6.10.2 To Import Relief Data

On the Import menu, click DEM Digital Elevation Model.... The Import Digital Elevation Model dialog box is
displayed.

This shows the contents of the relief database, and allows you to add new files to the database. The Import DEM...
button allows you to import DEM files from external sources.

You can undo the most recent imports using the Undo Imports button, or fit the map to the selected imports using
the Fit Map To Imports button.

Because imported DEM data does not always match exactly with the data provided as standard with Viz World
Classic, seams sometimes are visible at the edges of imported data. To avoid this, you can animate the amount of
imported relief to be used, so that the imported relief is only visible when zoomed in enough that no such edges are
visible, using the Imported Relief Blend control in the Map Features dialog box; for more information see the
Setting Map Features section.

6.10.3 To Obtain DEM Data

Because DEM data for the whole world would occupy literally thousands of gigabytes, the data usually comes in
tiles. You need to obtain several such tiles to cover the area you require.

For information about obtaining DEM data contact your local Vizrt representative.
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6.10.4 To Undo DEM Imports

Because of the sheer amount of data involved with DEM files, and the unfortunate fact that DEM tiles need not
actually have straight sides, providing a facility for undoing imports requires significant amounts of disk space.

Viz World Classic allows you to choose how much disk space to be allocated for undo information in the Options
dialog box. You can only undo the most recent imports from the bottom of the import list, and it may not even be
possible to undo these if there was insufficient disk space to hold the required undo information.

6.10.5 To Use Multiple DEM Databases

You can change the directory that Viz World Classic uses to store DEMs in the Options dialog box. Using several
different directories allows you to have multiple DEM databases, each of which holds detailed relief data for a
particular area. This can be useful if you need high-resolution relief data for a particular project, but do not want to
keep using that imported data in your normal day-to-day work.
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7 Reusing Design Elements

This section explains how you can easily reuse styles, layers, and colors which you have created in earlier projects. It
also describes recommended techniques for setting up and sharing style sheets, templates, and projects between
users.

This section contains information on the following topics:

¢ Importing from a Project
® Reusing Style Sheets

¢ Using Templates

® Reuse Design Elements
¢ Using Color Palettes
Sharing Databases

7.1 Introduction

From the outset Viz World Classic has been designed to allow you to separate the design of the appearance and
house style of your map animations from the creation of the individual maps themselves:

® You can import styles, presets, color palettes, or layers from another project, to allow you to use themin a
new project.

¢ Style sheets record all the essential information describing how a map should look, and can be reused in
different projects.

¢ Templates allow you to set up blank projects containing selected styles, layers, and settings ready to be
used for the creation of new projects.

¢ User map details and alternate names databases allow you to standardize alternative spellings for place
names and user added places.

Each of these features is a powerful tool for standardizing maps developed by a group of users, and they can be
shared between users by saving them into a directory accessible by all users and machines.
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7.2 Importing from a Project

The Project Import dialog box allows you to import styles, presets, colors or layers from another project.

7.2.1 Tolmportfrom a Project

1. On the Import menu, click From Project.... The Open dialog box allows you to select another project to

import from:
ﬂ Open @
Look in: | Styles - @ T &
T Name : Date modified Type
S { " Alistyles.cmp 10.04.2011 16:33 CMP File

Recent Places

Desktop
Libraries
8

.

Computer

‘m
~ <« | i »

Network

File name: AllStyles.cmp v Open

Files of type: [Project {*.cmp;”.cap) '] [ Cancel ]

2. Select the project you want to use and click the Open button. The Project Import dialog box shows the
reusable features in the project, and allows you to select which features you want to import:
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Styles | Presets | Colors | Layers |

fﬁ

Political
ShadedGlobe
BrightPolitical
CentreFocus
News1
News2
News3
NewsNoRegionNames
PoliticalRelief
Physical
PhysicalLight
P

m

hysicalSelection
LowMountains

HighMountains
Desert

Load

Cancel

Viz World Classic User Guide - 24.1

3. Click the Styles, Presets, Colors, or Layers tab as appropriate and select the features you want to import.
4. Hold down SHIFT to select multiple contiguous items, and CTRL to select multiple non-contiguous items.

5. Click the Load button to import the specified features into the current project.

Copyright © 2025 Vizrt

Page 149



Viz World Classic User Guide - 24.1

7.3 Reusing Style Sheets

Careful design of the styles you wish to use can greatly increase the speed at which high-quality maps can be
created by a group of users. Users just need to select the correct style, and they can then create maps without
having to be concerned with the design or appearance.

A number of sample style sheets are included with the software. You can import these as described below.

7.3.1 To Share a Stylesheet between Projects and Users

Once you have designed a style sheet that you would like to use in other projects, or make available to other users,
you can save it to disk as follows:

Styles Editor
Style Sheet

Monochrome
Natural Earth
Qutline
Physical

Physical Selection
PoliticalRelief
Virtual Earth

(V] Use for new map layers

() () (enane-) 2]

[Export...] [Import...] [ Link... ]

Click the Export... button in the Styles Editor dialog box to save a copy of the style sheet in a shared directory.

Note: Each user can then import styles from the style sheet file using Import... in the Styles Editor.

Copyright © 2025 Vizrt Page 150



Viz World Classic User Guide - 24.1

7.4 Using Templates

When you create a new project you can choose to base it on a project template which defines the default styles,
style sheets, color palettes, and predefined layers and settings to be included. You can save any project as a
template file and then use it as the basis for new projects.

If you create a new project without selecting a template, a default project template is used. A simple default project
template is supplied and automatically used by Viz World Classic, but you can create a new default template of your
own, containing all the settings you want to use on a regular basis.

This section contains information on the following procedures:
® To Create a Project Template
* To Specify a Template as the Starting Point for a Project

¢ To Set the Default Project Template
® To Share Project Templates

7.4.1 To Create a Project Template

1. Create a new blank project.
2. Define or import all the styles, color palettes, Navigator presets, and layers you would like to have in the

template.
3. On the File menu, click Save As....
K Save As @
Savein: || Projects - @ &
D= Name . Date modified Type
ol No items match your search.

Recent Places

Desktop
Libraries

A

S

Computer

(T
~ 4 LU »
Network

File name: Map Temp v Save

Save as type: [Project Template ("tpl) v] [ Cancel ]

4. In the Save As dialog box choose Project Template from the Save as type (PC) or Format (Mac) drop-down
menu.

5. Enter a name for the template and click the Save button. Opening the template then creates a new untitled
project containing the contents of the project you saved, and you are prompted to give it a new name when
you save the file.
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Select Use a project template in the Welcome or New Project dialog box, and select the particular template you

want to use.

7.4.3 To Set the Default Project Template

Options

=) Display

General

Map Labels
Intemational Font
Shape Controls
LUT Settings File
Proxies

=) Keyboard

Shortcuts

Tool Modffiers

Database
Locations
Attribution

Map Legend
Map Projection
Bing

Ninitsl Rlnha

m

The default template is used to specify the initial contents
of new projects.

C:\Program Files (x86)\Curious Software\Curious World

1. On the View menu, click Options....

2. Click the Template option to display the Template panel.

3. Click the Browse... button and select the appropriate template file. The default project template is used
whenever you create a new project by selecting Create map project in the Welcome or New Project dialog

box.

7.4.4 To Share Project Templates

To share project templates put them into a shared directory. All users can then use the same styles, colors,

Navigator presets and layers by default.
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7.5 Reuse Design Elements

7.5.1 Reuse of Stylesheets

Careful design of the styles you wish to use can greatly increase the speed at which high-quality maps can be
created by a group of users. Users just need to select the correct style, and they can then create maps without
having to be concerned with the design or appearance.

7.5.2 Reuse of Layers

You can use templates to provide users with an initial set of layers for use in the maps they are creating. For
example, if the users are creating maps, all of which contain the same logo and headline text, you could create a
template containing the appropriate image and text layers.

7.5.3 Reuse of Navigator Presets

Templates include the Navigator presets, which are a quick way of defining a map’s position and scale. If you
frequently use a small number of set map settings you can save these as a preset in a project template and make
them available to all users.
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7.6 Using Color Palettes

Templates include color palettes, which are selections of user-defined colors in the Color dialog box:

Color (]

You can create several palettes and select the one you want to use from the pop-up menu above the palette.

This section contains information on the following procedures:

To Edit the Color Palette
To Select a Color

® To Pick a Color from the Viewer
To Add the Current Color to the Palette
To Delete a Color from the Palette

To Create a New Palette
® To Save or Load Palettes

7.6.1 To Editthe Color Palette

Color (]

HedvGreen RB >< .. . ..
[ |

g0 of
’ Load Palelle][ Save Palette l

_?I ’ Apply ] [ Palette Only ] ’ New Palette ][Delete Paletlel

Default v

Click the Edit Palette button in the Color dialog box. The full Color editor is displayed (see above).

° Tip: To cancel the operation / close the palette editor click Palette Only.
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7.6.2 To Selecta Color
Either:

¢ Clickin the color space in the top left corner of the Color chooser.
Or:

e Click the color sliders in the top right corner of the Color chooser.
Or:

® Enter the color values in the fields to the right of each color slider.

You can change the color space displayed in the Color chooser by choosing an option from the pop-up menu. You
can change the values shown on the color sliders, and the range of each value, using the two pop-up menus below
the color sliders.

7.6.3 To Pick a Color from the Viewer

Click the Pick Color () tool. Click in the Viewer to select that color.

7.6.4 To Add the Current Color to the Palette

Click the Add Color (E]) button.

7.6.5 To Delete a Color from the Palette

Click the color to select it. Click the Remove Color (@) button.

7.6.6 To Create a New Palette

Click the New Palette button below the palette. The new palette becomes the current palette.

7.6.7 To Save or Load Palettes

Use the Save Palette and Load Palette buttons. This is useful for exchanging palettes between different users,
archiving them for future reuse, or copying them from one style sheet or project to another.
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7.7 Sharing Databases

New features, defined using the Add New Label or Add New Feature dialog boxes, are stored in a user map details
database; for more information see how To Define a New Feature on the Map or how To Define a New Feature from
Explorer.

Alternate names, defined using the Properties panel on the Contents panel, are stored in the alternate names
database; for more information see the Setting the Properties for Details section.

The user map details, alternate place names and abbreviations databases can be shared between users by placing
them in a shared directory. This allows users to benefit from any user map details and new names added to the
database.

This section contains information on the following procedure and topic:

® To Share User Map Details, Alternate Place Names
¢ Editing User Map Details or Alternate Place Names

7.7.1 To Share User Map Details, Alternate Place Names

User map details and alternate place names are stored in text files, and can be shared among users by placing them
in a shared directory. To modify the location of these files:

1. On the View menu, click Options....
Options @

i LUT Settings File

>

Shared User Map Data

H - Proxies User Map Details and Altemate Names are stored in text files, and can be
= Kgyboard shared amonast users if placed in a shared directory.
i Shortcuts
.. Tool Modifiers Changing these filenames takes effect next time you run the software.
- Template
© Ma pD User Map Details are added using the New Feature button
C:\Program Files (x86)\Curious Software\Curious Worl
- DEM
- Database = Altemate Names for map details can be set in the Map
- Locations Details Properties tab
- Atribution C:\Program Files (x86)\Curious Software\Curious Worl
- Map Legend
- Map Projection
- Bing i Abbreviations
- Digttal Globe C:\Program Files (x86)\Curious Software\Curious Worl
- Locations
[=)- File Formats
LG
- Numbering
=), Pairt ~

2. In the Options dialog box select Shared in the Map Data section.
3. Click the Browse... button and specify the new location for the appropriate file.
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7.7.2 Editing User Map Details or Alternate Place Names

You can edit the user map details, alternate place name and abbreviations files using a simple text editing
application such as Notepad, Notepad++ or SimpleText. This can be useful if places or names have been added
incorrectly and need to be deleted or modified. You can find the path and filename of each file as described above.
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8 Working with Images and Movies

This chapter contains information on the following topics:

® Moving, Resizing, or Rotating an Image

¢ Specifying the Contents of the Image

¢ Using the Keyer

* Image Rotoscoping

e Setting the Image Properties
® Importing an Image or Movie

Viz World Classic supports a wide range of alternative image and movie formats, summarized in the table below.

Note: Viz World Classic 64-bit version does not support movies added as layers.

Extension
.avi

.bmp

.cin

.cmr

.exr

.dpx

.gif

iff

Jpg or jp2
.mov

.ntf

.sid

.psd

.pct

Format

Video for Windows movie

Windows bitmap

Kodak Cineon image

Curious Multi-Resolution bitmap image
OpenEXR image

DPX image

Graphic Interchange Format
Alias/Wavefront Paint Image

JPEG compressed image

QuickTime movie

National Imagery Transmission Format
MrSID multi-resolution image (PC only)
Adobe Photoshop image (supports transparency)

Macintosh PICT
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Extension Format

.png Portable Network Graphics (supports transparency, paletted, grayscale, and
true-color images)

.sgi or .rgb Silicon Graphics Image (supports transparency)
.tga Targa bitmap

.tif or .tiff Tiff bitmap format

.qtif QuickTime image

8.1 Curious Multi-Resolution Format

Viz World Classic provides the proprietary CMR (Curious Multi-Resolution) image format, which allows very large
images to be included in maps without the memory overhead normally associated with images in the standard file
formats. CMR formatted images can be used in any context where an image file can be specified, including in image
layers and as textures for maps. For example, satellite images and high-resolution photographs can be used to fill a
region of a map. When you zoom in close, an appropriate high-resolution tile of the image is loaded, avoiding the
need to have the whole high-resolution image loaded at all times.

An optional Convert Large Images tool allows you to convert an image into CMR format from any of the common file
formats including Photoshop, TIFF, and BMP.

8.2 Cineon Files

Viz World Classic includes support for Cineon files, which use a logarithmic color space to provide a better
representation of dark colors. Because Viz World Classic works in a linear color space, it allows you to specify how
Cineon files are handled on loading and saving.

¢ On the View menu, click Options....
¢ In the Preferences dialog box select Cineon in the File Formats section. The following options are provided:
* No conversion: The images are left in logarithmic space, so loading them and saving them again
makes no alteration to the pixel values in the files. You can use the Viewer LUT Controls option to
compensate for the darker appearance of Cineon files when working with them in the Viewer.
¢ Convert to/from linear : Converts Cineon files from the logarithmic color space to the linear color
space on load, and back again on save. An allow headroom option varies the conversion so that
overexposed images retain more detail in the very bright overexposed regions.

Copyright © 2025 Vizrt Page 159



Viz World Classic User Guide - 24.1

8.3 Moving, Resizing, or Rotating an Image

The Move/Pan tool () button allows you to move, scale, or rotate an imported image or movie.
This section contains information on the following topics:

* To Move an Image
® To Resize an Image
* To Rotate an Image

8.3.1 To Move anImage

Position the mouse pointer within the image and drag the image to the required position.
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8.3.2 To Resize an Image

1. Move the mouse pointer to one of the eight handles on the corners or midpoints of the edges.

2. Drag to resize the image.
3. Hold down CTRL to constrain the image to its original aspect ratio.

8.3.3 To Rotate an Image
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1. Point to the rotation handle, which is a yellow square to the right of the image center. The cursor changes to
a rotation symbol.
2. Drag the handle to rotate the image about its center.
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8.4 Specifying the Contents of the Image

Properties | Contents iPaint | Lighting | Layer Fx l Keybars|

Source | Keyer | Roto Matte

Treat as Movie
Hold frame before start
Hold frame after end

DSCF6552.png

Image Layer:
Raster Image
500 x 375, 8bitRGB

Loop movie
@ Auto 1
Field Ordering: ) Every 10
@ Full frame () Upper/E ven first

() Lower/0dd first

Change Image... Alpha Start at o

Memory storage of frames:

D] Lock frame range into memory
[0- 9 locked]

Clear locked frames

The Contents panel displays information about the image or movie, and provides options to allow you to change

the contents.
This section contains information on the following topics:

¢ Controlling Image Transparency
¢ To Set the Start Time and Looping

8.4.1 Controlling Image Transparency

Images and movies used in an image layer may contain an alpha channel (or matte) which defines transparent

areas of the image. You can specify how the alpha channel is interpreted to give greater control over the

appearance of matted images.

Alpha Interpretation

@ Guess
) Treat alpha as straight [unmatted)
' Treat alpha as premultiplied [matted with black)
' Treat alpha as matted with white
' lgnore alpha

=]

-

0K ] [ Cancel

Click the Alpha... button to display the Alpha Interpretation dialog box. By default Guess is selected, which

automatically selects the best option in most situations. Choosing the correct option should produce an image
without noticeable banding, fringes, or speckling around the edges. You can choose one of the other options if

Guess does not give the results you expect, or Ignore alpha to treat the image as if it had no transparency.

The following illustrations show the effect of the options:. Correct (unmatted), incorrect (premultiplied) and alpha

ignored:
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8.4.2 To Setthe Start Time and Looping

1. Use the Hold frame options to specify what is displayed before the start time and after the end time.
2. Select Loop movie to play the movie in a loop.

e Auto: Loops the entire movie, between its start and end frames.

¢ Every: Allows you to specify the loop frequency.
3. Edit the Start at time value to determine the start time of a movie.
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8.5 Using the Keyer

Properties | Contents lPaint I Lighting I Layer Fx I Keybars |
’ Source | Keyer | Roto Matte |
") NoKey

@ Color Pick Backgrou Softness 0 0=
Chrominance X
* Luminance Pick Foregrour Erode
’ 0% =
Suppress Amount
0 0.00 =

Suppress To |
Keep Alpha (V]

The Keyer creates a matte which is used to cut out the foreground from the background. Mattes created with the
Keyer can be saved and reused in other projects or applications.

8.5.1 To Key anImage or Movie

1. Click the Contents tab, to display the Contents panel for the image or movie.

2. Click the Keyer tab, to display the Keyer.

3. Select Color, Chrominance, or Luminance to determine how keying is performed.

4. Select the Pick Background or Pick Foreground tool, and click appropriate parts on the image to add the
corresponding colors to the range defined as background or foreground.

You can drag to define a rectangle to average the colors in the rectangle.
The sliders provide an alternative way of adjusting the components you have selected.

Each slider has four handles:

R

The white handles specify the range of colors treated as background, and the black handles specify the range of
colors treated as foreground. Between each black handle and the corresponding white handle there is a smooth
transition between foreground and background.

¢ Drag the Erode slider to reduce the size of the masked area, to hide edge effects, and add a softness to blur
the edge of the image.

¢ Use the Suppress Amount and Suppress To controls to reduce the amount of the keyed color from the
image.

This is useful for hiding reflections from the blue or green screen.

8.5.2 To View the Effect of the Keyer

The paint controls to the right of the Keyer allow you to choose whether the Viewer shows the keyed image, Keyer
matte, or both:
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Display Image
| Display Matte .l
» S

,

BG Fill .

Render Matte ...

8.5.3 To Render the Keyer Matte

Render Layer Matte @
Output: [E!uickT ime Movie v]
Matte: () Roto Matte @ Keyer Matte () Combined Mattes
Settings

User Set, 1024 » 1024
Frame Rate 30.00 fps

] Render RGBA Movie (Millons of Colors+)

Premultiplied alpha [matted on black)

Field Render... No Field Rendering, Flicker Filter On

Render Range
@ Whole Project

(") Slider Range
(") Part of the Project:
Start 0 End 59 Dur 60
Render in Background Render ] [ Close ] _?I

¢ Click the Render Matte... button in the paint controls.
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This is equivalent to the Render Matte... command on the Layer menu, and displays the Render Layer Matte
dialog box to allow you to render the Keyer matte and/or the roto matte as a separate movie.

8.5.4 To CutanImage from a Blue Screen

The following example illustrates a typical application of the Keyer, to cut out a subject filmed against a blue-screen
or green-screen background, so it can be superimposed on another background.

1. Load the image or movie into a new image or movie layer.

2. Click the Keyer tab to display the Keyer.

3. Click the Contents tab, to display the Contents panel for the image or movie.

4. Select Color to key on a specified color range.

5. Select the Pick Background tool and drag to define a rectangle enclosing the blue-screen background:

When you release the mouse button the keyed image is displayed.

You can refine the keyed area by clicking or dragging with the Pick Background tool to increase the areas of
background removed, or by clicking or dragging with the Pick Foreground tool to reduce the areas of background
removed.

Alternatively you can adjust the key using the color, chrominance, or luminance sliders.

8.5.5 To Remove the Color Cast

Subjects filmed against a blue-screen or green-screen typically have a blue or green cast. The Suppress option
enables you to remove this.
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Suppress Amount
, 0 080 =

1. Drag the Suppress Amount slider until the cast is removed. Too high a value introduces a contrasting cast.
2. Optionally change the Suppress To color to suit the replacement background.

You can then superimpose the subject onto an alternative background:
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8.6 Image Rotoscoping

| Properties | Contents :Painl I Lighting ] Layer Fx I Keybarsi
: Source I Keyer | Foto Matte

Shape | Points | Propetties | Animation | Display

[V] Apply Roto Matte [
Q New Polygon - (————————  Shape Properties
Invert v New Bez [@ Move Shape |Smooth J
;| New Bezier fShapen @ Filled Outline
Background Removal ( C New B-Spiine [E;] Open Shape ¢ ) @ Open
o N —a ivi
Ao:me l. Q; New Fr [&] Divide Shape Closed
utomatic 0 .
(%] New Cicle M Join Shapes
Assume Color [l % Use To Cut Hole
+
Q| NewElipse Freehand Shapel [C]l@ () |
Show Keybars... E New Rectangle | Rename ... E] @ » [le Shepe B Keve @

The Roto Matte panel on the Contents panel allows you to add one or more shapes to an image or movie layer to
mask dynamically, tracking them as they move in successive frames. This is often referred to as a roto matte or
rotoshape.

For more information about creating and editing shapes see Working with Shapes.

8.6.1 To Create an Animated Shape

1. Move to the first frame of the movie.

2. Create one or more shapes using the shape tools to outline the feature in the movie that you want to
process.

3. Move to the last frame in the movie, and adjust the shape so that it matches the feature.

4. Check the intermediate frames, and make any necessary adjustments to keep the shape tracking the
feature.

8.6.2 To View the Effect of the Roto Matte

¢ Select Apply Roto Matte. The roto matte dynamically cuts out the image to reveal the background:
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® The paint controls to the right of the Roto Matte panel allow you to choose whether the Viewer shows the
keyed image, roto matte, or both:

Display Image

| Display Matte !

-

]

BG Fill !J

Render Matte ...

8.6.3 To Render the Roto Matte

Click the Render Matte... button in the paint controls. This is equivalent to the Render Matte... command on the
Layer menu, and displays the Render Layer Matte dialog box to allow you to render the Keyer matte and/or the
roto matte as a separate movie.
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8.7 Setting the Image Properties

Properties | Contents | Paint | Lighting | Layer Fx | Keybars |
[> Compositing Options Automation Map Usage Project
[> Transf : .
g Er]aD orrsn o Pin on map [Fll project to layer... ]
P h Wrap oh map [Scale layer to project ]
> Frame E] Apply Track Data '
B> Edgi Scale with map Foset
ing (= 1.00) LE=SE
Image Placement | Appl
B> Trail (] mag
> Producer Export Match rotation to path
[> Instant Maps Export
Reset [ Transformation ]
[Transformation animalion]

The options on the Properties panel allow you to specify the compositing options for the image or movie,
transform it, and add a drop shadow, frame, edging, or animation trail. It also provides several animation options.

This section contains information on the following topics:

* Compositing Options

* Transform Options

¢ Drop Shadow Options

® Frame Options

* Edging Options

¢ Trail Options

® Export Producer Options

® Instant Maps Export Options
* Automation Options

* Mask Options

8.7.1 Compositing Options

V Compositing Options -
Blend Mode - |4

Opacity r 100%

Use Paint Mask as a

Obey Composite Mask

Blend Mode specifies how the layer is combined with the other layers, and can be one of.

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, Screen, Lighten Only, Dodge, Color
Dodge, Hue, Saturation, Value, Color, Overlay, Soft Light, Hard Light, Pin Light, Exclusion, or Negation.
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The Opacity determines the layer opacity, and can be animated.

Animating the opacity from 0% to 100% can be used to cause the image to fade in smoothly over a specified period
of the animation.

8.7.2 Transform Options

V Transform ‘3
TrEe Long[ -7560 [ Lat | 4264 [ -
Pinned on Map
Wrap on Map
Set Using GPS
Scale X[ 1003 v[ 100
Scale with Map

. T
Rotation G %) ,W%
Match Rotation to |3

These options allow you to specify the position, scale, rotation, and origin numerically.
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The Set Using GPS button is used to position the image using UTM coordinates, which are normally supplied with
aerial photographs and satellite imagery, or using latitude/longitude coordinates.

Latitude and longitude coordinates can either be entered in decimal degrees, such as 20.175, or in degrees, minutes
and seconds, such as 20d10m30s.

Forimages provided by Global Terrain Inc., the Use Metafile... button reads the UTM coordinates directly from the
metafile provided with the image.

The Pinned on Map, Wrap on Map, and Scale with Map options duplicate the options in the Map Usage section of
the Properties panel; for more information see how To Choose How the Image Moves Relative to the Map.

To Change the Origin of the Image

The origin determines the point about which the image is rotated or scaled, and defaults to the center of the
image. Edit the Origin values to specify the position in pixels relative to the lower left corner (south-west) of the
image, or choose one of the predefined options from the Origin drop-down menu.

8.7.3 Drop Shadow Options

V|| Drop Shadow
Offset X 3.00 =
Opacity
Softness
Color

Select Drop Shadow to turn on a drop shadow for the layer. The following parameters are provided:
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Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the drop shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the range 0-5 are
recommended.

Color The color of the drop shadow.

The following example shows a drop shadow with offset X=3, Y=3, and Softness=2:

8.7.4 Frame Options

¥V Frame
Fill Color ﬁl
Border Color ﬁ]

Border Width - 500 [+

Allows you to add a colored fill, and/or border to the layer. Border Width specifies the width of the border in pixels.
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8.7.5 Edging Options

V Edqing
1z ’ None v l
Size G | 500 %

The Edging options allow you to add a vignette to the image or movie.

e Choose Rectangle or Circle from the Type pop-up menu to vignette the image with a soft border of the
corresponding shape.
¢ Use the Size control to adjust the size of the shape.

This option is especially useful when superimposing one image on another, to hide the edges of the top image.

The following example shows a circular vignette with a size of 100:

Copyright © 2025 Vizrt Page 176



Viz World Classic User Guide - 24.1

8.7.6 Trail Options

W Trail
Trail Width { 5.00
Trail Color .|
Trail [Off ,]
Trail Above il

The Trail options allow you to leave a trail as the image animates. For more information see the Leaving an
Animation Trail section.

8.7.7 Export Producer Options

V Producer Export
Producer Segment BG Not Used

Note: No longer supported.

8.7.8 Instant Maps Export Options

WV Instant Maps Export =
Selectable in IM 7 =

Allows you to make maps available to the Viz World Instant Map tool.

8.7.9 Automation Options

The Properties panel includes an Image Placement tool, to help align images accurately to positions on another
image.

¢ Click the Image Placement tool in the Automation section of the Properties panel.
Two arrowhead controls are displayed in the Viewer to allow you to indicate the transformation you want.

® Position the circles on two appropriate points on the image.
¢ Position the arrowheads on the background to indicate where the points should be mapped to.
® Click the Apply button.

The image is transformed to align the points on the image with the points on the background you have specified.

To Choose How the Image Moves Relative to the Map
Viz World Classic provides several options that allows you to control how the image moves relative to the map layer.

By default the image position is independent of the map position. Pin on map keeps the image at the same latitude
and longitude as the map moves. Wrap on map projects the image onto the map, according to the map projection.
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Only available if Pin on map is selected. Alternatively, Scale with map scales the image as the map is zoomed. Only
available if Pin on map is selected.

These options are selected in the Map Usage section of the Properties panel.

The images below show a map with default, pin, wrap and scale modes:
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8.7.10 Mask Options

See Controlling Layer Compositing.

See Also

¢ Auto Animate and the Automatically Animating a Layer section.

¢ Match rotation to path and how To Align the Image, Text Item, or Drawing to the Angle of the Animation
Path.

¢ Controlling Layer Compositing
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8.8 Importing an Image or Movie

This section contains information on the following topic and procedures:

® Tolmport anImage or Movie

* To Convert an Image to a CMR Format

® To Convert Multiple Geo-referenced Images to a Single CMR Image

¢ Using Geo-referenced Images

To Add Geo-referenced Images
To Add Satellite Images

8.8.1 TolmportanImage or Movie

& Open (=X
Look in: , Viz Curious Maps v @ ; =g g
I Name : Date modified Type
"'} . EnhancedDEM 26.05.2011 11:06 File folder
RecentPlaces | G, amANdHawaii_DEM 29.05.2011 17:53 File folder
! . JAPAN-CMRs 26.05.2011 11:45 File folder
\& ValentinesDay.tiff 30.05.2011 11:19 TIFF imag
Desktop
Libraries
'
.
Computer
TV
LY < | T »
Network
File name: ValentinesDay tiff v
Files of type: Image Files (".sgi;”psd;” bmp;”aif:" jpa:” pct:"p '] [ Cancel ]

Options

Options...

1. On the Layer menu, point to Add Layer, and then click Image or Movie.
* The following dialog box allows you to select an image to import, and optionally preview it.

Note: Viz World Classic 64-bit version currently do not support movies added as layers.

2. Select the image or movie file and click the Open button to import it.
¢ Anew image layer is automatically created for the imported image or movie. Note that each image or

movie is contained in a separate layer.
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¢ |f you open a project that uses images, or movies, that are no longer available they are displayed as a
red cross.

¢ If you import a movie the Match Time Range to Movie dialog box appears. This allows you to adjust
the time slider’s range and/or the project’s frame size, rate and duration to match the clip you are
importing.

¢ |f they have moved you can use the Change Image... button on the Contents panel to locate them.

8.8.2 To ConvertanImage toa CMR Format

~ ~

Convert Large Image to Curious Multi-Res Format | 88

Image File Conversion
Input Image  C:\Private\DSCF6585.png

QOutput Image  C:\Private\DeadSea.cmr Browse...

[ Convert ] [ Cancel J

1. On the Tools menu, click Convert Large Images.... The following dialog box allows you to specify the image
to convert, and a filename for the CMR (Curious Multi-Res) image:

2. Browse for and select the input image to be converted.

3. Browse for and select the location for the output image and specify a filename for the CMR image, which can
be the same as the input image.

4. Click the Convert button to convert the image to the CMR format. You can then select the CMR image just as
you would any other image in Viz World Classic. You can also make a compressed version in the following
dialog box.

Note: The Convert Large Images tool makes a copy of the original image; it therefore requires at least as
much available disk space as the size of the original image.
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8.8.3 To Convert Multiple Geo-referenced Images to a Single CMR Image

Combine & Adjust Multiple Images s

Input Images E]

or Input Folder

(-]
Output Image E]
-]

Intermediate Images
@ Store Intermediate Images with Input Images
Store Intermediate Images in

[ Keep Intermediate Images

Adjust Tint Key
Brightness  100.0C-2 Tint Color - KeyMode NoKey
Tint Opacity
Contrast 100.0C-= | Key Color [
Gamma 1.00 = Edging Tolerance -1.00

Type NoEdging ~
Saturation  100.0C

<>

Amount [%) 0% =

Convert J [ Cancel

The Convert Multiple Images tool allows you to convert a number of adjacent geo-referenced images into a single
large image, in CMR (Curious Multi-Res) format.

® On the Tools menu, click Convert Multiple Images. The Combine & Adjust Multiple Images dialog box
allows you to specify the input and output images.

¢ Intermediate Images: Allows you to specify where the intermediate CMR files should be stored, and
whether they should be kept after the conversion is finished.

¢ Adjust, Tint: Provides color correction options to allow you to make the resulting CMR file match
other images you are already using.

¢ Edging: Uses a soft edge when joining the individual tiles to obscure any seams that may arise.

¢ Key: Allows you to key out, or remove from the image, areas of a particular color with a specified
tolerance. For example, this allows you to make the sea transparent in the finished CMR image by
specifying blue as the key color.

8.8.4 Using Geo-referenced Images

Much satellite and aerial photography is now available in a geo-referenced format, which includes the precise
location of the image on the Earth’s surface. Viz World Classic supports the following geo-referenced formats:

e GeoTiff: Data is embedded in a TIFF file.
e Tiff World: Data is in an accompanying text file.
¢ Geo-referenced NITF

It is recommended that you convert large geo-referenced images to a CMR format before importing them.
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8.8.5 To Add Geo-referenced Images
Either:

1. On the Layer menu, point to Add Layer, and then click Image or Movie.
2. Select the geo-referenced image file.

A\ Note: Viz World Classic 64-bit version currently do not support movies added as layers

Or:
¢ Add the image as a texture to an existing style in the Styles Editor.

The following dialog box allows you to pin the image to the correct location on the map:

. Georeferencing
@' This image can be georeferenced. Do you want to place the image on
the map according to the georeference coordinates?

= [

Viz World Classic |23

o

¢ Click the Yes button to pin the image using the georeference information.

8.8.6 To Add Satellite Images

["] Show only images containing [j
[ Show only visible images

¥ Japan

v Fukushima

"W 45cm-M..-CMR.cmr 20748 x12250 0.40 Meters/Pixels

¥ Miyagi [ Add to map

l

[ Add to map with crop

)

?’ 45cm-Se...-CMR.cmr 27646 x 36536 0.39 Meters/Pixels

l 15m-BASE...n-CMR.cmr 17588 x 31841 11 Meters/Pixel

=IERE

Path:  C:\Wizrt Software\Viz Curious Maps‘\WAPAN-CMR shd5cm-Soma-J apan-CMRA\45cm-Sor

Enter Keywords:

1] Image Manager =
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1. Select a map layer.

2. Select the Contents tab and then the Overlays tab.

3. Click the Add Satellite Image button.

4.In the Image Manager click the + button to browse for and add your image/CMR.
5. Click the Add to map button.

6. Close the Image Manager.

Note: The imagery is not a part of the base map (see Working with Maps).
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9 Painting

This section explains how to use the paint and image processing tools on the Paint and Graphics panels to paint
directly onto image/movie layers, for retouching or enhancing an existing image, masking areas of an image, or
creating original freehand artwork.

This section contains information on the following topics:

® Painting onto an Image
¢ Adding Graphics to Images
¢ Paint and Image Processing Tools
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9.1 Painting onto an Image

Brushes | Graphics | Shapes | Text | Cutouts [ Fx | Image | Mask | Macros|
Brushes Profie Seltings

. : = =
- Buitn ~| [tinear @  spe 0 LG [0 g
Color Sof & 2 o 1005
= Neon & 2 o 9 o O — L
= N [Eeibe=d 64 ConeOfist  Backgiound Offset ( —

[Tedue | PIOmG RGB v |0-100 v
Reo am | S e ® = w [ _cJo-e ]
Erw ¥ 000 5 0 2 @04 Square - Bl | |
aser === A .
Restore Y (000 | mmrm @ D _(HN |
. - 2Ees2y & @ u_Em mEs

E >4

Blur
P x| Restore (] Pixel Lock |

The brushes on the Brushes panel allow you to paint directly onto an image or movie layer. You can paint onto the
image, mask, or simultaneously onto both. Alternatively you can protect the image with the mask while you are
painting onto the image.

In the case of a movie, painting affects the current frame of the movie, and the mask associated with the current
frame, only. Painting can be applied automatically to multiple frames of a movie by recording and playing back a
macro; see Automating with Macros.

A brush applies color, an image, or a filter directly onto the image or movie through a profile, which defines its
shape.

9.1.1 To Paint the Image or Mask

1. Select the Paint brushes () tool. This tool is automatically selected when you display the Brushes panel.
2. Select the brush you want to use in the Brush list.
3. Select a color for painting from the palette on the right of the Brushes panel.

4. Click on the image and drag to paint.

You can adjust the opacity of the paint with the Opacity slider. If you are using a pressure-sensitive input device,
such as a tablet, the brush strokes respond to the pressure of your pen.

9.1.2 To Choose How the Mouse Cursor Displays while Painting

You can choose to hide the mouse cursor while painting, or display a colored circle or ellipse indicating the size of
the brush:
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The images above depicts a normal cursor, hidden cursor and outlined cursor.

1. On the View menu, select Options...
2. In the Preferences dialog box select Brush Display in the Paint section:

Options =]
- Display Brush Cursor
@" Keyboard \V|iSimple brush cursor
_ Template || Hide cursor when painting
S Map I?ata || Hide cursor when not painting
- Locations
- File Formats Brush Dutline
m r;:'r:tb SN Show brush outine [
_ Material | Hide outiine when painting
- Undo .
. Brush Tools Show clone outiine
- Storage || Hide outline when painting
Brush Tools

|| Center brush around cursor when resizing

You can set separate options for the Clone brush.

You can also turn the outline on or off, and specify its color, by clicking the buttons on the Brushes panel:

|

This section contains information on the following topics:

¢ Specifying the Brush Settings
¢ Creating and Editing Brushes

Defining the Brush Source
¢ Defining Brush Filter Effects
Defining Brush Profiles

* Managing Painted Materials

9.1.3 Specifying the Brush Settings

The Profile, Size, Opacity, and Settings are set to default values specified for the brush, but you can adjust them in
the controls to the right of the Brush list.

To Define the Brush Profile

The brush profile defines the shape of the brush stamp. It is either a circle or an ellipse, with a falloff defined by a
graph, or an arbitrary shaped cutout. There are also the special options: Texture, which creates a brush with a
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random fill pattern, and OnePixel, a one pixel solid brush. Select a profile from the Profile list. This gives a list of
profiles defined in the Brush Editor.

To Define the Brush Size
Either:
* Drag the Size slider.
Or:

® Enter the size in the Size box:

Size L 20 2

Or:

¢ Hold down CTRL and drag in the Viewer, or in the brush preview on the Brushes panel, to draw a circle
defining the brush size.

To Define an Offset

Brushes that take paint from the image or background, such as the Clone and Drag brushes, allow you to define an
offset.

Either:
¢ In the Clone Offset section enter appropriate values in the X and Y fields:
Clone Dffset
¥ 500 =
Y 500 =

Or:

1. Hold down SHIFT and drag in the Viewer to draw a line from the source to the destination to define the
offset interactively.
2. Click the Reset button to reset the offset to zero.

To Define the Background Transformation

Brushes that take paint from the background, such as the Merge brush, allow you to transform the background
before using it for painting.

1. Set the Display option to Single Layer.
2. Select the image layer from the Layers list.
3. Click the image layer’s eye-dropper icon.

4. Click the Background Transformation Tool () button in the Background Offset section to display an
outline of the background image in the Viewer with handles so you can move, scale, or rotate it:
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Backaround Offset
Frame

0 ) B0
I+

B=ks

| Pixel Lock

~D

= 00

Once you have transformed the background close the Edit Merge Transformation to continue painting. You can
store up to four transformations by clicking one of the > buttons and restore the transformation by clicking the 1, 2,
3, or 4 button.

To reset the transformation click the Reset button.

To Define other Brush Settings

Click the Settings... button to display more advanced settings for the brush. The brush settings are described in
greater detail in the later sections of this chapter.

To Reset the Brush Settings to Default
Click the Restore Defaults button.

Built-in Brushes
The following pre-defined brushes supplied with Viz World Classic:

¢ Color: Paints in a selected color.

* Clone: Picks up paint from one area of the image and paints it to another position on the image, as defined
by the offset.

* Merge: Copies paint from a background image on to the current image.

* Drag: Drags paint on the image, causing a smudge effect.

¢ Repair: Picks up color from the image and paints with it; useful for painting over scratches and blemishes in
an image.

¢ Eraser: Erases pixels from the image, making them transparent. Equivalent to painting with the non-color.

¢ Chalk: Paints with a textured brush.

¢ Blur: Blurs the image.

¢ Oil Effect: Creates the effect of layered color in an oil painting.

* Posterise: Similar to Oil Effect, but more severe.

¢ Smooth: Similar to Blur but more dramatic.

* Marble: Mixes up the pixels giving a marbling effect.

¢ Black And White: Convert pixels to monochrome.

To Use the Clone Brush

1. Hold down SHIFT and drag in the Viewer to draw a line from the source point to the destination point:
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The X Offset and Y Offset fields are set to the appropriate values.
2. Paint to create a clone of the image:

To Use the Merge Brush

The Merge brush allows you to copy paint from a background image onto the current image. For example, it can be
used to paint out unwanted features of a scene by using a photograph of the background from the same position,
called a clean plate.

1. Load the background image onto one layer:
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2. Load the foreground image onto the current layer.

3. Set the Display option to Single Layer.

4. Click the eye-dropper icon in the Layers list to indicate which layer you want to merge from

5. Use the Onion Skinning control in the paint controls to reduce the opacity of the foreground, if desired:

6. Use the Merge brush to paint the background over the unwanted feature:
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Wl dns il
The Merge brush also allows you to scale or rotate the background image you are merging from.

7. Click the Background Transformation Tool () button to transform the background.
8. Click the Reset button to reset the background to the original scale and position.

To Protect Artwork with a Mask

1. You can use a mask to protect parts of an image while painting. For example, you could use a mask to
protect the butterfly in the following image while painting over its shadow:

2. Create the mask by using a brush tool. Alternatively, you could mask the butterfly by drawing shape overlays
and then sticking them onto the mask; for more information about creating shape overlays see Working with
Shapes:
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3. Set the paint controls to Protect with mask, Paint Image, and Display Image:

Protect with Mask Fil lmage !l

Clear Image

Paint Image
| Paint Mask Fill Mask |

:Clear Mask

Display Image
Display Mask li Invert Mask
' L

| Onion Skinning
' L

BG || Invert FG

4. Paint the image as required; for example, use the Clone brush to paint over the shadow on the leaf by
copying texture from the other side of the leaf:
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9.1.4 Creating and Editing Brushes

Brush Editor =]}
Brushes | Profiles %
Bt Source | Filters [
[=)- Builtin -
Color Source  Color : :
Clone ) —
Merge = Profile [Soﬂ v] =
Drag Size — T 20 2| Flatess © 1002
Repair
Eraser . o . B —
Pickup | Mormal 0
— p nal ("] Build Up Rotation G ["] Match Path
Chalk Opacity C  Mode [Normal '] .
Blur __ Automatically
il et " )| Decay 000 2 Spacing 015 = Maximum Detall v | [ adiust for
flathess
Rename ? I
{ Export... ] [ Impot... ] Save Defaults || Restore Defaults | [V] Use Shared Settings <No Shortcut> E] Brush Test >>

Viz World Classic is supplied with a range of pre-defined brushes. You can edit some aspects of these brushes, or
you can create your own completely editable brushes using the Brush Editor.

A Brush Test window allows you to try out the effect of the brush you are designing as you edit its parameters.

How Brushes Work

Brushes work by performing the sequence of operations: Pickup > Filter > Stamp. These steps can be customized
to determine the precise behavior of the brush, and are explained in greater detail in the following sections:

Pickup

The brush picks up paint from the specified source, which can be the current color defined in the Color Chooser,
the image or background, or an image cutout. When picking up paint from the image or background, an offset can
be added to the current brush position to clone one part of the image to another part. The paint is picked up
through the selected profile, which determines the size of the brush, and the softness of its edges.

Filter

The paint is optionally filtered by a specified filter, such as to add noise or soften the image.

Stamp

The paint is stamped onto the image according to the decay and spacing parameters. If Protect with mask is
selected, painting takes into account the density of the mask.

To Display the Brush Editor
Either:

¢ On the Tools menu, click Brush Editor.
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Or:
¢ Click the Editor... button on the Brushes panel.

The Brushes list shows a list of the currently loaded brushes. Selecting any brush in the list shows its definition on
the Source, Profiles, and Filters panels and allows you to edit it.

To Create a New Brush

1. Select the brush in the Brushes list that you want to base the new brush on.
2. Click the + button.

The new brush appears under the User heading and by default has Copy appended to its name, but you can
rename it using the Rename... button below the Brushes list.

To Assign a Keyboard Shortcut to a Brush

You can assign up to ten keyboard shortcuts to the brushes you use most frequently so that you can select them
with a single keypress.

1. On the View menu, click Options....

2. In the Options dialog box select Shortcuts in the Keyboard section.

3. In the Paint section of the Keyboard Shortcuts list, select one of the entries labelled Brush Named, enter
the name of the brush in the Brush field, and enter the keyboard shortcut you want to use or click the Type
Key... button and press the key combination on the keyboard:

Options (3]

- General - Invert Onion Skinning -
- Map Labels Backup for Undo
- Intemational Font Update Video
-~ Shape Controls Brush Named Erase Control+Alt+E
- LUT Settings File |
. Prosi Brush Named
“ Proxies

= Keyboard Brush Named
‘.. Shortcuts = Brush Named
i Tool Modifiers Brush Named

- Template Brush Named

=I-Map Data Brush Named i

- Shared A .

- DEM e
-Database Brush Named fase
) Loc.allcfns E v [V] Control [] Shift Alt Type Key

Attribution

-Map Legend
- Map Projection
-~ Virtual Earth
- Digital Globe [ Import... H Export... ][ Reset }

.. | amshons

If you assigned a keyboard shortcut to a brush it is displayed on the bottom line of the Brush Editor window.

To Test a Brush

While you are editing a brush in the Brush Editor you can test it in the Viewer, or in the Brush Test window. To
display the Brush Test window, click the Brush Test button in the bottom right corner of the Brush Editor.
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The Brush Test window displays. This includes a palette editor, to allow you to change the color of the brush, and
controls to clear or change the image displayed in the brush test window:

Brush Editor

Brushes | Profiles

Vizr

.

[ Fillmage

Snapshot

[ Load Image... ‘

Copy To BG

‘HedvGreen v] RB

L

Brushes Source | Filters
+ Builtin
User Source | Color
Profile [Snf! v
Size £ 20 Flatness © 1.00-2
Pickup | Normal Build Up Rotation @ 0° Match Path
Opacity T Mode | Nomal v‘ .
Au_tomatlcally
0.00 . 0.15 . P adjust for
Decay Spacing Maximum D etail v I e -
4
Export... J ‘ Import... J Restore Defaults | [V] Use Shared Settings <No Shortcut> 7 << Brush Test

]

R I 233
G T 131 £
B ) 0

[ReB  ~v[o0-255 ~

To hide the brush test window: Click the Brush Test button again.

To Save a Brush

1. Click the Export... button below the Brushes list. The following dialog box allows you to browse a place to

export the brush file to and name the brush file:
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K save As B
Savein: [ Libraries v 6 7 = [T~
D= = i
&} ‘k Documents — Music
B» Library b2 Library
RecentPlaces : <7 :
-' [~ Pictures m Videos
\7 Library e, Library
Desktop
u»S!J
Libraries
A
Computer
e
w
Network
File name: v l Save
Save as type: [B«ush (*.cpb) v] [ Cancel ]

2. Enter a suitable name for it and click the Save button.

To Load a Brush

1. Click the Import... button below the Brushes list. The following dialog box allows you to select the brush file

to import:
m Open
Look in: E} Documents v 6 7 » [E~
I Name Datemr *
'*} .. My Documents 2210.2
RecentPlaces | My photos 22102
-' .. My Received Files 20.04.2
(E My Shapes 14.01.2
Desktop || MyBrush.cpb - 21.06.2] |
.l‘]
Libraries =
A
Computer
‘h-, e
~ < | " »
Network
File name: MyBrush.cpb v
Fesoftype: [StyleSheet (".cpb) v [ Cancel |

2. Select the brush file and click the Open button. The brush is added to the list of brushes in the Brushes list.
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9.1.5 Definingthe Brush Source

Source | Filters |

Source Clone ® Offset  0.00 : Y Offset 0.00 :

Profile | Soft v

Size £ 20 = Flathess [ 1.00 -2

Pickup | Momal 1BuldUp  Rotation @ 0° [ Match Path

Opacit £ Mode | Normal v

sl [ ] ~Automatically
. = : 1 a : ; - | (| adjust for

Decay 0.00 2 Spacing 015 = [Mamrnum Detail } i

The options on the Source panel in the Brush Editor allow you to define the source of color for the brush, and
associated options.

To Define the Paint Source

Specify the source for the paint by choosing an option from the Source pop-up menu. The options are explained in
the following table:

® Color: The brush paints in the currently selected color.

¢ Clone: The brush takes the color from the image being painted. Useful in conjunction with an offset for
cloning one part of the image to another part.

e Background: The brush takes color from the composite background (Composite mode), or specified
background layer (Single layer mode). Useful for copying from one image onto another image.

* Image File: The brush paints with an image loaded from disk. Useful for painting with copies of a small
image (for example, leaves).

* Image Center: Colors the whole brush with the color at the center of the stamp.

* Eraser: Makes pixels transparent by painting on the alpha channel.

¢ Image: Takes color from the image.

The Image and Background Source options allow you to define an offset in the X Offset and Y Offset fields. This
allows you to pick paint up from one position on the image or background and paint it in another position.

To Define the Brush Profile

Choose an option from the Profile pop-up menu. The profile determines how the paint fades away from the center
of the brush to the edge of the brush, as defined by the Size parameter. You can define new profiles using the
Profiles tab of the Brush Editor.

To Specify the Image Pickup
You can specify how the image is picked up by the brush using the Pickup options:

¢ Normal: The image is picked up before each stamp.
e Once: The brush is loaded once on the first stamp.

Copyright © 2025 Vizrt Page 199



Viz World Classic User Guide - 24.1

¢ After Stamp: The image is picked up after the previous stamp.

To Define the Opacity and Decay

The Opacity and Decay define the density of the paint stamped by the brush, and the rate at which it decays as you
drag. ADecay of O gives a brush that never dries out; larger values dry out faster.

To Define the Mode

The Mode pop-up menu allows you to specify how the paint is combined with the image; it provides the same
options as the Blend Mode compositing option for layers.

To Define the Spacing

The Spacing determines the spacing between brush stamps as a percentage of stamp size. A large Spacing gives
visible gaps between stamps. A small Spacing gives a smooth stroke.

Choose Fixed from the pop-up menu to make the spacing independent of your stroke speed, Constant Density to
increase the spacing as you drag faster, and Maximum Detail to ignore the spacing and paint with full detail.

To Paint with an Image

Any image file, preferably with an alpha channel, can be used as a brush; for example:

1. Choose Image File from the Source context menu.

2. Click the Browse... button and select the image file you want to use.

3. Select Match Path to automatically rotate the image to match the angle of your stroke.

4. Set the Spacing to an appropriate value to determine the distance between stamps. Choose Fixed for a
fixed spacing irrespective of your speed of stroke:
Brush Editor

£3|

Brushes | Profiles
Brushes Source | Filters
Restore - .
-Chalk Source C:\UsershJon Fraczak\DesktopiCutout0. raw.tif
Blur
Oil Effect Profile [Lineay v]
Posterise
Smooth
Marble : T . =
=) | P | :
Black And White . ClBuldUp  Rotation G [ Match Path
=J-User Opacity C Mode [Normal v] )
CutoutO.raw _Automatically
S I T —
2|
[ Export... ] [ Import... ] [ Save Defaults ] Festore Defaults | [] Use Shared Settings <No Shortcut> B Brush Test >>

5. Drag the brush to paint with the image you have loaded:
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6. Use the Jitter filter to add variations to each stamp.

To Load a Cutout for Use as a Brush or Profile
You can use a cutout as a brush; this works in exactly the same way as painting with an image.
Alternatively you can use a cutout as the profile for painting; the cutout defines the outline of the brush.

1. On the Cutouts panel click the Layout tab to display the Layout panel.

2. Select the cutout you want to use in the Overlay list. For more information about creating a cutout see
Working with Cutouts.

3. Click the Use for Brush or Use for Profile button:
Layout | Properties |

B Use for Brush

Use for Profile

Save Image...
Flip Vertical

Flip Horizontal

Convert To Layer

Use for Brush saves the cutout as a TIFF image which you can load in using the Image File option in the Brush
Editor.

Use for Profile saves the alpha channel of the cutout as an image file which you can load in using the Create from
Image button in the Profiles panel of the Brush Editor.
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9.1.6 Defining Brush Filter Effects

The options on the Filters panel allow you to create brushes that selectively color correct, filter, or add an effect to
the image as you paint:

Source Filters

= Color Correctors - Brightness/Contrast - - 4
- Add/Sublract Brightness £ 000
- AutoEqualize  |= Contrast 0 0.00 =
- Black & White
- Brightness/Ca Gamma (5 000
- Chroma Scale E] Saturation 0 0.00 =
- Color Dodge
- Colour Jitter

p rrr—

The filters are divided into the following categories:

¢ Blurs: Soften or blur the image.
* Color Correctors: Allow you to do local color correction to parts of an image.

Distort: Apply marble, jitter, or turbulence effects to the image.

Effects: Provide image effects, including noise and emboss.

Filters: Process the image according to the values of the pixels.

Multiple: effects are applied in the order they are specified in the list. To change the order:
Select an effect, and click the Up or Down arrow buttons to change its position in the list.

To Create a Brush That Applies a Filter

1. On the Source panel, set the Source to Image, the X Offset and Y Offsetto O and the Pickup to Normal.
2. On the Filters panel, add the effects you want to include in the brush, and for each effect set the parameters.

9.1.7 Defining Brush Profiles

The Brush Editor Profiles panel allows you to define a number of preset profiles, and then select these when you
are using or defining a brush:

The profile determines how the paint dies away from the center of the brush to the edge of the brush, as defined by
the brush size parameter.

The horizontal axis defines the radius of the brush (center on the right), and the vertical axis is the opacity of the
brush stamp.

The following table shows some sample profiles together with the corresponding spread of paint they create:
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Description Profile Effect
Linear g

(ﬁ\
Soft ——

Solid e— ’ i
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Description Profile Effect

Neon @

The Create from Image... button allows you to load in an image and use its alpha channel as the profile.

You can also create a profile from a cutout; for more information see Moving and Transforming Cutouts.

To Create a New Profile

1. Click the + button below the Profiles list.
2. Edit the profile curve as required.

The profile you have defined is displayed in the Profile list on the Brushes panel, and the Profile pop-up menu on
the Brush Editor Source panel.

To Adjust the Profile Graph

1. Drag the point from the profile curve.

2. Click on the curve to add a new point to the curve.

3. Hold down CTRL and drag to extend tangent handles from a point on the curve.
4. Hold down CTRL to adjust one tangent handle independently of the other one.

To Rename a Profile

1. Select the profile in the Profiles list.
2. Click the Rename... button.

9.1.8 Managing Painted Materials

Working on a project often involves importing a number of images or movies and then making changes to the
images, or to one or more frames in the movies, before rendering out a composite of the resulting project.

Changes you make to images or movies never affect the original source materials. Instead, a copy of every image is
saved, and every modified movie frame, in a painted materials folder on your hard disk. Actions that cause painted
materials to be saved include: painting on an image or its mask using the tools on the Brushes panel, drawing
shapes using the tools on the Graphics panel, sticking shapes, text, or cutouts from the Overlay list, and applying
image effects from the Image panel.
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You can conform an image or movie layer, or its mask, to incorporate all the changes painted onto that layer and
create a new image or movie that reflects those changes. You can then incorporate the conformed image or movie,
or the mask, into another project without requiring the saved painted materials.

You can also export, as an image sequence, just those frames of a layer that have been painted on. By default
painted materials are stored in a PaintedMaterial folder, but you can change this to any desired location.

To Conform an Image or Movie Layer

Viz World Classic never changes original files on disk as they are painted. You can conform a layer to produce a new
complete movie or sequence incorporating all the painted frames. The layer is then updated to use the conformed

material.

1. Select the layer you want to conform.
2. On the Layer menu, click Conform Layer.... A warning confirms the Conform Layer... action.

3. Click the OK button to continue. The Conform Layer dialog box then allows you to give a name to the movie
and specify the format:

Conform Layer

(X8

PNG Image
(V] Render RGBA (Millions of Colors+] if supported by format

[Premultiplied alpha [matted on black) VJ

Format Options...

Field Render

Render Range

o Whole Movie

Start 00:00:00:00 End| 00:00:00:00 00:00:00:01

I

Dur

Render in Backaround ]

Render Close

J

Output: Image Sequence, one frame per humbered file
Files: I2:\T empi\Untitled0000.png Browse...
Format:  PNG Image(*.png) v
Settings
Frame Size
llrmmg

2

"

4. Check Render RGBA (Millions of Colors+) if supported by format to include the alpha channel in the

conformed layer.
5. Click the Render button to render the layer.

The movie layer is updated to use the new conformed movie, eliminating the need for the painted materials.
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To Conform a Mask

You can also conform the paint mask of an image or movie layer to create a movie or sequence on disk containing

the paint masks for the layer. The mask is output at the size of the original material for the layer, without
transformations or filters applied to the layer.

1. Select the layer whose paint mask you want to conform.
2. On the Layer menu, click Conform Mask....

A warning confirms the Conform Mask... action.

1. Click the OK button to continue.
2. Proceed as described for conforming a layer.

To Export the Painted Frames from a Layer or Mask

1. On the Layer menu, click Export Painted Frames... or Export Painted Masks....

The Export Painted Frames dialog box then allows you to specify the filename for the image sequence, and
the file format:

Export Painted Frames @

Output: Image Sequence, one frame per humbered file

Files:  C:\Temp\Untiled0000 png

Format:  PNG Image(*.png) v

Settings

Frame Size
Timing
PNG Image
Format Options... Render RGBA [Millions of Colors+) if supported by format

Straight alpha [unmatted) v

Premultiplied alpha [matted on black]

Field Render Straight alpha [unmatted) |

Render Range

@ Whole Project

() Slider Range

() Part of the Project:

Start | 00:00:00:00 End| 00:00:01:24 Dur | 00:00:02:00

Render in Backaround Render ] [ Close ] _?I

2. In the Render Range section specify the range of the project that you want to render.
3. Click the Render button to continue.

Animage is created for each of the painted frames, numbered with the frame number.
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To Specify the Location of the Painted Material

1. On the View menu, click Options....
2. In the Preferences dialog box select Material in the Paint section.

This allows you to change the location of the PaintedMaterial folder, and allows you to display the Painted
Material Manager by clicking the Manage painted Material... button:

Options =]
Shared - Temporary Storage for Unsaved Images
DEM Painting on images or movies creates changed temporary frames which are stored in a
Database central location. The original image or movie is never itself changed on disk.
Locations . L :
- ‘ou must specify a location in which temporary changed frames can be stored.
Attribution Wit t fy a locat hich t h d f be stored
Map Legend
Map Projection C:\Pro : : .
:\Program Files (x86)\Curious Software\Curious World Ma| | Browse...

Virtual E arth
Digital Glob

Ighalialobe Storage of Saved Images

Locations
3. File Formats Final saved images can be stored in a folder with the saved project file or centrally in

. the folder chosen above. Saving with the project file is strongly recommended as it

Gif

provides maximum portability of your projects. You can easily move the project file and

Numbering its associated image folder to another location or computer.

= Pa'i.

m

Undo New projects should save their painted images:
& Brush Tools @ in the same folder as the project file [Recommended)
- Storage . . .
RAM Limits in the central Painted Material folder, path as set above.
Flipbook ; :
it Board - Manage Painted Material... ]

To Display the Painted Materials

The Painted Material Manager displays all the material saved for the different projects you have worked on, and
allows you to delete material you no longer need. It also allows you to rescue material, in the event that the original
project has been accidentally deleted. On the View menu, click Paint Material Management.... The Projects list
displays a list of the projects with saved painted material.

To Display the Materials for a Project

Select the project name in the Projects list. The Painted Material Manager shows the full path name of the project
file, together with a list of the painted materials used by the project. Material that is no longer referenced by a layer
in the project is drawn in red to indicate that it is in the trash.

To Delete Specific Material

Select the material in the Painted material list and click the Delete Selected button.

To Rescue Material from a Lost Project

If a project file is lost, the material it referenced is not available until it has been copied into a new project. Select
the material in the Painted material list and click the Rescue Selected button. The original source material and
any painted frames are copied into the current project.
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To Remove Material from a Project That Is No Longer Referenced by a Layer
Click the Empty Trash button.

To Delete All the Material in a Project

Click the Delete All button. You are not allowed to delete material in use by the current project.

0 Warning: Do not delete materials in any project you still need, or you are not able to load the project in its
last saved version.
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9.2 Adding Graphics to Images

Brushes | Graphics i Shapes | Test | Cutouts | Fx

[ Image [ Mask ] Macros

Quick Shapes Flood Fil G e @

@ Circle Dpack) B E Flood Fill Flaiance N — T e

(O Eose  gomess l © [®) Fitoco I Y [

a Rectangle | 000 Y || Antisliss [V (RGB  ~0-100: v
Oupshodon £ (1) LN Mogend [t~

RB <
~ ~ ..
.
||

The Graphics panel allows you to draw simple geometric shapes directly onto an image, or a frame of a movie.
These tools provide a convenient way of creating a solid area of color in an image or a simple mask, where you do
not need the flexibility and editability provided by the options on the Shapes panel.

Like the tools on the Brushes panel, the tools on the Graphics panel affect the image immediately, without needing
to be stuck to the image. If you want to create editable shape overlays use the options on the Shapes panel instead.

9.2.1 To Draw a Quick Shape

1. Use the paint controls to specify whether the shape is drawn into the image and/or mask, and whether it is
protected by the mask.

2. Use the Color Chooser to specify the shape color.

3. Select the Circle, Ellipse, or Rectangle tool in the Quick Shapes section:

Quick Shapes

— 3] ~ Opacity

Q Circle

= 1.00 =
O Elipse | :
Lts Softhess

D+ Rectangle |- 0.00 =

—

Drop Shadow || B

4. Drag to draw the shape. You can hold down CTRL to constrain the shape to a circle or square respectively.
5. Release the mouse button to draw the shape.

9.2.2 To Define the Drop Shadow

1. Click the ellipsis (...) button to the right of the Drop Shadow checkbox. The following dialog box allows you
to define the drop shadow:
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Drop Shadow 3]
Shadow for | ?
Quick Shapes

On (V!

¥ 300 =

y -300 =
Opacity &

Softhess 2 >

coior [ 2|

Note: This only affects shapes you subsequently draw.

9.2.3 To Flood Fill Areas of the Image or Mask

The Flood Fill tools allow you to fill a contiguous area of pixels with the current color:

Flood Fill

? Flood Fill Tolerance
; Fill to color !, {2t

— Antialias
# | Magic Wand

1. Use the Color Chooser to specify the color to fill with.
The tools are described as follows:
¢ Flood Fill: Flood fills areas of uniform color in the image.

¢ Fillto Color: Flood fills the image up to the color specified by the Fill to Color box.
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¢ Magic Wand: Flood fills the paint mask based on areas of uniform color in the image.
2. After selecting the appropriate tool: click on a color to start filling from that color.
3. Move the Tolerance slider to the right to flood a larger range of colors around the color you first clicked on.
4. Select Antialias to blur the edges of the filled area.

With the Magic Wand tool you can click additional areas to add to the mask, or click with SHIFT to remove areas
from the mask. The Magic Wand tool is particularly useful for making cutouts; see Creating Cutouts.

Transforming Images

| Brushes | Graphicsl Shapesl Text l Cutouts I Fx ] Image IMask l Maclosl

Transform G

Flip Vertical
Flip Horizontal

R oS

c 1w O

R
[RGB v [0-100: v |

><_Ill L |
E]
s J2 8 S

The options on the Image panel on the Paint panel allow you to transform an image or movie. The Roll operation is
designed to assist in creating textures that tile seamlessly.

Unral Fled v Green

To Flip the Image about a Vertical or Horizontal Axis
Click the Flip Vertical or Flip Horizontal button.

To Create a Seamlessly Tiling Image

The following example shows how to create a seamlessly tiling texture from an image.

1. Load the image into a new layer:
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2. Click the Roll button. This exchang ge:

4. Click the Roll button again to create the image:
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e can then be used to tile seamlessly, without any visible joins:
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9.3 Paintand Image Processing Tools

Properties ] Contems: Paint | Lighting [ Layer Fx [ Keybars

Brushes | Graphics | Shapes | Test | Cutouts [ Fx | Image | Mask | Macros
Profile

Brushes Settings 6
Builtin - Linear )] Size ! 20

Color Soit | ™ 2
bl e (. ) (@ Opaciy © 100%

- N— =
:e;gge - i:::gad (4 Clone Offset Background Offset

OnePicel anm | — Frame . L

Repair nePoce (5 X | 0.00 0 Ba RedvGrieen ~|FB
Chalk ‘.’Ed““"- J ’}‘\@‘Q % i S q
Bhr ' e 80
A s al |||} ‘W Pixel Lock

A i ®

™ —

] —
RGB ~+|0-100 v

Viz World Classic provides a wide range of paint and image processing tools divided into eight categories.

The Paint panel provides a selection of options for each category of paint and image processing tools. You can
select a category by clicking the icon to the left of the Viewer, or by clicking the corresponding tab on the Paint
panel. The following table describes the functions available within each category of paint and image processing

tools:

U Brushes: Provides a selection of brushes to allow you to paint directly onto an image or movie, or its

mask.

o l%l Graphics: Paints geometric shapes onto an image or movie, or its mask.

o Shapes: Adds drawings to the project by creating editable vector shapes.

o Text: Adds text to an image or movie, or to the mask.

. Cutouts: Cuts out part of an image to create a floating image overlay called a cutout.

o Fx: Provides a range of paint effects for color correction, filtering, keying, or procedural effects.

o Image: Provides image transformations.

o Mask: Provides a range of options for extracting a mask from an image based on the parameters of the

image.

o Macros: Records a series of actions, and then replays them on several frames in a movie or in different

projects.
This section contains information on the following topics:

* Paint Controls
® Overlays
¢ Undo and Restore Options for Painting

9.3.1 Paint Controls

The paint controls, displayed to the right of each of the Paint panels, allow you to specify how operations using the

brushes, shapes, and text affect the currentimage and its mask:
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|| Protect with Mask Fill Image !l
= Clear |

|| Paint Image

(] Paint Mask Fill Mask 4'
—_— Clear Mask

|| Display Image

(| Display Mask ﬂ

|| Onion Skinning

BG [ Invert FG

The mask can be used to protect the image from changes when painting on the image using the brushes or graphics
tools, and sticking shapes or text on the image.

At any pixel where the mask is at full density, the image is not affected by any operation. At pixels where the mask is
completely transparent, operations are applied in full. Intermediate values result in a blend between the original
image color and the changes.

To Protect the Image with the Mask

Select Protect with mask.

To Specify What is Affected by Painting Operations

Painting operations can be applied either to the image or to the mask or to both simultaneously: Select Paint Image
and/or Paint Mask to affect the image and/or mask respectively.

To Specify Whether the Image or Mask Are Displayed in the Viewer

1. Select Display Image and/or Display Mask to display the image and/or mask respectively.
2. Use the slider below the Display Mask checkbox to change the opacity of the mask displayed on the screen.

Note: This only affects the screen display, not the actual density of the stored mask.

To Use Onion Skinning

The Onion Skinning control allows you to reduce the displayed opacity of the foreground image in the Viewer to
allow you to see the background while working on the foreground. A typical use is in wire removal when merging
portions of a background image to replace unwanted elements in the foreground.

¢ In Composite display mode, the background is the composite of the other layers.
¢ In the Single Layer display mode, you can specify which layer to use as the background: Click the eye-
dropper icon in the Layers list to indicate which layer you want to use as a background.
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V| Onion Skinning

BG | | Invert FG

Selecting Invert allows you to invert the background, which is useful for highlighting the differences between two
very similar frames.

Note: This only affects the display, not the stored image.

To Fill or Clear the Image or Mask or Invert the Mask

The Fill Image and Fill Mask buttons allow you to fill the image or mask with a solid color. You can set the fill color
by selecting a color and then clicking in the square to the right of the Fill Image or Fill Mask button.

The Clear Image and Clear Mask buttons clear the image or mask to transparent, and the Invert Mask button
inverts the mask level at each point.

9.3.2 Overlays

The Shapes, Text, and Cutouts panels on the Paint panel allow you to create overlays as an intermediate step in
constructing artwork. They are available to any of the image and movie layers in your project, and at any stage you
can paint them onto an image or its mask; this is called sticking the overlays.

Overlays @) all Just: Cutouts

B Cutout2
D Test

<& [ Polygon 1

(Fenene... ] (4] () (Sick ]

For more information about creating shape overlays see Working with Shapes.

To Show or Hide an Overlay

Click the eye icon to the left of the shape name in the Overlay list. The icon changes to show whether the shape is
hidden:

o 3 Shown
e &= Hidden

To Rename an Overlay

1. Click the Rename... button below the Overlay list.
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2. Enter a name for the overlay and click the OK button:
~

Rename Overlay &3

Cutout

0K ] ‘ Cancel

To Change the Order of Shapes in the Overlay List
Either:

1. Select the overlay you want to move.
2. Click the up or down button below the Overlay list.

Or:

e Click the overlay you want to move with the right mouse button and select one of the Ordering options from
the appearing context menu.

Or:

* Dragthe shape to the new position in the Overlay list.

To Delete an Overlay
Either:
¢ Select the overlay you want to delete and press the BACKSPACE button.
Or:

¢ Click the overlay you want to delete with the right mouse button and click Remove from the appearing
context menu.

To Copy an Overlay

You can cut, copy, and paste Overlays between layers or between projects. You can also export one or more shapes,
and then import them into another layer or another project, using the Export... and Import... options from the
Overlay list’s context menu.

9.3.3 Undo and Restore Options for Painting

Viz World Classic allows you to undo brush strokes while painting, and you can also restore the image or its mask to
the last saved version or to the original frame.
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On the Layer menu, click Restore Image or Restore Mask, then click To Last Saved or To Original Frame on the

submenu.

To Select the Paint Undo Options

By default, Viz World Classic allows you to undo each brush stroke while painting, to a limited undo depth, to
minimize the amount of work you need to redo in the case of a mistake. However this level of undo control is
memory intensive, and may cause noticeable delays when painting complex images. Viz World Classic gives you the
option of reducing the degree of undo control for greater performance.

Options

+- Display

- Keyboard

- Template
~Map Data

i Locations
+)- File Formats
i Numbering
- Paint

- Material
- Undo
“ Brush Tools
Storage

o

&

Undo mode | Every Stioke

Paint undo Similar Strokes
for best per Explicit

[Sle possible
f memory to

be used before saving older images to disk.

Memory (Mb) 10.00 ==

¢ On the View menu, click Options....
¢ In the Preferences dialog box select Undo in the Paint section.

The Undo drop-down menu lets you specify the degree of undo control provided. The options are explained as

follows:

¢ Every Stroke: Undo affects the previous painted stroke.

¢ Similar Strokes: Undo affects all strokes made with the same brush and color settings.

¢ Explicit: A Backup for Undo button appears in the paint controls, and Viz World Classic stores a snapshot of

the painting each time you click it. Selecting Undo restores the previous snapshot.

The Memory setting allows you to allocate more memory to undo, which allows you to increase performance if you
have sufficient memory available on your computer.
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10 AddingImage Effects

Viz World Classic provides a wide range of image effects, including color correctors, filters, and procedural effects.
You can apply effects to any layer using the options on the Layer Fx panel, and these effects can be animated.
Alternatively, the Fx options on the Paint panel allow you to apply fixed paint effects to an image or movie layer.

This section contains information on the following topics:
¢ Adding Image Effects to a Layer

* Adding Paint Effects
* Image Effects

10.1 AddingImage Effects to a Layer

‘ Properties | Contents I Paint I Lighting} Layer Fx lKeybars‘

- Effects - Emboss | I 90° =
. 5dd Noise Light Direction @ 90.00 =
Drop Shadow Light Elevation O 30.00 =
- Emboss
. Glint . [E Bump Height (5 50% =
ETI{;E; @ Color |
- 0l (8 bi
Pixellate Mix With Image C 0% =
- Rays
- Simple Bump Map
Solarize -

10.1.1 To Apply One or More Image Effects to a Layer

=

. Select the layer.
2. Click the Layer Fx tab to display the Layer Fx panel for the layer. Every parameter of an effect can be
animated. For more information see Using the Keybars Panel.

10.1.2 ToAdd an Effect to a Layer

1. Click the arrow symbol to the left of a heading in the effects list to expand the list, and show the effects
under that heading.

2. Select the filter and click the > button to add it to the right-hand list of effects to be applied to the layer. Each
effect displays a set of controls to allow you to adjust its parameters.

10.1.3 To Determine the Order in which the Effects Are Applied

The order of effects in the list determines the order in which they are applied. Select an effect in the right-hand list
and click the up or down arrow buttons to move it up or down in the list.
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10.2 Adding Paint Effects

Brushes ] Graphics ] Shapes] Text ] Cutouts Fx | Image [ Mask ] Macros

5 Effects “| [ dight Direction (T) 90" 9000 2 G A 'wiEHE
Add Noise ) i i = G 10052 =
Drop Shadow Light Elevation f 3000 ° B 1005t
Emboss : Y —

" g Bump Height C 50% < - 3 -
Gt RGE  ~|0-100: v
Halftone Color | _ e —
0il (8 biY . RedvGreen v R B |57
Pheellate Mix With Image © 0% < ’ [’] |
Rays 1
Simple Bump Map LE @

Cancel Save.. | [Load..

10.2.1 To Preview a Paint Effect

1. Click the Fx tab on the Paint panel to display the paint effects.
2. Select the effect in the list. Each paint effect displays a set of controls to allow you to adjust its parameters,
and these are displayed to the right of the effects list.

The effect is previewed in the Viewer as you change the parameters.

10.2.2 To Apply the Paint Effect Permanently to the Image Layer

Click the Apply button. To apply one or more paint effects to every frame of a movie you can record a macro.
See Automating with Macros.

10.2.3 To Restore the Image to its Previous State
Click the Cancel button.

10.2.4 To Reset the Paint Effect Parameters to their Default Settings

Click the Reset button.

10.3 Image Effects

The image effects are divided into the following sections:

10.3.1 Backgrounds

Provides options for creating textured and patterned background images such as gradients or clouds.

10.3.2 Blurs

Allows you to blur or soften an image.
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10.3.3 Color Correctors

Provides controls for adjusting the color balance of the image, adding/subtracting colors, or correcting the image in
any of the alternative color models.

10.3.4 Distort

Provides options for transforming or distorting an image.

10.3.5 Effects

Provides artistic effects including emboss, crystallize, motion blur, ripple, solarize, and stained glass.

10.3.6 Filters

Provides image effects such as edge detection, erode, and threshold.

10.3.7 Grain

Provides filters for removing or simulating film grain.

10.3.8 Sharpen

Provides options for sharpening images.

10.3.9 Transition

Provides wipes which can be animated to give a transition between two images or movies.

10.3.10 Video

Provides filters for broadcast video use.

10.3.11 Adobe After Effects Plug-ins

If you have Adobe After Effects-compatible plug-ins installed on your system, some of these can be used and are
listed in the effects list.

For details on which plug-ins can be used with Viz World Classic please contact your local Vizrt representative.
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11 Extracting Masks

This chapter describes the options in Viz World Classic for extracting a mask automatically from an image based on
its colors. With certain images, where the foreground is very distinct from the background, this can provide an
extremely quick way of creating a finished mask. With more difficult material it can often provide a useful starting
point for painting a mask manually.

This section contains information on the following topics:

¢ |ntroduction
e Mask Extract Tools

11.1 Introduction

[ Brushes | Graphics | Shapes | Text | Cutouts [ Fx [ Image | Mask | Macros] }
- [ e [0S
xlac Component = R 100 %
Cheoma Extract LUT Graph - ¢ ) 1001

Y —
[RedvGreen =) A8 [~ TR
D |
e
(¢ [ ]
| | |

The mask extract tools are provided on the Mask panel on the Paint panel. Each tool includes its own set of controls
to allow you to adjust its parameters, and these are displayed to the right of the mask extract tools list.

11.1.1 To Extract a Mask

The following image contains yellow poppies against a predominately blue background, and so is an ideal
candidate for extracting a mask:
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1. Select Component Extract, and choose Yellow from the Component drop-down menu to mask yellow
areas of the image.

2. Adjust the LUT graph to achieve an optimum mask:

Component_[Vellow = =
uma Extract @

Chroma Extract

Foreground Extract LUT Graph

Background Extract

Color Extract

Hue Extract

The masked areas are displayed in the mask color:

3. Click the Apply button to apply the mask permanently.

11.2 Mask Extract Tools

11.2.1 Component Extract

Extracts a mask based on the level of a specified component: Red, Green, Blue, Cyan, Magenta, Yellow, Alpha, or
Max:
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Component  |Red v i

LUT Graph

11.2.2 Luma Extract

Extracts a mask based on the luminance value of each pixel. The graph allows you to define the mapping between
the luminance value and the output mask value.

11.2.3 Chroma Extract

Extracts a mask based on the minimum and maximum chroma levels.

11.2.4 Foreground Extract

Extracts a mask based on the predominance of the chosen component, red, green, or blue, in the foreground. The
graph allows you to define the mapping between the raw values extracted and the output mask value.

11.2.5 Background Extract

Extracts a mask based on the predominance of the chosen component, red, green, or blue, in the background. The
graph allows you to define the mapping between the raw values extracted and the output mask value.

11.2.6 Color Extract

Extracts a mask based on a specified color level.

11.2.7 Hue Extract

Extracts a mask based on the proximity of the color at each pixel to a specified source color:
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Component Red v at
4
LUT Graph
£]
r_' b
See Also
* Painting
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12 Automating with Macros

Macros provide a convenient way of recording actions, such as painting or image processing, and then applying
them to several frames of a movie. They also allow you to repeat the same sequence of actions in a series of
different projects.

12.1 Using Macros

| Brushes | Graphics l Shapes l Text | Cutouts | Fx | Image | Mask ‘ Macros

Start Recording
RECORDING Apply Tracks [E)
Stop Recording

lay Macro

Play On Range...

Save Macro...

Load Macro...

Macros allow you to record any of the painting or image manipulation actions, including painting with brushes, and
then replay them on another image or each frame of a movie.

Features of the movie that should not be affected can first be masked using rotosplines.

12.2 To Record a Macro

The following example illustrates recording a macro, applying an image processing operation to one frame of the
movie, and then replaying it on all frames.
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Protect with Mask |Fi|l Image | -l

Paint Image
| Paint Mask |Fi|l Mask | |

Clear Mask
S Clear Mask
| Display Mask .l Invert Mask

- Q

v

| Onion Skinning
' (N

BG | | Invert FG

1. Select Protect with mask in the paint controls, to use the mask to protect the image.
2. On the Macros panel click the Start Recording button. The panel displays RECORDING.
3. 0On the Image panel select the image processing function, such as Black and White, and click
the Apply button. The current frame will be converted to black and white outside the masked area:

4. On the Macros panel click the Stop Recording button.

12.3 To Replay a Macro

1. Click the Play On Range... button. The following dialog box allows you to specify which frames are affected:
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Frame Range )

) Whole project
() Slider range
@ Part of project
Start 0

End 59 Duration 60

This action cannat be undone

0K ] [ Cancel

2. Select Part of Project, enter the range omitting the first frame, and click the OK button.

You can now preview the movie to confirm that the operation has succeeded. Any number of different paint and
image processing operations can be recorded into a single macro.

12.4 To Save a Macro

After creating a macro you can save it, and then reload it for use in another project.

1. Click the Save Macro... button.
2. Enter an appropriate name and click the Save button.

12.5 To Load a Macro

1. Click the Load Macro... button.
2. Select the macro you want to load and click the Open button.
3. Click the Play Macro or Play on Range... button to replay the macro.
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13 Working with Shapes

This section explains how to add drawings to your map by creating vector shapes, either using separate shape
layers or by adding shape overlays to map layers. It explains how you can create and edit shapes, and change their

appearance to achieve exactly the effect you want.

This section contains information on the following topics:

Introduction to Shapes
Creating Shapes on a Shape Layer
Creating Shape Overlays

Cutting and Pasting and Exporting and Importing Shapes

Editing Shapes

Editing Points

Defining the Appearance of Shapes
Animating Shapes

Specifying How Shapes are Displayed
Setting the Shape Layer Properties
Adding Shape Overlays to a Map Layer
Animating Shape Layers

Shape Tools
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13.1 Introduction to Shapes

Each shape consists of a number of points joined by straight lines or smooth curves. A range of shape tools is
provided to enable you to draw shapes point by point, by drawing a freehand curve, or by drawing a precise
rectangle or ellipse.

Each shape has a start point and an end point, displayed as circles; the intermediate points are displayed as
squares. In a closed shape, the start and end points are joined:

0
2]
2~
] 3
2
0
33
1
2

You can control the appearance of shapes by changing the border and fill colors, border thickness, opacity, and
blur. Shapes can be edited or transformed after you have created them, and a series of tools are provided to allow
you to move, edit, divide, or join shapes. You can also use a shape to cut a hole in the currently selected layer.

You can animate the entire drawing on the shape layer, the individual shapes in the drawing, and the individual
points of each shape. So for example, a shape could be used to show the path of a hurricane, with the shape
changing in size as it moves across the land.

13.1.1 Shape Layers

You can create shapes in one or more shape layers. Each shape layer can be animated as a single unit, pinned to a
map layer, wrapped to the map, and scaled to the map. Typically you would create a new shape layer for each
drawing consisting of several shapes. This makes it easy to transform the complete drawing as a unit, such as
animating its position or fading it in by changing the opacity. Shapes can also be used to create holes in other

shapes.
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13.1.2 Shape Overlays in Map Layers

You can also add shape overlays to a map layer. Shape overlays are always wrapped to the map, and can be
displayed in the same style as other map details. Shape overlays in map layers can be constructed by automatically

tracing an existing map detail.
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13.2 Creating Shapes on a Shape Layer

Prooenies} Contents :Paint [ Lighting [ Layer Fx[Keybars

This section contains information on the following products:

® To Create Shapes on a Shape Layer

To Show or Hide a Shape on a Shape Layer
To Edit a Shape on a Shape Layer

® To Rename a Shape on a Shape Layer

13.2.1 To Create Shapes on a Shape Layer

& P
%::Bm. Shape | Paints | Propedies | Arimation | Display
New B-Spine @ Move Shape [zh;m
New Freehand @ Open Shape (Shapen ]
New Cicle (] oiide Shape
New Elipse @ Join Shapes
@ New Rectangle Polygon1 Default Area Shape @D )
7 [E] @ @ [Fnt Shape [Remove Keys

Shape Properties
©) Filed Outine
Open
9 Closed

| Use To Cut Hole

1. On the Layer menu, point to Add Layer, and then click Shape. A new empty shape layer will be created at

the top of the Layers list:

2. Click the Contents tab to display the shape tools. The New Polygon tool is selected to allow you to create a

shape.

3. As you add shapes to the shape layer they will be shown in the Shapes list on the Contents panel for the

layer.

13.2.2 To Show or Hide a Shape on a Shape Layer

m A Click the eye icon to the left of the shape name in the Shapes list.

13.2.3 To Edit a Shape on a Shape Layer
1. Select the shape you want to edit in the Shapes list.

2. Use the options on the Shape, Points, Properties, Animation, and Display panels to edit the characteristics

of the shape as required.

13.2.4 To Rename a Shape on a Shape Layer

1. Select the shape layer in the Layers list.
2. Click the Rename... button below the Shapes list.
3. Enter a name for the shape and click the OK button:
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13.3 Creating Shape Overlays

Propemes: Contents | Paint [ugnnng [ Layer Fx [ Keybars

'Explorer I Search [ Streets] Imported Data Overlays Detalils Style Sheet [M Map Features |
(e P ] Stde | Propedies | Shape | Symbol
[ Sea
M] New Bezier Add Satelite Image Unselected Land
(7% c p Selected Region
&J New B-Spline Bird's Eye... ] Lakes

@ New Freehand Rivers

Q] New cicle

@Newﬂ'we O < . Defasi_aSh
= Defaul...a Shape

(&) NowRectange Scale labels wihmap (4] (W] (Dveride Sule (+)...]|

This section contains information on the following products:

® To Create Shape Overlays

® To Rename a Shape

¢ To Change the Order of Shapes
¢ To Delete a Shape

® To Copy a Shape

® To Edit a Shape Overlay

13.3.1 To Create Shape Overlays

1. Select a map layer in the Layers list.

2. Click the Overlays tab on the Contents panel to display the shape tools. As you add shape overlay
shown in the Details list on the Contents panel.

13.3.2 To Rename a Shape

1. Select a layer (not a shape layer) in the Layers list.
2. Select a shape from the Details list.

3. Click the Properties tab and edit the Label field.

13.3.3 To Change the Order of Shapes
Either:

1. Select the shape you want to move from the Details list.
2. Click the UP or DOWN arrow button below the Shapes list or Details list.

Or:

¢ Right-click the shape you want to move and click one of the Ordering options on the pop-up menu:
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Cut
Copy
Paste
Remove

Clear

Fit Map
Center Map
Export...
Import...
Ordering » Move Up
R

Move Down
New Feature... v W

Add Shape Detail » R

Move Bottom

Or:

* Drag the shape to the new position in the Details list.

13.3.4 To Delete a Shape

Select the shape you want to delete and press the BACKSPACE key, or Right-click the shape you want to delete and
click Remove from the appearing context menu.

13.3.5 To Copy a Shape

You can cut, copy, and paste shapes between layers or between projects using the Cut, Copy, and Paste options on
the Edit menu or the Shapes list or Details list context menu. You can also export one or more shapes, and then
import them into another layer or another project, using the Export... and Import... options on the Shapes list or
Details list context menu.

13.3.6 To Edit a Shape Overlay

Select the shape you want to edit in the Details list and then use the options on the Shape panel to edit the
characteristics of the shape as required.
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13.4 Cutting and Pasting and Exporting and Importing Shapes

Several options are available to help you reuse shapes within a project, or between projects. You can cut, copy and
paste shapes within a shape layer, between shape layers, or between shape layers and shape overlays, to make
multiple copies of a shape or use one shape as the starting point for another shape.

You can also export shapes to a file and then import them into a different project, to reuse artwork you have created
on a previous occasion.

13.4.1 To Cutor Copy a Shape
Either:

¢ Click the shape in the Shapes list or Details list with the right mouse button and select Cut or Copy from the
appearing context menu.

Or:

1. Select the shape in the Shapes list or Details list.
2. On the Edit menu, click Cut or Copy.
® Cut deletes the original and puts it onto the clipboard.
® Copy makes a copy of the original on the clipboard leaving the original unaffected.

13.4.2 To Paste a Shape

1. Select the shape layer or image/movie layer on which you want to paste the copy.
2. 0n the Edit menu, click Paste.
¢ If you pasted onto a shape layer the shape is added at the top of the Shapes list for the layer.
* |f you pasted onto an image or movie layer the shape is added to the top of the Shapes list or Details

list for the layer.

13.4.3 To Export a Shape

1. Right-click to select the shape in the Shapes list or Details list and click Export... from the appearing context
menu. The following dialog box allows you to give a name to the shape file:
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K save As =)
Savein: |, Projects - 02 = E
D= Name : Date modified Type
el No items match your search.

Recent Places

L
Desktop

w;!J
Libraries
P |
==

Computer

"‘-‘l.,
u < | mn »
Network

File name: Weather Pattems v Save

Save as type: [Curious Maps Export (*.cmx) v] [ Cancel ]

2. Enter an appropriate name and click the Save button to save the shape.

13.4.4 Tolmporta Shape

1. Right-click in the Shapes list or Details list and click Import... from the appearing context menu. The
following dialog box allows you to select the shape you want to import:

-
(& Open =
Look in: , Projects v @ ¥ 2 v
I Name : Date modified Type
el A  Weather Patterns.cmx 29.05.2011 09:12 CMX File

Recent Places

Desktop

w;!J
Libraries
P |
u:eh\

Computer

@ < | m »

Network

File name: Weather Pattems.cmx v Open

Files of type: [Source Files (*.cmx;” kml;* kmz) v] [ Cancel ]

2. Select the shape file and click the Open button to import it.
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13.5 Editing Shapes

The options on the Shape panel allow you to edit the entire shape:

Shape | Points | Propeties | Animation | Display|

Move Shape Shape Properties

() Open

Join Shapes

[JUse To Cut Hole

[Fix Shape ] [Remove Keys ]

Open Shape © Filled ) Outiine
Divide Shape @ Closed

It provides the following options:

¢ Move Shape: Allows you to move, stretch, or rotate a shape.
* Open Shape: Opens a shape at a selected segment or point.
¢ Divide Shape: Divides a shape into two shapes.

¢ Join Shapes: Joins two shapes.

¢ Smooth: Converts all the points on a shape from corner points to curve points.
¢ Sharpen: Converts all the points on a shape from curve points to corner points.

¢ Filled/Outline: Specifies whether the shape is filled.

* Open/Closed: Specifies whether the segment between the endpoints should be drawn.
® Use To Cut Hole: Makes the shape cut a hole in shapes below it in the Shapes list.

¢ Fix Shape: Adds a keyframe (for example, to an animated path).

¢ Remove Keys: Removes a keyframe. Use Next Shape and Prev Shape keys to jump between the keyframes.

These options are described in greater detail in the following procedures:

® To Move a Shape

® To Resize a Shape

® To Rotate a Shape

® To Move the Pin Position

¢ To Open a Shape

® To Divide a Shape

® To Join Two Shapes into One

13.5.1 To Move a Shape

2

1. Select a shape from the Layers list.
2. Select the Contents tab, and then the Shape tab.

3. Select the Move Shape tool. The shape is shown with a dotted bounding rectangle.
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Either drag the shape by a point within the rectangle to move it to a new position or right-click at the destination
and click Move here from the appearing context menu:

Move here

Apply Track Data to Shape...

Align »
Space Evenly »
Clear Selection

13.5.2 To Resize a Shape

e

1. Select a shape from the Layers list.

2. Select the Contents tab, and then the Shape tab.

3. Select the Move Shape tool.

4. Move the mouse pointer to one of the eight handles on the corners or midpoints of the bounding rectangle.
5. Drag to resize the shape:

6. Hold down CTRL to constrain the shape to its original aspect ratio.

13.5.3 To Rotate a Shape

e

1. Select a shape from the Layers list.
2. Select the Contents tab, and then the Shape tab.
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3. Select the Move Shape tool.

4. Point to the rotation handle, which is a yellow circle to the right of the pin position. The cursor changes to a
rotation symbol.
5. Drag the handle to rotate the shape about its pin position.

13.5.4 To Move the Pin Position

e

1. Select a shape from the Layers list.

2. Select the Contents tab, and then the Shape tab.

3. Select the Move Shape tool.

4. Point to the pin position, which is initially at the center of the shape. The cursor changes to a pin symbol.
5. Drag the pin position to move it.

13.5.5 To Open a Shape

1. Select a shape from the Layers list.
2. Select the Contents tab and then the Shape tab.
3. Select the Open Shape tool.

Either click the border of the shape to open the shape with the start and end points either side of the corresponding
segment:
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Or:

1. Click a point to open the shape using that point as the start point.
2. Click the point a second time to use that point as the end point.

13.5.6 To Divide a Shape

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Shape tab.

3. Select the Divide Shape tool.

4. Drag between two non-adjacent points on the border of the shape.

The shape is split into two shapes along the line joining the points.

13.5.7 To Join Two Shapesinto One

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Shape tab.

3. Select the Join Shapes tool. The start and end points of each shape are displayed.

4, Click the start or end point on the first shape. A line extends to the cursor.

5. Click the start or end point on the second shape. The selected endpoints are joined to combine the two
shapes into a single shape.
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13.6 Editing Points

Shape | Points [ Properties ] Animation l Displaﬂ

Move Points Sharpen Points E éghlft
Transform Points Smooth Points

Add Paints Align Between
2| Delete Paints Shape Edge

[Fix Shape ] [Flemove Keys ]

The options on the Points panel allow you to adjust individual points on a shape, and provides the following
options:

* Move Points: Allows you to move points, or adjust their tangent handles.

¢ Transform Points: Lets you rotate one or more selected points as a unit.

¢ Add Points: Allows you to add points to a shape outline.

¢ Delete Points: Click a point to delete it from the shape outline.

¢ Sharpen Points: Click a point to convert a curve point to an angle point.

¢ Smooth Points: Click a point to convert an angle point to a smooth curve point.

¢ Align Between Points: Click two points to align intermediate points into a straight line.

¢ Shape Edge: Allows you to soften the edge of a shape.

¢ Adjust Pulls: Allows you to adjust each point by pulling each point’s handle.

¢ Fix Shape: Adds a keyframe (for example, to an animated path).

¢ Remove Keys: Removes a keyframe. Use Next Shape and Prev Shape keys to jump between the keyframes.

When any of the tools on the Points panel are selected you can also right-click and select an option from the
appearing context menu:
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Remove point
Remove key

Add key

Activate

Deactivate

Smooth in
Smooth both
Smooth out

Smooth all

Set AutoSmooth

Clear AutoSmooth

Sharpen in
Sharpen both
Sharpen out
Sharpen all

Apply Track Data to Point ...

13.6.1 To Activate or Deactivate a Point

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Points tab.

3. Select the Move Points tool.

4. Right-click and from the appearing context menu click Deactivate or Activate on the pop-up menu. A
deactivated point is stored with the shape, but does not affect the shape.

13.6.2 To Move One or More Points on the Shape Outline

1. Select a shape from the Layers list.
2. Select the Contents tab and then the Points tab.
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3. Select the Move Points tool.
4. Click the point you want to move. The point turns yellow to show it is selected.
5. Drag the point to the new position:

To move several points at once, first select them by holding down SHIFT and clicking them, or drag to enclose
them.

You can also move points with the Add Points tool selected by holding down ALT.

13.6.3 To Adjust the Curvature at a Point on a Bezier Curve

Every point on a Bezier curve has a pair of tangent handles. The angle of the tangent handles determines the angle
of the curve through the point, and the length of the tangent handles determines the curvature.

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Points tab.

3. Select the Move Points tool.

4. Hold down CTRL and drag a point up/down/left/right to adjust the smoothness at that point:
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5. Drag one of the tangent handles to adjust the curvature at the point.

6. Hold down CTRL while dragging a tangent handle to make it independent of the other one.

7. Hold down SHIFT + CTRL to align both tangent handles.

13.6.4 To Adjust the Curvature at a Point on a B-Spline Curve

Every point has a pull factor which determines how close the curve gets to the point.

1. Select a shape from the Layers list.
2. Select the Contents tab and then the Points tab.
3. Select the Move Points tool.

4. Hold down CTRL and drag a point up/down/left/right to adjust the pull factor at that point.

13.6.5 To Add Points

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Points tab.
3. Select the Add Points tool.

4. Click on the shape outline to add a point.

5. Hold down CTRL to insert the new point equidistant from its neighbors. After clicking you can drag the new
point to position it. You can also add points with the Move Points tool selected by holding down ALT.
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13.6.6 To Delete Points

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Points tab.
3. Select the Delete Points tool.

4. Click a point to delete it.

13.6.7 To Soften the Edge of a Shape

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Points tab.

3. Select the Shape Edge tool.

4. Drag to extend a second outline around the section of the shape you want to soften. The edge of the shape
fades smoothly between the two boundaries.

Copyright © 2025 Vizrt Page 246



Viz World Classic User Guide - 24.1

13.7 Defining the Appearance of Shapes

The options on the Properties panel allow you to adjust the fill and outline styles of the shape, apply a texture to a
shape, change its opacity and softness, transform it numerically, or add a drop shadow:

Shape I Paints | Properties IAnimation I Display|

[> Appearance

P Transform

=[] Drop Shadow
£>["| Motion Blur
> Producer Export

This section contains information on the following topics:

e Appearance Options

¢ Transform Options

¢ Drop Shadow Options (not Rotoshapes)
* Motion Blur Options

13.7.1 Appearance Options
Shape | Points | Propetties | Animation | Display |

' Appearance -
Style [Default Area Shape v] K
Settings
Opacity r m =
Softness 0 ,W =
Soften Fill Mask [
Write On Amount W Y%

The Style pop-up menu lets you select a style for the shape.
Use the Opacity and Softness controls to adjust the opacity of the shape and the softness of its edge.

The Write On Amount allows you to animate the appearance of a line shape, such as to indicate the route of a
journey. The line is animated from the starting point to the ending point with precise interpolation between points.

To Define a Shape Style
Click the Settings button. The Settings dialog box is displayed.
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To Draw a Shape with a Brushed Outline

1. Choose Brushed from the Style pop-up menu.
2. Click the Settings button to select the brush to use.

To Fill a Shape with the Background Image

Choose Merge from the Style context menu.

To Add a Texture to a Shape

Viz World Classic User Guide - 24.1

1. Click the + button in the Settings dialog box to display an Open dialog box, and select a texture.

2. Select the texture from the Texture context menu.

3. Use the buttons to the right of the Texture context menu on the Settings dialog box to move or scale the

texture. The texture is used as a fill for the shape.

13.7.2 Transform Options
Shape | Paints | Properties | Animation | Display |

W Transform -
Position X | 13100 5 Y | 33000
Scale X 100 | Y 1.00
Rotation L(,O:)U- 000 = 4
I_\AaFch Rotation to [
Origin X | 13100 5 Y | 33000

t> | Drop Shadow -

Allows you to transform the shape numerically.

13.7.3 Drop Shadow Options (not Rotoshapes)
Shape | Points | Properties IAnimation] Displayl

> Transform 2
V|| Drop Shadow

Offset X[ 3002 v[ 300
Opacity N lTso
Softness W ’72
Color -

£>[~] Motion Blur 4
> Producer Export IL

Select Drop Shadow to turn on a drop shadow for the shape.

The following parameters are provided:
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Offset: The offset of the drop shadow, in pixels.
Opacity: The opacity of the drop shadow. 0% gives no drop shadow.

Softness: Blurs the drop shadow to smooth the edges. Values in the range 0-5 are recommended.

Color: The color of the drop shadow.

13.7.4 Motion Blur Options

Shape | Points | Properties IAnimationl Displayl
FITANSTOT

=[] Drop Shadow i
¥ [ Motion Blur

Blur Before 0 0.00 =

Blur After 0 1.00 =

Shutter Angle ' 5 360.00

Shutter Phase £ | 180.00 = =
> Producer Export AV

Adds motion blur before and/or after a shape.
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13.8 Animating Shapes

{ Shape ] Points l Properties} Animation [ Displaﬂ

Edit Shape Path (31 Next Shape Key B Aol Track Data
Edit Points Path srShaee ey e

Match rotation to path

(] Smooth New Paints on Shape Path
[ ] Automatically Fix Shapes

[Fix Shape ] [Flemove Keys Show Keybars...

The options on the Animation panel allow you to animate individual shapes on a shape layer. This panel is not
available for shape overlays.

¢ Edit Shape Path: Enables you to edit the shape’s path by adjusting the points on the path (for example, the
start and end points).

¢ Edit Points Path: Enables you to edit the shape’s points (for example, giving the shape another shape
during the animation).

¢ Next Shape Key: Jumps to the shape’s next keyframe.

¢ Prev Shape Key: Jumps to the shape’s previous keyframe.

¢ Apply Track Data: Applies a tracking path to a layer in your project.

¢ Auto Animate: Enables you to set animation properties like slide in/out and fade on/off.

¢ Match rotation to path: Enables the object’s rotation to follow the direction of the path.

¢ Smooth New Points on Shape Path: Converts an angle point to a smooth curve point on a shape path.

¢ Automatically Fix Shapes: Automatically makes the current frame a key frame for every point on the shape.

¢ Fix Shape: Adds a keyframe (for example, to an animated path).

* Remove Keys: Removes a keyframe. Use the Next Shape and Prev Shape keys to jump between the
keyframes.

¢ Show Keybars: Opens the Shape Keybars editor. This allows you to edit the shape’s animation properties
(for example, transformation) on its timeline.

This section contains information on the following procedures:

® To Fix a Shape

® To Remove the Keys

¢ To Animate an Individual Shape

* To Animate Individual Points on a Shape
¢ To Show the Keybars for a Shape

13.8.1 ToFixa Shape

1. Select a shape from the Layers list.
2. Select the Contents tab and then the Animation tab.
3. Click the Fix Shape button. This makes the current frame a key frame for every point on the shape.
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13.8.2 To Remove the Keys

1. Select a shape from the Layers list.
2. Select the Contents tab and then the Animation tab.
3. Click the Remove Keys button. This removes all keys for the current frame.

13.8.3 To Animate an Individual Shape

!

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Animation tab.

3. Select the shape in the Shapes list.

4, Select the Edit Shape Path tool.

5. Open the Animation Controls and set the marker where the animation should end (for example, 50 fps).

6. Drag the center of the shape to define its path throughout the animation.

7. Hold down CTRL and drag from a point on the animation path to extend tangent handles from that point
and create a curved animation path.

13.8.4 To Animate Individual Points on a Shape
L

F

1. Select a shape from the Layers list.

2. Select the Contents tab and then the Animation tab.

3. Select a shape in the Shapes list.

4, Select the Edit Points Path tool.

5. Drag the points to the positions you want them to have at each frame of the animation.
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6. Hold down CTRL and drag from a point on the animation path to extend tangent handles from that point
and create a curved animation path. The keys for individual points are not displayed in the Keybars panel.

13.8.5 To Show the Keybars for a Shape

1. Select the shape in the Shapes list.

2. Click the Show Keybars... button on the Animation panel. The Shape Keybars window shows a keybar for
each shape in the Shapes list. You can click the arrow to the right of each shape to show a Transform bar
showing the transformations applied to the entire shape, followed by a keybar for each point on the shape:
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Shaze Keybar &

@ L Pori: 0 =

() Seleciad Ports v

| Pediton _ 7 [ U =
Rotaten - 4 |3

5 15 5 35 45 §5 65 75 85

CREINEE=

3. Select All Points to include a keybar for every point in the Shapes list, or Selected Points to show only
selected points on those shapes. The Shape Keybars window works in the same way as the Keybars panel;
for more information see the Using the Keybars Panel section.
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13.9 Specifying How Shapes are Displayed

The options on the Display panel allow you to specify how shapes are displayed while they are edited:

| Shape I Paints | Properties I Animationl Display I

Editor Display -
Outline Selected Handle
Points Al Handles
[ Number Points Tangents
Pull Values Fill Points & Handles at Key Frames
_ [] Small Points & Handles
Shape Display -
Dutlines
Finished Shapes

Use the Editor Display options to specify which features of a shape are displayed during editing.

The Fill Points & Handles at Key Frames option displays each point filled if the frame is a key frame for that point,
and is only available for shape layers.

Use the Shape Display options to specify how shapes are normally displayed.

Click the Tool Colors... button to define the colors for the editing features:

Tool Colors =]
Guides L Path ! Tracking Outline !
Outline ! Tangent |- Tracking Pin [
Handle ! Position L Detail |
Selected Handle [ — Rotation | | Selected Detail !
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13.10 Setting the Shape Layer Properties

Properties | Contents | Paint | Lighting | Layer Fx | Keybars |

Match ratation to path

Reset [ Transformation ]

[ Transtomation animation |

[> Compositing Options Automation Map Usage

[> Transf i
ransform . Pin on map

> [] Drop Shadow e

> Trail @ Apply Track Data ' i

Reset

Use Style Sheet

[Politjcal

*)

The options on the Properties panel allow you to specify the compositing options for the shape layer, transform it,
and add a drop shadow, or animation trail. It also provides several animation options.

This section contains information on the following topics:

* Compositing Options
® Transform Options

¢ Drop Shadow Options
® Trail Options

13.10.1 Compositing Options

¥ Compositing Options
Blend Mode

| Normal v|

Opacity
Obey Composite Mask [

0 | 100%

-~

v

¢ Blend Mode: Specifies how the layer is combined with the other layers, and can be one of:

e Normal

e Add

e Subtract

e Difference
® Multiply

® Darken Only
* Burn

e Color Burn
® Screen

¢ Lighten Only
¢ Dodge

® Color Dodge
* Hue

e Saturation
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* Value
¢ Color
¢ Overlay
* Soft Light
* Hard Light
* Pin Light
e Exclusion
* Negation
¢ Opacity: Determines the layer opacity, and can be animated.
¢ Obey Composite Mask: Specifies whether the current layer should obey the composite mask.

For more information see Controlling Layer Compositing.

13.10.2 Transform Options

V Transform -
Position X | 38399 = | Y | 28801
Pinned on Map ]
Wrap on Map L8
L4

Scale X 100 = v 1.00 =

Scale with Map

Rotation k(JO:)U' 000 =
Match Rotation to [
Layer Origin X | 384.00 : Y | 288.00 : =

These allow you to specify the position, rotation, scale, and origin of the entire shape layer numerically.

These options behave in exactly the same way as for image layers.

13.10.3 Drop Shadow Options

V|| Drop Shadow
Offset X[ 3002 v[ 3002
Opacity s 060 =
Softness 5 ,72 A
Color -

Select Drop Shadow to turn on a drop shadow for the layer. The following parameters are provided:

* Offset: Sets the offset of the drop shadow, in pixels.

* Opacity: Sets the opacity of the drop shadow. 0% gives no drop shadow.

¢ Softness: Blurs the drop shadow to smooth the edges. Values in the range 0-5 are recommended.
¢ Color: Sets the color of the drop shadow.
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13.10.4 Trail Options

WV Trail
Trail Width N, 5.00
Trail Color .|
Trail [Off v]
Trail Above [

The Trail options allow you to leave a trail as the shape layer animates. For more information see Leaving an
Animation Trail.

Copyright © 2025 Vizrt Page 257



Viz World Classic User Guide - 24.1

13.11 Adding Shape Overlays to a Map Layer

As well as constructing drawings out of shapes in separate shape layers, you can also add shape overlays to map
layers. Shapes drawn on a map layer appear in the Details list on the layer’s Contents panel and are referred to as
shape overlays. They include all the same features as shapes drawn in shape layers with some extra features that
make them particularly useful for highlighting areas on maps:

* You can draw shape overlays by automatically tracing borders, coastlines, built-in roads and railways, or

imported lines on the map.

® You can clip shape overlays to the land, so that any areas overlapping the sea are effectively transparent.
* You can choose to draw shape overlays as land, water, relief, road, rail, or imported data to give the shape
exactly the same scale and appearance as the corresponding features.

This section contains information on the following procedures:

¢ To Define the Properties of Shape Overlays
To Draw Shape Overlays as Land, Water, etc.

To Clip a Shape Overlay to Land
To Draw Shapes by Tracing Map Features
To Zoom or Pan while Tracing

13.11.1 To Define the Properties of Shape Overlays

1.

Select the shape in the Details list.

2. Click the Shape tab to display the properties for the selected shape:

Details

Style Sheet [political

v ] Map Features

ﬁé New York, New York Co... Place
g New York Selected Region(+)
&> Shapel Defaul...a Shape(+)

[ Scale labels with map [E] E] Override Style (+] ...

[Style ]F'roper!ies] Shape ’Symbol‘

) Line Open @) Closed
© Area @ Cut hole in layer
[Draw using style v] [ Clip to land

Write on % | 100,00 -

Softness  0.00 = [ Mask

Smoothing |
Drop Shadow... | []0On

The options are the same as for shapes in shape layers, with the addition of Draw using style, Clip to land, and the
edit tools of Shape, Points and Animation. All are described in the following sections.

13.11.2 To Draw Shape Overlays as Land, Water, etc.

¢ Choose the appropriate option from the drop-down menu:

¢ Treat as Land: Colors the land and relief.

* Treat as Water: Colors the sea and depth contours.

e Draw with Border line width: Scales with region borders.

¢ Draw with Road/ Rail line width: Scales with built-in roads/railways.
¢ Draw with Imported Data line width: Scales with imported data.
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For example you can use a shape set to Treat as Land to mark out an area of a particular terrain type, such as
desert:

13.11.3 To Clip a Shape Overlay to Land

Area of hurricane

oNew York
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Area of hurricane

il

oNew York

¢ Select the shape detail in the Details list and select Clip to land in the Shape panel.

13.11.4 To Draw Shapes by Tracing Map Features

A\ Note: You can only trace features on the map once the high quality rendering of the map layer has
completed.

1. Select the map layer on which you want to create the shape.

2. Select the Add Point Shape tool and click the arrow to the right of the tool to display a submenu of options
for the tool:

Properties | Contents | paint | Liahting

+

Explor (= Polygen

= L* Trace borders & coastline
D E] ‘L’:Trace global roads & rail

35| Ne ‘X{Trace river lines
(| e " Trace streets/imported da

Press ESC if you want to cancel the submenu without making a selection.
3. Select Trace borders & coastline, Trace global roads & rail, Trace river lines, or Trace streets/imported
data according to which features on the map you want to trace.
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A\ Note: River tracing cannot be used on rivers that are wide enough to be drawn as area shapes rather than
simple lines.

4. Move the mouse pointer near the feature you are tracing; for example, the coastline or border between
regions.
* The mouse pointer changes shape (cuts the tail) to show that the border has been detected:

oNew York

5. Click to create a point, and then move to the next point along the border you are tracing.
¢ Aline indicates the outline of the shape being traced. If the line being traced follows the wrong path,
take smaller steps between points.
e Asyou are drawing the shape you can use the Add Point Shape tool to turn tracing on or off, or
change the feature being traced, to achieve exactly the effect you want.

6. Finally complete the shape in the usual way, by clicking on the starting point to create an area shape, or
clicking (for example, double-click) again on the previous point to create an open shape:
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o New York

o New York

Once you have traced the shape, you can edit it or transform it in exactly the same way as for other shapes
you draw.

13.11.5 To Zoom or Pan while Tracing

You can only trace areas of the map that are actually visible on the screen, but if necessary you can zoom or pan the
map while you are tracing to change the part of the map that is in view

1. Type Z to temporarily select the Zoom tool or P to temporarily select the Pan tool while you are tracing.
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2. Press either key again to switch back to the Add Point Shape tool.
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13.12 Animating Shape Layers

In addition to being able to animate individual shapes, you can animate the complete set of shapes on the shape
layer as a single entity.

This is useful if you have constructed a complex illustration from a number of separate shapes and want to animate
it as if it were a single object.

Each shape can be given its own animation path with control over the following features:

* Opacity

* Drop shadow opacity

¢ Offset color and softness
® Position

* Rotation

e Scale

* Write on amount

¢ Softness

13.12.1 To Auto-animate the Entire Shape Layer

Click the Auto Animate button on the Properties panel for the shape layer, or select the shape layer in the Layers
list and click Auto-Animate... on the Layer menu.

The Automatic Animation dialog box allows you to automatically slide in, slide out, fade on, and/or fade off the
shape layer with specified timings.

For more information about using the automatic animation dialog box see section Automatically Animating a Layer.

13.12.2 To Animate the Entire Shape Layer

1. Select the Path tool:
2. Drag the shape layer to the position you want it to have at each frame of the animation.
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3. Hold down CTRL and drag from a point on the animation path to extend tangent handles from that point
and create a curved animation path:

° Tip: If you are creating a small graphic draw it in the center of the shape layer, as this makes its position
correspond to the points on the animation path.
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13.13 Shape Tools

The following shape tools are provided for drawing shapes on shape layers, and overlays on map layers:

. New Polygon: Straight lines and polygons.
U New Bezier: Smooth Bezier.

. New B-Spline: Smooth B-Spline.

. New Freehand: Freehand shapes.

. New Circle: Circles.

+
. New Ellipse: Ellipses and circles.
-+
. New Rectangle: Rectangles and squares.

A\ Note: All shape tools are available to map layers; however, not all features of all tools are (for example, the

Points editor).

As you are drawing a shape a floating palette gives you options for completing the shape:

Shape [
Finish
Shape As:

Area

N ’

Closed Line

: Open Line

: Delete Last

Cancel

¢ Alternatively, to cancel drawing a shape press the ESC key.

For more information about using each of these shape tools see the following procedures:
¢ To Draw a Polygon, Bezier, or B-Spline Shape
® To Complete the Shape to Make an Area Shape
® To Complete the Shape to Make a Line Shape
® To Draw a Freehand Shape
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® To Draw a Geometric Shape

13.13.1 To Draw a Polygon, Bezier, or B-Spline Shape

& + A
1. Select the New Polygon (), New Bezier (), or New B-Spline () tool:
2. Click at the appropriate position to draw each point. As you draw the points, the shape is shown as straight
line segments (New Polygon tool), smooth Bezier curves (New Bezier tool), or B-Spline curves (New B-Spline
tool) determined by the point positions:

The points are drawn in red with the two endpoints highlighted in yellow by default.

13.13.2 To Complete the Shape to Make an Area Shape

Either click the Area button in the floating Shape palette or right-click and select Make Area Shape from the
appearing context menu:

Make Area Shape
Make Open Line Shape
Make Closed Line Shape

Remove Last Point

Remove All Points

v Auto Complete Shape

Clear Selection

Clear Selection

® The shape is closed and displayed, drawn with the current area style:
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13.13.3 To Complete the Shape to Make a Line Shape

Either click again on the last point you drew, or:

e Click the Closed Line or Open Line button in the floating Shape palette, or
* Right-click the shape and select Make Open Line Shape or Make Closed Line Shape from the appearing
context menu. The shape is drawn with the current line style:

13.13.4 To Draw a Freehand Shape

+
1. Select the New Freehand () tool button.
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2. Hold down the mouse button and drag to create the shape you want to draw:

3. Click Points tab and select Move Points. As you drag, points are added as necessary to create the shape you
are drawing.

4. Complete the shape as for drawing a point shape. The freehand shape is converted to an equivalent Bezier
curve that uses as few points as possible.

A\ Note: The Points tab is not available when drawing shapes on map layers.

13.13.5 To Draw a Geometric Shape

+

+ +
1. Select the New Circle (), New Ellipse (), or New Rectangle () tool.
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2. When using the New Ellipse or New Rectangle tool, hold down CTRL to constrain the shape to a circle or
square:

When you release the mouse button the shape is filled with the current area style.
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14 Working with ESRI Shape Files

This section explains how to import map data in ESRI Shape File format and configure it for use with your maps.

Although the Street Data format provides a more convenient way of creating street maps, a wide range of published
data is available in ESRI Shape File format, and Viz World Classic allows you to import this data and configure it for
use with your maps.

Viz World Classic supports ESRI Shape File format data in which the text and field data are encoded in an extended
range of formats, including UTF-16 and various language-specific encodings including some Japanese, Hebrew, and
Arabic encodings.

You can specify the encoding for each field of imported shape file data, allowing maps to be created in many
different languages.

This section contains information on the following topics:

e Setting up ESRI Shape File Data
® Using ESRI Shape File Data

See Also

¢ Working with Street Maps
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14.1 Setting up ESRI Shape File Data

Data in ESRI Shape File format may contain a large number of different attributes and values which describe the
data contained in the file. For Viz World Classic to understand how to draw the data, you first need to create a data
set definition that describes which features are to be drawn and in which style.

This section contains information on the following procedures:

® To Create a Data Set Definition

To Edit the Data Set

To Add Subsets to a Data Layer

To Define the Style for Data Layers or Subsets

14.1.1 To Create a Data Set Definition
1. On the Import menu, click Map Data (Shape Files)... to display the Imported Data Sets dialog box.

2. Click the Create a Data Set Definition () button.
The following dialog box allows you to select an existing data set definition as the basis for the new one:

New Data Set Definition (23]

Data Set Definitions descibe how imported map data should be used. You should
place the new data set definition in the same directory as the data files it will use.

Filename for new data set definition:
C:\Vizrt Software\Viz Curious Maps\Europe.cid

@ Create a new, empty data set definition
_) Base on the following data set definition:

USA -

4 ;

0K ] [ Cancel

3. Click the Browse... button to specify the filename for the new data set definition.
If you want to base the data set definition on an existing one:

1. Click Base on the following data set definition and select a definition in the list.
2. Click the OK button to create the new data set definition. It is displayed in the Imported Data Sets dialog
box.
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14.1.2 To Edit the Data Set

Edit Data Set: C:\Program Files (x86)\Curious Software\Curious World Maps\SharedData\TWC\Roads\roads.cid
Data layers and subsets: How to draw selected layer or subset:
Eédd Data Layerg =)-USA [Draw layer with selected style v]
- States
Add Subset .- Borders Style for drawing selected layer or subset:
Unselected Land &
Selected Region
= Lakes E
Rivers
Ice Bl
— Building AL
Nafaids Avma Clhamn

Style for individual features from layer or subset:

Sea
Unselected Land =
Selected Region
Lakes

Rivers

Ice

Parkland
Building i

Nafaidd Avmm Chome

Line Thickness for layer or subset:

Scale by: 1.00

>

m

>

S5

[ Change Data Folder... ] [ 0K H Cancel ] _?l

1. Select the data set definition in the Data Sets list.

2. Click the Edit Data Set Definition button. The Edit Data Set dialog box allows you to edit the data set
definition.

3. Click the Add Data Layer button.
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'ﬂ Open

Look in: , StateShape

ps

i Name

-~

=)
- 0 E

Date modified Type

e {TUS STATES, DETAILED.shp

06.01.2009 07:14 SHP File

Recent Places

Desktop

Libraries
A

Computer

@

< | n

Network

File name: US_STATES_DETAILED shp

v Open

Files of type: [Shape Data (*.shp;”.csf)

[ Cancel ]

)

4, Select the data file you want to add. Supported file formats are .shp (Shape File) and .csf (Curious Shape
File). The Data File Properties dialog box then allows you to specify how the features in the data file you

have loaded are labeled on the map.
# | Data File Properties: States

Use this window to set up which data fields are used for labelling
features, and which fields are used to split data into subsets.

-

=

Filename:

Feature Type: Polygons/éreas
[ Land Areas

Icon:

-] @

C:\Program Files (x86)\Curious Software\Curious World Maj
Encodings: | Field Settings...

Fields used to label features:

[STATENAME ~ v| + [Nothing -

)

+ [Nothing

Join multiple seaments into single feature
v
Field used to split features into subsets:

v] Test Field

Using | Label

| STATE_NAME

2| o]

5. Choose up to three fields from the Fields used to label features drop-down menus. Each street is labeled

with the specified field values.

6. Click the Field Settings... button to display the following dialog box, which allows you to specify the

encodings for each field in the file:
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Data field settings for: US_STATES_DETAILED.shp (23]

Use this window to set up the data types for the fields in US_STATES_DETAILED .shp
Note that chanaing the field types may affect other data sets using this data.

Fields:

AVG_SIZEB7 A~ Data Type: Text

CROP_ACRS87 i

AVG_SALES7 Name Encoding: [UTF-S v]
SHAPE_AREA Dt Encoding

SHAPE LEN ata Encoding: [UTF-S ,]

SU6 REGIO
SUB_REGION View field...
STATE_ABBR a —

7. Select one or more fields in the Fields list, then choose the relevant encodings from the Name Encoding and
Data Encoding pop-up menus. You can preview the effect of the encodings by clicking the View field...
button.

8. Click the Close button to save the data layer in the data set definition.

14.1.3 To Add Subsets to a Data Layer

You can create subsets of a database file based on the contents of a specified field. This allows you to filter the
database, and display each subset in a different style.

1. Open the Data File Properties dialog box and choose the field you want to use to divide the database into
subsets from the Field used to split features into subsets drop-down menu. For example, to divide states
according to east and west coast states.

2. Click the Close button to close the Data File Properties dialog box.

3. Select the appropriate data layer in the Edit Data Set dialog box.

4. Click the Add Subset button.
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o ™

States subset: dividing up States using STATE_NAME @

Subset Name; East Coast

e

"ALABAMA™

"ALASKA™

"ARIZONA™

"ARKANSAS™

"CALIFORNIA™

"COLORADO"

"CONNECTICUT"

‘DELAWARE" -

S ——

Select strings from the list above, or enter them manually here:

"CONNECTICUT™ -
‘DELAWARE"
‘FLORIDA"™
"GEORGIA" —
‘MAINE"

"MARYLAND"

"MASSACHUSETTS”™

"NEW HAMPSHIRE"™ Y

m

The upper list shows all the available values in the data file.
The lower list shows which values will be included in this subset.

([ [

¢ The following dialog box displays a list of the available values for the specified field in the data file
and allows you to select values to create the subset.
5. Select the values you want to use in the upper list and click the + button to add them to the lower list.
6. Hold down SHIFT to select multiple contiguous items, and CTRL to select multiple non-contiguous items.
For example, to create a subset containing only the East Coast states you could select and add those.
7. Enter a name for the subset in the Subset Name field.
8. Click the OK button to save the subset definition.

14.1.4 To Define the Style for Data Layers or Subsets

You can define a separate style for each data layer or subset you have created, to distinguish them on the final map.

1. Select the data layer or subset in the Edit Data Set dialog box.

2. Select Draw layer with selected style from the How to draw selected layer or subset drop-down menu.

3. Select the styles for drawing the selected layer or subset, and the style for drawing individual features, in the
lists on the right side of the Edit Data Set dialog box:

Copyright © 2025 Vizrt Page 276



Viz World Classic User Guide - 24.1

Edit Data Set: C:\Program Files (x86)\Curious Software\Curious World Maps\SharedData\TWC\Roads\roads.cid @
Data layers and subsets: How to draw selected layer or subset:
Add Data Layer = USA Draw layer with selected style v
[=)-States Draw layer with selected style
Add Subset ‘.- East Coast Treat polygons/areas as Land
-Borders Treat polygons/areas/lines as Rivers

Sort Subsets Treat polygons/areas as Lakes

Treat polygons/areas as Sea

Properties...
Lakes =

Rivers
Ice
Rename Parkland
Building e

Nnfmidd Aemn Chmmn

Delete

il

Style for individual features from layer or subset:

Sea -
Unselected Land
Selected Region
Lakes

Rivers

Ice

Parkland
Building L

Nafaidi Acan Chann

Line Thickness for layer or subset:

Scale by: 1.00

m

o (oo ) 2]

* Appropriate styles are listed in the Style lists depending on whether the type of the layer is Area,
Line, or Point.

¢ Alternatively, select Draw polygons/areas as Land, Draw polygons/area/lines as Rivers, Draw
polygons/areas as Lakes or Draw polygons/areas as Sea from the How to draw selected layer or
subset drop-down menu to treat the selected layer in the same way as the built-in land, rivers, lakes
or sea respectively.

¢ The Scale by box allows you to scale the line thickness defined by the style. For example, you can
identify different types of roads by using the same Primary Roads style but different Scale by

settings for the line thickness.
4. Enter a value to scale the line thickness and press the RETURN key.
5. Repeat for any other data layer or subsets.

See Also

* How to edit any of the styles using the Styles Editor in the Working with Styles section
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14.2 Using ESRI Shape File Data
Once you have created a data set definition, you can use this to load the ESRI Shape File data with the attributes
you have specified.
This section contains information on the following procedures:
* To Load a Data Set Definition
¢ To Load the Data

® To Use Imported Map Data
® To Add Labels to Imported Data Features

14.2.1 To Load a Data Set Definition

Imported Data Sets @
?

BN 2

D‘{ Add a Data Set i

Europe (data not loaded)

Definition File for selected Data Set:
C:\Program Files (x86)\Curious Software\Curious World Maps\Shared|

| Always load the data for this set on startup

Close

1. On the Import menu, click Map Data (Shape files)... and click the Add a Data Set button.
2. Select the data set definition file and click the Open button to load it. The data set is displayed in the Data

Sets list.
3. Click the Close button to close the dialog box.
Once you have added a data set, it is remembered for future use of Viz World Classic, so there is no need to add the
data set to the list every time you start the software. If you want the data for the data set to be loaded automatically
on start-up you can select the Always load the data for this set on startup box.
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14.2.2 To Load the Data

Adding a data set to Viz World Classic does not load the map data by default. This prevents very large data sets
being loaded before you are ready to use them. You can instruct Viz World Classic to automatically load the data for
a set, in the Import Data Sets dialog box (see how Using ESRI Shape File Data#To load a data set definition), or you
can load the data manually when you need it as follows:

1. Click the Imported Data tab in the map layer’s Contents panel to display the data sets you have imported.
The data set definitions are shown in the left list.

‘Explorer| Search | Streets | Imported Data | Overlays

Find Find
=-USA €4 CONNECTICUT, USA -
B-States @ DELAWARE, USA
IR™ £ast Coast ~
‘... Borders Load Data % USA
UnLoad Data USA
SA
Add to map D. USA
Fit map USETTS, USA v
[ ] Visible Data Center map m

2. Click the data set you want to import with the right mouse button and select Load Data from the appearing
context menu.

You can unload a data set (for example to free up some memory to load a different set) at any time by clicking the
set with the right mouse button and choosing UnLoad Data from the appearing context menu.

14.2.3 To Use Imported Map Data

You can expand the tree to show the data layers and subsets for each data set.

1. Select the data layer or subset in the Imported Data list to show the features it contains.

2. Click each data layer, subset, or feature with the right mouse button and select Add to map from the
appearing context menu, or click the Add To Map button to add it to the map layer.
You can also search for imported features in the Search panel, in exactly the same way as for built-in map
data.

14.2.4 To Add Labels to Imported Data Features

Initially the features in imported data are drawn unlabeled, but you can add labels to selected features to label
them on the map just as you would with other map details.

a;gi:

1. Select the Browse Imported Data tool.
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BOSTON AND MAINE RAILROAD

As you move this over the map the tool tip shows you the name of each imported data feature.

New Label...
Filter

Add BOSTON AND MAINE RAILROAD m
Label BOSTON AND MAINE RAILROAD

Clear Selection

2. Right-click a‘n'd from the appearinﬁ context menu click the appropriate label option.

‘V
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If you are labeling a street, the label is drawn aligned with the direction of the street. You can then use the
Text tool to move or rotate the label as desired.

Copyright © 2025 Vizrt Page 281



Viz World Classic User Guide - 24.1

15 Adding Text to a Project

Each map detail you select in your project is automatically provided with a text label, pinned to the map. Viz World
Classic also allows you to add independent text layers to the project, each containing one or more separate text
items, with precise control over the appearance of each item and the way in which they are animated. For example,
you could use a text object to add a title to the animation, add legends to graphics incorporated in the animation,
or label map features not provided in the map database.

You could also use a text label to label a map detail instead of the default label provided with the detail, for greater
control over its appearance and the way it is animated.

Viz World Classic allows you to use any of the TrueType fonts installed on your computer and supports text in many
international character sets. You can change the font used in the Viz World Classic user interface to ensure that the
international character set you are using is displayed correctly.

This section contains information on the following topics:

® Creating Text on a Text Layer

® Manipulating Text Items

Editing Text

Defining the Appearance of Text Items

* Animating Text Items

Defining the Properties of the Entire Text Layer
Defining the Text Layout
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15.1 Creating Text on a Text Layer

Properties | Contents | Paint | Lighting | Layer Fx | Keybars |

Edt | Layout | Properties | Animation |
R‘:;’ Text (vial v 16 _I Item Properties
Manhattan -

©) Filed ©) Dutline
Stroke Width : 5 E]

T Keyline Width : 5
Default Font < ) Y [B

) Uniform Color
(E> Manhattan
&=

This section contains information on the following procedures:

® To Create Text on a Text Layer
¢ To Create Additional Text Items
¢ To Define the Default Text Properties

15.1.1 To Create Text on a Text Layer

1. On the Layer menu, point to Add Layer, and then click Text.

2. Click in the Viewer to define the position of the text item. Alternatively you can drag to define the width of
the text item.

3. Type the text you want to add:

O

Bl
[u]
a

] =.
Blanhattan

Kings County
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15.1.2 To Create Additional Text Items

1. Select the New Text Item tool on the Contents panel.
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2. Click or drag in the Viewer and type the text. The text items are displayed in the text items list.

To enter international characters not shown on the keyboard, such as accented characters, use the standard
procedure for your computer system. Once you have created one or more text items on a text layer you can edit

them or change their appearance using the panels on the Contents panel.

15.1.3 To Define the Default Text Properties

Default Text Layer Properties

These properties are used as defaults
when a new Text Layer is created.

Aial ~|16 ~ (B[]

Additional Character Spacing  0.00

Additional Line Spacing  0.00 -5

Color I

The quick brown fox jumps
over the lazy dog

&

On the Styles menu, click Default Text Properties. The above dialog box allows you to specify the default font,

size, style, spacing and color for new text layers.
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15.2 Manipulating Text Items

15.2.1 To Move Text

1. Select the Text tool (&) button in the toolbar. This tool is automatically selected when you create a new
text item.
2. Drag the text by the position handle.

15.2.2 To Resize a Text Item

Drag one of the handles on each side of the text item. The text is wrapped to fit in the text item.
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15.3 Editing Text

Edit | Layout | Properties | Animation |

[Arial v] 16 . . _l _l Itemn Properties
Manhattan . . . .

@ Filled ) Outline
Stroke Width : 5 [E]
~  KeylineWidth:5  [»)

("] Uniform Color

The options on the Edit panel (depicted above) allow you to edit the font, size, style, and color of selected
characters, change the alignment of the text, and edit the stroke and keyline widths.

This section contains information on the following procedures:

To Edit the Text

® To Specify Text Alignment

To Create Outlined Characters

To Add a Keyline around Characters

15.3.1 To Editthe Text
Either:

Select by marking the characters you want to edit in the Viewer.

Or:

Select the characters in the Edit panel.

Or:

Select the entire text by clicking the Select All () button in the Edit panel.
Select the font, size, style, fill color, and outline color using the controls at the top of the Edit panel.

15.3.2 To Specify Text Alignment
Click the appropriate button to the top right of the Edit panel.

15.3.3 To Create Outlined Characters

1. Select the Outline option.
2. Choose the stroke width from the Stroke Width pop-up menu. The character outlines are drawn with the
specified stroke width in the fill/outline color.
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You can specify the fill and keyline colors individually for each character in a text item. Alternatively selecting
Uniform Color makes all the letters have the same color. When Uniform Color is selected the text color can be
animated.

15.3.4 To Add a Keyline around Characters

1. Choose the keyline width from the Keyline Width pop-up menu.
2. Select the characters you want to edit in the Viewer, or on the Edit panel, and click the keyline color box to
specify the keyline color for the selected characters.

With filled characters the keyline is drawn as an outline around the characters:

Jeather -

With outlined characters the keyline is drawn as a double line around the outlines.
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15.4 Defining the Appearance of Text Items

The options on the Properties panel allow you to specify, the appearance of individual text items, including the
compositing options, spacing, transformation, drop shadow, frame, or animation trail:

6t Loyou] Piopeties | Animaion

[> Appearance |4
[> Spacing ‘:
> Transform

| Drop Shadow

> Frame

> Trail

> Producer Export

[*> Inctant Manc Fynart

This section contains information on the following topics:

® Appearance Options
® Spacing Options

* Transform Options

¢ Drop Shadow Options
* Frame Options

® Trail Options

® [nstant Maps Export

15.4.1 Appearance Options
% Appearance
.o [Solid ~]
Brushies,.. I
Texture INone L‘ il E‘ B
Opacity —— J mﬂ

Softness ); 0.00==

] I T T T B | : —.I
Write On Style Characters j

Write On Amount J I 100.00 _|::'

The Appearance options allow you to specify the rendering style of the text, apply a texture to the text, and
animate its writing.

To fill the text with a texture choose Solid from the Style pop-up menu, and click the + button to select an image
file for use as the texture:
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-
-

% ;,&m E’""“ 9—\r~f
v ’\”f w G ING E 144

v - 3 el

Weather

Use the Opacity and Softness controls to adjust the opacity of the text, and blur the edges of the text.

The Write On options (text layers only) allow you to animate the way in which the text appears, to cause it to
appear to be typed on as the animation progresses.

¢ Choose Characters from the Write On Style pop-up menu to make the text appear character by character,
or Words to make it appear word by word.
¢ Set the Write On Amountto O atthe frame where you want the animation to begin,andto 100 atthe

frame where you want the animation to end.

15.4.2 Spacing Options

% Spacing
Character Spacing — ')‘ — U.UDE
Line Spacing ')‘ 0.00 E

The Spacing options allow you to adjust the character and line spacing for the text item.

15.4.3 Transform Options

% Transform

Position X | ?? ﬁ Y 77 ﬁ
Additional Scal = o

Rotation U+U” Iiz
[Do] 7‘? —.l

Match Rotation to Path r

Width J | ??EII

Origin = 30,66 = [North ~]

The transform options allow you to specify the position, scale, rotation, and origin numerically. The Origin
determines the point about which the text item is rotated or scaled, and defaults to North, or the top center of the
text item.

Choose one of the predefined options from the Origin pop-up menu, or edit the X and Y origin values to specify the
origin in pixels relative to the lower left corner of the text item.
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15.4.4 Drop Shadow Options
V[~ Drop Shadow

Drop Shadow Offset I 300 ::Il I .3.00 ::jl

Drop Shadow Opacity — I)‘ — mﬂ
Drop Shadow Softness : } — 2 _:l
Drop Shadow Color !'
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Select Drop Shadow to turn on a drop shadow for the text item. The following parameters are provided:

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the drop shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the range 0-5 are
recommended.

Color The color of the drop shadow.

15.4.5 Frame Options

% Frame
Backaround Fill Color

Border Color

Border Width } I 0.00 _|::I

Text Margin ); 0.00 —|

Allows you to add a colored fill, and/or border to the text item.

Border Width specifies the width of the border in pixels.

15.4.6 Trail Options

YV Trail
Trail Width -} 'ﬁg
Trail Color |
Trail ID" j

Trail Above r

The Trail options allow you to leave a trail as the text item animates.
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15.4.7 Instant Maps Export

V Instant Maps Export |
Editable in Instant L

Allows you to make maps available to the Viz World Instant Map tool.

See Also

¢ Leaving an Animation Trail
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15.5 Animating Text Items

| Edit | Layout | Properties | Animation |

Match rotation to path

Auto Animate @ Apply Track Data
Edit Text Path

The options on the Animation panel allow you to animate text items on text layers.
See Also

¢ Match rotation to path and how To Align the Image, Text Item, or Drawing to the Angle of the Animation
Path

¢ Auto Animate and Automatically Animating a Layer

¢ Edit Text Path and Animating an Image, Movie, Text Item, or Drawing Along a Path

® Creating Tracking Paths
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15.6 Defining the Properties of the Entire Text Layer
Properties |
> Compositing Options ~Automation—————————— —MapUsage

gm.&m E| Poonmep

| Match sotation to path B o™ Ao |

In addition to being able to define the properties of individual text items, the Properties panel allows you to edit
properties for an entire text layer.

15.6.1 Compositing Options
% Compositing Options
Blend Mode IN p— j

Opacity J l_:l1 00% _:I

Obey Composite Mask r

Blend Mode specifies how the layer is combined with the other layers, and can be one of:

e Normal

e Add/Subtract

¢ Difference

® Multiply

* Darken Only

e Burn/Color Burn

® Screen

e Lighten Only

* Dodge/Color Dodge
* Hue

e Saturation

* Value

e Color

e Overlay

¢ Soft/Hard/Pin Light
e Exclusion

* Negation.

The Opacity determines the layer opacity, and can be animated.

15.6.2 Animation Options

Allows you to animate the entire text layer. The options are the same as for individual text items.
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15.7 Defining the Text Layout

Edit | Lavout | Properties | Animation |

Move Text ’ﬁlign *} ‘
Text Kering {Space Evenly > ‘

The options on the Layout panel (depicted above) allow you to move, scale, or rotate a text item, adjust the
kerning, or align or space evenly multiple text items.

This section contains information on the following procedures:

* To Move a Text Item

To Scale Text

To Rotate Text

To Adjust the Letter Spacing

To Align Several Text Items

To Space Several Text Items Evenly

15.7.1 To Move a Text Item

1. Select the Move Text tool (@I) button.
2. Position the mouse pointer within the text item.
3. Drag the text item to the new position:

t]
_________________ I3
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This allows you to move a text item even if the position handle is out of view.

15.7.2 To Scale Text

1. Select the Move Text tool (@J) button.
2. Drag one of the handles on the border of the text item:

3. Drag while holding down CTRL to scale the text proportionally.

15.7.3 To Rotate Text

1. Select the Move Text tool (@J) button.
2. Point to the rotation handle, the yellow circle to the right of the center of the text item.
3. Drag the handle to rotate the text item about its center:
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15.7.4 To Adjust the Letter Spacing

1. Select the Text Kerning tool. The Viewer indicates the position of each character by a marker on the
baseline:

Weekend Weather

2. Drag a marker to the left or right to adjust the spacing between the corresponding characters.
3. When you have finished kerning the text, click the Text Kerning tool again.

° Tip: You can reset the default kerning of the text by clicking the Reset button.

15.7.5 To Align Several Text Items
Edit | Layout | Propetties | Animation|

Move Text Align > Left edges
Text Keming Right edges

Tops

Bottoms
Horizontal centers

Vertical centers

1. Select at least two text items in the list, using SHIFT to select multiple items.
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2. Choose the appropriate alignment option from the Align context menu (see above).

15.7.6 To Space Several Text Items Evenly

Edit | Lavout | Properties | Animation |

Move Text Align 3
Text Keming Across

Down

1. Select at least three text items in the list, using SHIFT to select multiple items.
2. Choose the appropriate alignment option from the Space Evenly context menu.

Copyright © 2025 Vizrt Page 297



Viz World Classic User Guide - 24.1

16 Working with Cutouts

Viz World Classic allows you to cut out a selected area from the Viewer to create an image overlay called a cutout.
You can use a cutout to paint onto an image or its mask, or you can convert one or more cutouts to a new image/
movie layer.

This chapter contains information on the following topic(s):

® Creating Cutouts
® Moving and Transforming Cutouts
¢ Defining the Appearance of Cutouts
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16.1 Creating Cutouts

[ Brushes [ Graphics I Shapes] Text | Cutouts [Fx ] Image I Mask ] Mecros}

New Cutout Overlays @ Al () Just: Cutouts Layout 'Propetties]
=

Cut: Move Cutout Use for Brush
Image (V] Mask [ Use for Profile
From:
Layer @ Composite ) Save Image...

Background Removal Flip Vertical

9 None

D Atometic Flip Horizontal

~) Assume Color Convert To Layer

L D) (o) | Commisine]

16.1.1 To Cut a Section of an Image
1. Select Cut: Image.

2. Select the New Cutout tool ( A ) button.

3. Select From: Layer to create a cutout from just the current layer, or From: Composite to create a cutout
from the composited layers.

4. Drag to draw a rectangle defining the size of the cutout you want to create:

The cutout is displayed in the Overlay list on the Cutouts panel:
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5.You can then drag the cutout to displace it from the original image, or display it on another layer:

16.1.2 To Cut an Object Defined by a Mask

1. Draw a mask over the part of the image you want to cut out:
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For more information see Specifying the Brush Settings.
2. Select Cut: Image and Cut: Mask.

3. Select the New Cutout (1 : ) tool button. Selecting Cut: Mask uses the image’s mask to cut out the image

from its background.
4. Drag to draw a rectangle defining the size of the cutout you want to create, enclosing the image:

The Move Cutout tool is automatically selected so you can drag the cutout to see it independently of the
original image:
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When using Cut: Mask, the Background removal options can be used to remove edge effects around the mask.

Assume Color allows you to specify a color to be removed from the edge of the mask, and Automatic uses the
average color within the cutout rectangle, but outside the mask.

16.1.3 To Create a Cutout Using the Magic Wand Tool

If the feature you want to cut out is clearly distinguished from its background, you can use the Magic Wand tool to
mask the feature, and then create a cutout using the mask.

1. On the Graphics panel click the Magic Wand tool:
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Flood Fill

—

“s*| Flood Fill Tolerance

? Fill to color !l —{t

Antialias

# | Magic Wand

Display Mask is automatically selected in the paint controls to show the mask when you create it.
2. Click the feature you want to mask. If necessary, adjust the Tolerance control and click again with the Magic

Wand tool until the feature is completely masked:

3. On the Cutouts panel select Cut: Image and Cut: Mask.

4. Select the New Cutout tool.
5. Drag to draw a rectangle enclosing the feature:

6. Drag the cutout to see it independently of the original image:
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16.1.4 To Stick a Cutout to an Image/Movie Layer

1. Select the cutout in the Overlay list.
2. Click the Stick button.
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16.2 Moving and Transforming Cutouts

The options on the Layout panel allow you to move, scale, or rotate cutouts, or use them in other ways:

Layout | Properties
B R Use for Brush

Use for Profile

Save Image...

Flip Vertical
Flip Horizontal
Convert To Layer

16.2.1 To Move a Cutout

Select the Move Cutout tool. You can then move, scale, or rotate the cutout in exactly the same way as for images;
see Moving, Resizing, or Rotating an Image.

16.2.2 To Flip a Cutout about the Vertical or Horizontal Axis
Click the Flip Vertical or Flip Horizontal button.

16.2.3 To Convert a Cutout to a Layer

1. Select the cutout in the Overlay list.
2. Click the Convert to Layer button. A new image/movie layer is created, above the current layer, containing
the cutout.

16.2.4 To Use a Cutout for a Brush or Profile

Click the Use for Brush or Use for Profile button. The cutout appears in the Brushes or Profile list on the Brushes
panel.

16.2.5 To Save a Cutout as an Image
Click the Save Image... button. You can save it in any of the standard image formats.
See Also

* Moving, Resizing, or Rotating an Image
® To Load a Cutout for Use as a Brush or Profile
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16.3 Defining the Appearance of Cutouts

The options on the Properties panel allow you to define the style, opacity, and softness of cutouts, add a drop
shadow, and specify a transformation numerically:

Properties I

> Appearance
> Transform
¥ ["] Drop Shadow

Offset x[ 3000 v[ 305
Opacity ‘ o [ 060 2
Softness &N, ,—2 =
Color -

16.3.1 Appearance Options
Properties l

V Appearance
Style [Image v]
Fill Color |
Opacity : r 1.00 =
Softness (B 0.00

> Transform
"] Drop Shadow

The Appearance options allow you to specify the style of the cutout, and change its opacity or softness. Set the
Style to Color to convert the cutout to a solid color, and use Fill Color to define the color. This is useful for creating
shadows.

16.3.2 Transform Options
Properties |

[> Appearance
¥V Transform

Position X | 51250 = Y | 50850 =

Scale X 100 = VY 1.00 =

i U+u =

Rotation G (0:] 000 =

Origin Type X | 4200 = Y | 3800 = [Center -
=[] Drop Shadow
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These allow you to specify the position, scale, rotation, and origin numerically. The Origin determines the point
about which the cutout is rotated or scaled, and defaults to Center.

Either:
¢ Choose one of the predefined options from the Origin context menu.
Or:

e Edit the X and Y origin values to specify the origin in pixels relative to the lower left corner of the cutout.

16.3.3 Drop Shadow Options
Properties ’

[> Appearance
> Transform
V|| Drop Shadow

Offset X 300 = Y | -3.00 =

Opacity (5 0.60

Softness r 2
Color !l

Select Drop Shadow to turn on a drop shadow for the cutout.
The following parameters are provided:

e Offset: Sets the offset of the drop shadow, in pixels.
e Opacity: Sets the opacity of the drop shadow. 0% gives no drop shadow.

* Softness: Blurs the drop shadow to smooth the edges. Values in the range ©-5 are recommended.
¢ Color: Determines the color of the drop shadow.
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17 Lighting and Effects

Viz World Classic includes sophisticated lighting features and effects, to enable you to add shading and depth to
your map animations, and give them a unique and distinctive appearance.

This section contains information on the following topics:

® Using Lighting

Setting the Lighting Options

Changing the Position, Size, or Angle of the Light
* Animating a Light

Using Style Lights

Add Image Effects to a Layer
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17.1 Using Lighting

Each of the map, image, text or shape layers in your project can include one or more lights which you can use to
focus the viewer’s attention, or add depth and perspective to the animation. Three different types of light are
provided, and you can use these either individually or in combination to achieve a wide range of different effects.

¢ Highlight: Gives the appearance of a light reflecting from a shiny surface.

¢ Spotlight: Casts a concentrated disc of light, with areas outside the beam remaining dark.

e Diffuse light: Casts a diffuse disc of light, falling away gradually to the edges. For each type of light you can
adjust the size and shape of the beam, the position, brightness, and color of the light.
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* Combining lights: Impressive effects can be achieved by combining two or more lights on a single layer. For
example, the image above uses a highlight combined with a diffuse light.
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17.2 Setting the Lighting Options

{ Properties I Contents | Paint ] Lighting ’LayerFx Keybars
Light

Lighting on Light 1 v V] Switch On Pin on map X 9251
Tpe
i #» o M Scale with map Y 3945

Ambient Level Color | Width 13.85

{
Revert to Style Brightness

| frge 100

4 4/

>

4

Height 1385 =

The Lighting panel allows you to create and edit the lights on each layer.

17.2.1 ToAdd a Light to a Layer

1. Select the layer and click the Lighting tab to display the lighting options for the layer. Initially lighting is
turned off, and no lights are defined.

2. Select Lighting on to turn lighting on for the layer.

3. Click the Add button to add a light to the layer. A new light is created with a default name, such as Light1.

4. Choose Highlight, Spotlight, or Diffuse from the Type drop-down menu to specify the type of light.

5. Use the Brightness control to adjust the brightness of the light.

6. Use the Ambient Level control to adjust the background light level. This determines the brightness of parts
of the layer that are not directly illuminated by one of the lights.

For map layers:

¢ Click the Pin on map or Scale with map buttons to move and/or scale the light as the map layer is moved or
zoomed.
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17.3 Changingthe Position, Size, or Angle of the Light

When you add a light, the Light () tool is selected in the Lighting panel to allow you to move, scale, or rotate the
light. The extent of the light is shown as a circle:

17.3.1 To Move the Light

Position the mouse pointer anywhere within the circle and drag the light to the required position.

17.3.2 To Change the Size of the Beam

Drag the outline of the surrounding circle.

17.3.3 To Stretch the Beam in One Direction

Drag the light by one of the four handles on the surrounding circle:
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17.3.4 To Change the Angle of the Light

Drag the handle extending from the center of the circle:

17.3.5 To Specify the Parameters of a Light Numerically
Edit the X, Y, Width, Height, and Angle values in the Lighting panel.
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17.4 Animating a Light

The Light Path tool () allows you to manipulate the animation path along which a light is animated.
See Also

* Animating an Image, Movie, Text Item, or Drawing Along a Path
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17.5 Using Style Lights

You can make a particular combination of lights part of your house style by defining the lights in the Lighting panel
of the Styles Editor. Any lights you define there are automatically applied to each map layer, with the names Style
light 1, Style light 2, etc.

You can modify the characteristics of each style light within a particular layer to override the settings defined in the
style sheet.

17.5.1 To Revert Style Lights to Stylesheet-defined Settings
Click the Revert to Style or Revert All to Style buttons in the Lighting panel for the layer.
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17.6 Add Image Effects to a Layer

[ Properties [ Contents ] Paint ] Lighting] Layer Fx IKeybars}

[#- Backgrounds - Blur -
- Blurs Tint Color

(+- Color Correctors Brightness/Contrast Tint Amount € 0% =
[+- Distort o =
[+- Effects = Keep Highlights C 0% =
[+- Filters E] B> Shadows

[+- Grain I

- Obsolete o

- — I> Highlights

(- Sharpen E] Sl

[#- Transition =
4. n » E]

17.6.1 To Apply One or More Image Effects to a Layer

1. Select the layer.
2. Click the Layer Fx tab to display the Layer Fx panel for the layer.

Every parameter of an effect can be animated. For more information see the Using the Keybars Panel section.

17.6.2 To Add an Effect to a Layer

1. Click the arrow symbol to the left of a heading in the effects list to expand the list, and show the effects
under that heading.

2. Select the filter and click the right arrow button to add it to the right-hand list of effects to be applied to the
layer.

Each effect displays a set of controls to allow you to adjust its parameters.

17.6.3 To Determine the Order of Effects

The order of effects in the list determines the order in which they are applied. Select an effect in the right-hand list
and click the UP ARROW or DOWN ARROW buttons to move it up or down in the list.

17.6.4 Layer Fx

The following layer effects are available:

Softness }

Blur

¢ Softness: Softens the layer, giving it an out-of-focus appearance.
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Brightness J I 100 _I;

Contrast J I 100 _|::I

Gamma — I 1.00 __lzjl

Saturation J I 100 _I;
Brightness/Contrast

¢ Brightness: Adjusts the brightness, where 0.00 corresponds to normal brightness.
e Contrast: Adjusts the contrast of the layer, where 0.00 corresponds to normal contrast.
¢ Gamma: Adjusts the gamma of the layer, where 0.00 corresponds to normal gamma.

e Saturation: Adjusts the color saturation of the layer, where 0.00 corresponds to normal saturation.

Tint Color -|
Tint Amount J; 0% =
Keep Highlights | 0% =3
[> Shadows
[> Midtones
[> Highlights

Tint

Applies a tint color to the layer. The Tint Amount control allows you to adjust the degree of the tint.

Copyright © 2025 Vizrt Page 317



Viz World Classic User Guide - 24.1

18 Controlling Animation

This section explains how to use the time slider to control the progress of an animation. It also describes how to use
the Automatic Animation tool to set up impressive animations with a few simple clicks, and the Keybars panel to
provide individual control over each component of a project.

This section contains information on the following topics:

® Using the Animation Controls

¢ Automatically Animating a Layer

Using the Keybars Panel

Getting Natural Motion

¢ Displaying Detailed Information About a Feature

¢ Animating an Image, Movie, Text Item, or Drawing Along a Path
® | eaving an Animation Trail
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18.1 Usingthe Animation Controls
] (> ) m ][] (@] ) ][] 00000124 Duation 00:00:02:00

00:00:00:00 .

@ Timecode () Frames @ @ @

44 00:00:01:29

The Animation controls allow you to choose which frame of the animation you are editing, and let you preview the
finished project.

This section contains information on the following procedures:

® To Specify the Time Display Format

¢ To Move to a Specific Frame

® To Move Frame by Frame

* To Move to the Start or End of the Animation
® To Move to the Next or Previous Key

® To Expand the Slider Scale

¢ To Show the Whole Project

® To Select Continuous Playback

18.1.1 To Specify the Time Display Format
Choose the format as follows:

* Format: Description
¢ Timecode: Hour:Minute:Second:Frame.
* Frames: Frame number.

18.1.2 To Move to a Specific Frame

Either edit the Current frame field: 50 Duration 60 = ULZEEE0 AT

Or drag the time slider until the appropriate frame is displayed in the Current frame field:

34
v

18.1.3 To Move Frame by Frame

[‘_lJ &J Click the Step back or Step forward buttons.

18.1.4 To Move to the Start or End of the Animation

I

« @J Click the Start or End buttons.
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18.1.5 To Move to the Next or Previous Key

KA

Click the Next Key or Previous Key button in the Animation controls.

° Tip: A key is a frame in which one or more properties have been edited.

18.1.6 To Expand the Slider Scale

1. Click the Range... button.
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2. Select Part of project, and specify the Start time, and the End time or Duration, of the section of the

roject you want to work on:

Frame Range b
) Whole project
@ Part of project
Start 0
End 33
Duration 100
tMatch Movie
[ 0K ] [ Cancel ]

3. Click the OK button.

18.1.7 To Show the Whole Project

e Click the Slider Range button.

¢ Select Whole project and click the OK button.

18.1.8 To Select Continuous Playback

¢ Click the Loop Play (@) button to play repeatedly, restarting at frame 0 after the last frame.

-

¢ Click the Bounce Play () button to play continuously, alternately forward and backwards.
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18.2 Automatically Animating a Layer

Viz World Classic includes an automatic animation tool, to make it easy for you to add animation to any layer of
your project.

It provides the following animations:

¢ Slide: Allows you to slide the layer on and/or off in any direction horizontally, vertically, or diagonally.
¢ Fade: Allows you to fade the layer on and/or off.
¢ Write on: In addition, for text layers, you can animate the text so that it writes on, in characters or words.

This section contains information on the following procedures:

* To Automatically Animate a Layer

® To Animate the Position of the Layer
¢ To Animate the Opacity of the Layer
¢ To Animate the Writing of Text

18.2.1 To Automatically Animate a Layer

Click on the Layer () button to select the layer you want to animate.
Either:
e On the Layer menu, click Auto Animate.

Or:

1. Click the Properties tab to display the Properties panel for the layer.
2. In the Automation section click the Auto Animate button:
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Automatic Animation @
Slide
|| Slide to current position [ Slide from current position
From | Left v To | Right v
00:00:00:00 Time 00:00:03:24
Cushion movement
Fade
[ Fade on [ Fade off
00:00:00:00 Time 00:00:03:24
[] Cushion fade
Write On

Wiite on | Characters

00:00:00:00 Time 00:00:03:24
‘Wam if overwriting keys 0K { [ Cancel ] _?l

o
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The Automatic Animation dialog box is displayed to allow you to specify how you want the layer to be animated:

18.2.2 To Animate the Position of the Layer

Slide
Slide to current position Slide from current position
From | Left v To | Right v

-7

{

0 Time 99

Cushion movement

1. Select Layer from the main menu and then Add Layer > Map.
2. Select the Properties tab and click the Auto Animate button.

3. In the Slide frame select Slide to current position and/or Slide from current position and choose the

direction of the slide from the From and/or To drop-down menus.
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4. Drag the keys on the time scale to adjust the extent of the slide. In the central white section, the layer is
static at its current position, and in the black sections to the left of the first key or to right of the last key the
entire contents of the layer are outside the image layer.

5. Select Cushion movement to include a smooth run-in and run-out.

18.2.3 To Animate the Opacity of the Layer

Fade

V| Fade on Fade off
0 Time 99
[ JiCushion fade

1. Select Layer from the main menu and then Add Layer > Map.

2. Select the Properties tab and click the Auto Animate button.

3. Select Fade on and/or Fade off.

4. Drag the keys on the time scale to change the rate the fade occurs. The white central area corresponds to
100% opacity and the black regions to the left of the first key and to the right of the last key correspond to
0% opacity.

5. Select Cushion fade to include a smooth run-in and run-out.

18.2.4 To Animate the Writing of Text
Write On

V] Wiite on | Words v

L T P

0 Time 99

. Select Layer from the main menu and then Add Layer > Text.

. Select the Contents tab and enable the New Text Item button and add a text to the layer.

. Click the Animation tab and click the Auto Animate button.

. Select Write on, and choose Characters or Words from the drop-down menu to specify how the text should

be written.

5. Drag the keys on the time scale to determine the rate at which the text is written on:
The white section to the right of the right most key corresponds to all the text written on, and the black
section to the left of the left most key corresponds to 0%.

6. Click the OK button to set up the animations you have specified for the layer.

A WN =

Auto animate automatically sets up the Opacity, Position, and Write on amount (text layers only).
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18.3 Using the Keybars Panel

Properties I Contents [ Paint | Lighting [ Layer Fx| Keybars

tornado.png 7 -
Compositing Options v
Opadity | M 2
Obey Composite Mask _
_Transform il
Position Iu T ———
X 331.00000 } — — i
Y 527.00000

For each layer in a project, the Keybars panel shows a keybar for each of the features that can be animated,
grouped into categories such as Compositing Options, Transform, Drop Shadow, and Trail. You can click the
arrow to the right of each layer or category heading to collapse it into a single bar, or expand it to show the keybar
for each feature.

The animations in each layer are summarized in an overview bar, and this allows you to move or scale the whole
layer’s animation in a single operation.

Each category also provides an overview bar, and you can use this to scale or move all the animations in that
category.

In image layers containing a movie the overview bar also shows the extent of the movie, and you can drag this to
change the start time of the movie.

This section contains information on the following procedures:
® To Display the Keybars List
® To Collapse or Expand the Keybars List
* To Move the Animation for a Layer or Category
® To Scale the Animation for a Layer or Category
* To Add a Key
¢ To Change the Position of a Key
® To Cut, Copy, Paste, or Delete a Key
® To Delete All Keys on a Keybar
¢ To Delete All Keys for a Layer

18.3.1 To Display the Keybars List
Click the Keybars tab.

18.3.2 To Collapse or Expand the Keybars List

Click the triangle to the right of the layer name or category name. Selecting a layer automatically collapses the
keybars for the other layers.

18.3.3 To Move the Animation for a Layer or Category

Drag the layer or category overview bar.
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18.3.4 To Scale the Animation for a Layer or Category

Drag the yellow triangle at either end of the layer or category overview bar.

18.3.5 ToAdd a Key

Either:

¢ Right-click the keybar and click Add Key on the pop-up menu:

Or:

Clear Bar [!

(slearn Layer

Cut
Copy
Haste
Delete

Start here
Hold frame befare start
Hold frame atterend

[Loop Movie

Smooth In
Smooth Out
Smooth Both

Smooth Segment

Ease In

Ease Out
Ease Both
Ease Segment

1. Click to position the marker where you want to add the key.

2. Click the Add Key (

il) button:
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A key is also added automatically at the current frame position, when you change the setting of any feature that can
be animated.
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18.3.6 To Change the Position of a Key
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f

4 4

4

¥

i

Drag it along the keybar with the mouse pointer. The cushion bars on either side of the key are scaled in proportion

to the distance to the key and the keys on either side.

18.3.7 To Cut, Copy, Paste, or Delete a Key

Either:

¢ Click on the key with the right mouse button and click the appropriate command on the pop-up menu:

Or:

1. Click the key to select it. The key turns red.

Add Key
Clear Bar

[Sleanllaver

Cut
Copy

Faste

Start here

Hold frame Gefare start
Hold rame atenend
Loop MoeyiE

Smooth In
Smooth Out
Smooth Both
Smooth Segment

Easeln

Ease Out
Ease Both
Ease Segment

2. Click the appropriate button:
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The cushion bars for the keys on either side are reset to their default positions.

18.3.8 To Delete All Keys on a Keybar
Either:

* Click the keybar with the right mouse button and click Clear Bar on the pop-up menu.

Or:
1. Click to position the marker in the keybar you want to clear.

2. Click the Clear Bar (EI) button.

18.3.9 To Delete All Keys for a Layer

Click any keybar with the right mouse button and click Clear Layer on the pop-up menu.
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18.4 Getting Natural Motion

By default, Viz World Classic causes objects to move with a smoothly varying speed between keyframes. You can
apply Smooth In/Out or Ease In/Out animation options to any key to achieve a more gradual acceleration or
deceleration.

The following table summarizes the differences between the options:

¢ Smooth In/Out: The rate of change of the property is constant through the key.

¢ Ease In/Out:The rate of change of the property is stationary through the key.
For example, if the property being animated is an object’s position, with Ease InfOut the object slows down
to a halt at the key, but with Smooth In/Out the object is moving with constant velocity through the key.

You can extend the cushion bars to increase the time either side of the key during which the object moves with
constant velocity (Smooth In/Out) or decelerates and accelerates (Ease In/Out).

18.4.1 To Cushion Animation
Either:

¢ Click in the Keybars panel with the right mouse button and click the appropriate Smooth or Ease option on
the pop-up menu:
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Sdd ey
Delete Key
(sleanBar
[sleaniaver

Start here

Hold frame Gerere start
Hold freme atenend
oo Mevie

Smooth In
Smooth Out

| Smooioh )

Easeln
Ease Out
Ease Both

Or:

1. Click the key to select it. The key turns red.
2. Click the appropriate button in the toolbar:

) Ll P e

If you click on a key you can smooth or ease either or both handles for the key.

If you click between two keys you can smooth or ease the appropriate handles for both keys.

18.4.2 To Adjust the Cushion Bars

1. Point at the cushion bar with the mouse pointer, until the mouse pointer turns to a single-headed arrow.
2. Drag the cushion bar to the appropriate position between the two keys:

o 1 d 4

Each cushion bar can be dragged as far as the adjacent key.
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18.5 Displaying Detailed Information About a Feature

Kmar\sl
e neee————————uai -
Compositing Options > -
Transform v |
Center )|
Scale o
vale . 104.12305
—
p— = . ~|
P T O R

You can display a graph showing the change in the value of any feature throughout the animation. You can
manipulate the graph to change keys, cushion the animation, or add keys, as an alternative to working in the

keybar.

18.5.1 To Display the Detail Graph
Click the Detail (I&d) button to the right of the feature name. The keybar expands to show the detail graph.

18.5.2 To Return to Keybar View
Click the keybar (om) button to the right of the feature name.
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18.6 Animating an Image, Movie, Text Item, or Drawing Along a Path

Viz World Classic allows you to draw a smooth path, using Bezier curves, and animate an imported image, movie,
text item, or drawing on a shape layer along the path.

This section contains information on the following topics:

* To Create an Animation Path

® To Convert the Path to a Curve

¢ To Adjust the Path

* To Align the Image, Text Item, or Drawing to the Angle of the Animation Path

18.6.1 To Create an Animation Path

1. Move to the first frame of the animation.
2. Select the Path tool and drag the image, text item, or drawing to the initial location:

3. Move to the last frame of the animation.
4. Drag the image, text item, or drawing to the ending position. A line is drawn to show the animation path,

with dots indicating the position in each frame:
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18.6.2 To Convert the Path to a Curve

1. Move to an intermediate frame of the animation.
2. Drag the image, text item, or drawing. The path curves through the new position.
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18.6.3 To Adjust the Path

1. Drag one end of the tangent handles extending from a point on the curve:
2. Hold down CTRL to drag a tangent handle independently of the other one.

18.6.4 To Align the Image, Text Item, or Drawing to the Angle of the Animation
Path

1. Click the Match rotation to path button on the Properties panel for the image, text, or shape layer:
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18.7 Leaving an Animation Trail

You can cause the map layer, text item on a text layer, image on an image/movie layer, or drawing on a shape layer
to leave a trail as it animates by choosing the appropriate option from the Trail drop-down menu in the Trail
section of the Properties panel for the layer.

For example, you could leave a trail behind an image of a plane to show the route of a journey:

18.7.1 To Leave an Animation Trail

¢ Choose Behind, Ahead or Full from the Trail pop-up menu to leave a trail behind, ahead of, or on both sides
of the path.

¢ Use the Trail Width and Trail Color options to define the width and color of the trail, and select Trail Above
to display the trail above the layer.
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19 Creating Tracking Paths

Viz World Classic includes a powerful tracking tool, which allows you to track features in a movie to create one or
more tracking paths. These can then be used to automatically stabilize the tracked feature, or to match the tracking
of another movie or image to that feature in creating a composite.

This section contains information on the following topics:

® Creating a Track
* Applying Tracking

The tracking tool lets you identify a distinctive feature in one frame of a movie, and then automatically track the
feature throughout the movie to create a tracking path.

19.1 Creating Tracking Paths

You can create any number of tracking paths in a single movie, or across multiple movies. One track is needed to
adjust for position, with two independent tracks the tracking tool can also adjust for scaling and rotation.

Additional tracks can be used to track independently moving objects. For example, if your video sequence shows
two cars driving towards each other you can create a separate tracking path for each car, and then use these to
superimpose a logo onto the side of each car.

You can also change the feature you are tracking mid-way through the movie. For example, if the feature goes out of
view or behind an obstacle you can select an alternative feature, and then continue tracking from that point.

19.2 Applying Tracking Paths
Having created a tracking path you can apply it in several ways:

* To the original movie to stabilize the image, keeping the tracked feature with the same position, scale, and
rotation on the frame. For example this can be used to stabilize an interview filmed with a hand-held
camera.

* To a differentimage or movie to animate it, matching the movement, scaling, and rotation of the selected
feature so that when the two sequences are composited they appear as a single, natural image.

* To the points and shapes in a rotomatte, to match their movement, scaling, and rotation to the original
movie.

* To the position parameters of filters and effects; for example, to make a wipe follow a feature in a movie.
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19.3 Creating a Track

Q\ On the Tools menu, click Tracker or click the Tracking button in the toolbar. The Tracker dialog box is
displayed to allow you to create one or more tracks.

19.3.1 ToCreatea Track

1. Click the + button to create a new track, and select it in the Tracks list.
2. Click the Edit Tracks button to indicate which feature of the image you want to track:
Tracker @

Tracks Tracking source area

X 467.00 2] widh 2000 2
Trackon [RGB ] ¥ 1000 2] Height 17.00 [

& Track point Search area
5 A\ % 467.00 = % 467.00 = Width 2000 =
Yy 1000 = v 1000 2 Height 2000 2
Rename... Presoftening 0.0 -5 -
| Rename... |
Sl pictaancs Track frames 0 - 53
[ Skip Bad Frames i Do Trackin
QIOICIO 2

Two concentric squares are drawn in the Viewer with a + at their center.

3. Move the mouse pointer over the center square until it changes to a move symbol and drag the squares over
the feature you want to track.

4. The center square acts as a magnifying glass to help you locate the feature accurately:

5. If necessary move the central + to the precise position you want to track. This is the pin position that
determines the precise offset generated by the track. Usually, you leave this at the center of the inner
square. The outer square determines the search area that the tracking tool scans at each frame when
looking for the feature you have specified. Its size should be sufficient to cover the maximum movement in
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any direction from any frame in the sequence to the next frame. It does not need to cover the area occupied
by the feature of interest throughout the whole sequence.

6. Adjust the Presoften value to blur the image before matching the target; this helps tracking if the image is
noisy, or includes a random feature such the rain.

19.3.2 To Start Tracking

Z
1. Click the Track Next Frame button to step forward a frame at a time, tracking the feature.

2. Click the Track Forward a button to start automatically tracking the feature from the current frame.

As tracking proceeds the Tracker dialog box plots a graph showing the quality of the track:

Higher values indicate a good match.

The tracking paths are shown in the Viewer as a white line with red dots at each track position:

19.3.3 To Correct a Tracking Path

The automatic tracking procedure may occasionally lose the feature being tracked. To correct for this:

1. Go to the last frame where the track was correct (or another earlier frame).

2. Hold down SHIFT and drag the tracking box. This leaves the tracking point itself unchanged, so that the
points added to the motion path continue on the same track, but it uses a different area for subsequent
detection. It is important to choose a different area which is moving in the same way.

7
3. Click the Track Forward @ button to continue tracking from that point. For example, if the feature being
tracked goes out of sight or behind another object, you need to select another feature to track. When
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tracking an actor’s eye it may be necessary to manually position the tracking tool if the actor blinks. You can
also track backwards or track the previous frame using the appropriate controls.

19.3.4 ToLockaTrack

Click the lock icon to the left of the track name in the Tracks list. This is useful once you are satisfied with a track, to
protect it from changes during subsequent tracking actions.
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19.4 Applying Tracking

After creating one or more tracking paths you can apply these to any layer in your project. In addition, in a shape

layer you can apply a tracking path to individual shapes in the layer.

19.4.1 To Stabilize a Movie

One application of tracking is to stabilize the movie that was used to generate the tracking path.

1. Select the movie layer in the Layers list, and click the Properties tab to display the Properties panel for the

movie .
2. In the Automation section click the Apply Track Data button:

* The Apply Track Data Wizard is displayed to lead you through the steps needed to apply the track

data to the image layer.

® The first panel lets you specify the transformations you want to track:

Apply Track Data Wizard

Do you want to apply tracking data in order to set:
Position, Rotation or Scale?

One track is sufficient for setting position.

Two points are required for scale or rotation.

Rotation
Scaling

V| Position
|

<<

? < Back 0K

Cancel

3. Select Position, Rotation, and/or Scaling as required, and click the Next button to continue. If you have
only recorded one track Rotation and Scaling are not available. The next panels let you select the tracks to

use.

4. Select the first track and click the Next button to continue. If you are adjusting rotation and/or scaling you

are prompted to select a second track.

5. Select the track and click the Next button to continue. The next panel lets you choose how the

transformations are applied:
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¢ Absolute: Aligns the pin position of the object with the current track position.
¢ Relative: Displaces the object by the track position.
¢ Stabilize: Applies the recorded tracks to the layer to stabilize it:

6. Click the OK button to apply the track information to the current image layer.
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20 Rendering a Project

This section explains how to render your project as a preview image or movie, or as a finished image or movie. It
also describes the options for exporting an image or a 3D model from a project.

This section contains information on the following topics:

® Rendering the Project

* Displaying a Live Video Output
¢ Exporting 3D Models

® Creating GIF Images
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20.1 Rendering the Project

Viz World Classic allows you to render your project as a movie or as a sequence of still images, one per frame, as
separate sequentially numbered files. Alternatively you can render a single layer, or its layer mask.

This section contains information on the following topics and procedures:

® Movie Formats
¢ Image Sequence Formats
® To Render the Animation
® To Specify the Output Format
® Frame Size
® Timing
* Format Options
¢ Field Render
® To Render a Single Layer

20.1.1 Movie Formats

The movie formats provide all the frames of the animation in a single file, optionally using compression to make the
file smaller and improve playback rates. A number of different movie formats are supported, some of which are
designed for playback on specific video output boards. The range of output formats available on your system
depends on the operating system, the version of Viz World Classic you are using, and the presence of any optional
video hardware.

Viz World Classic requires a QuickTime player for playing QuickTime movies on your computer monitor, and a Video
Output player which can play QuickTime movies on the video output of compatible QuickTime video boards. Other
video devices may be supplied with their own playback applications for movies rendered in their own native
formats.

20.1.2 Image Sequence Formats

The image sequence formats provide a sequence of numbered files, one frame per file (for example,
myanim0001.bmp, myanim0002.bmp etc.). The files can be in any of the formats supported by Viz World Classic. This
can be a very useful format for exchanging images with other applications, many of which support single frame per
file sequences.

When you first choose a file to render you are presented with a name untitled0000. This renders a sequence with
four digits for the frame number as above. If you want to change the number of digits, edit the name (for example,
untitled000 would use three digits for the frame number).

You can change the default filename format using the Numbering option in the File Formats section of the Options
dialog box:
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Options =]

- DEM g
Database
- Locations
- Attribution iUntitled0000 R
- Map Legend
- Map Projection
- Virtual Earth
- Digital Globe
Locations
=) File Formats
. Gif

-~ Numbering
[=)- Paint
Material
- Undo
“ Brush Tools
[=)- Storage

i RAM Limits

- Flipbook

i Video Board

Specify the default file name format when rendering to a sequence of
numbered files.

m

20.1.3 To Render the Animation

® On the File menu, click Render Project... or Render Project Preview....
* Render Project Preview: Renders a low-quality version without anti-aliasing, and with no lighting
effects.
¢ Render Project: Produces a finished, high-quality version of the animation.

The Render dialog box is displayed to allow you to specify the output format and filename for the rendered movie,
and specify the output settings:
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f Render & |

Output: | Quick Time Movie v

Movie: Browse ..

Seltings

Frame Sze.. | PAL (Video), 720x 576
. Timing... 4 Frame Rate 25.00fps

- . Using Raw RGB-RGBA codec
Format Options... | Render RGBA (Milions of Colors+) # supported by format

remultiphed alpha (matted on black

|| Fieid Render.. | No Field Rendesing, Ficker Fiter On

Render Range
© Whole Project
_) Skder Range
Part of the Project:

P

Stat | 00:00:00:00 End| 00:00.01:24 | Dy | 00:00:02:00

20.1.4 To Specify the Output Format

1. Choose the appropriate format from the Output dropdown menu.

2. Select Whole Project to render the whole project, or Part of the Project to render the range of frames
specified in the Start, End and Dur fields.

3. Click the Frame Size..., Timing..., Format Options..., or Field Render... buttons to set up the
corresponding options.

¢ To render with an alpha (mask) channel select Render RGBA Movie (Millions of Colors+) and specify
how the alpha channel should be treated by selecting one of the options from the drop-down menu.

¢ Premultiplied alpha effectively superimposes the image on a black background; transparent areas
of the image appear black, and semi-transparent areas of the image are mixed with black in
proportion with their transparency.

¢ Straight Alpha leaves the image unchanged.

4. Click the Render button to render the animation with the settings you have specified. While the animation is

being rendered the progress bar in Viz World Classic’s status bar shows the progress of each frame, and the
viewer shows the frame currently being rendered.

Frame Size

Allows you to set the frame size for the rendered movie:
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Height 1024
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The default project sizes in Viz World Classic are square pixel versions of the popular PAL and NTSC video formats,
suitable for displaying on a computer screen. When rendering final output Viz World Classic automatically scales the
output images to the corresponding video formats (PAL video, NTSC video) to ensure that the images continue to
look correct (video pixels are a different shape to computer pixels) on a video monitor. If you are outputting for
further manipulation or use on a computer (in another software package) you should deselect Scale correctly for

PAL (Video) output.

Timing

Allows you to set the frame rate for the rendered movie:

Render Timing Options

@ Use Project Frame Rate

Different Frame Rate

Rate 30 frames per second

—

=)

oK ] [ Cancel

Note that changing the frame rate does not change the total time of the animation. For example, rendering a 25 FPS
animation at 30 FPS simply generates more intermediate frames to ensure the animation plays out at the same

speed.

Format Options

Allows you to change the compression and quality settings for the movie. The options available depend on the
output format you have selected.

Field Render

Field rendering is a technique used to create smoother looking animations when creating output for video or
broadcast. It takes advantage of the fact that most video is interlaced, each frame consisting of two fields displayed

inturn:
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Field Rendering Options @

Field Rendering:

@) Full Frame [no field rendering)

(") Field Render: create fields by frame interpolation

Field Dominance | Lower/odd field first [NTSC Yideo] v

Lower/odd field first [NTSC Video
Flicker Filter Upper/even field first [PAL Videa] |

| oKk || cancel |

Enabling field rendering can produce a considerable improvement for certain types of animations, when played
back on suitable video equipment such as a video output board or video tape. Rendering times are significantly
increased however, as every frame requires two separate fields to be rendered and then combined. Animations for
playback on a computer are generally rendered without field rendering.

The Upper field first and Lower field first options determine the field ordering for the rendered output.

Animations rendered with incorrect field ordering can appear jumpy and distorted. The correct setting can vary
with your desired output type (PAL or NTSC) and the video equipment you are using.

The Flicker Filter option applies a small amount of softness to the rendered output. This can help to prevent slight
flickering which can sometimes be a side-effect of field rendering.

To Render a Single Layer

Rendering a layer outputs the layer as it appears in the project at project size, including the layer’s transformation
and any filters.

1. Select the layer you want to render.
2. On the Layer menu, click Render Layer... or Render Layer Preview....
3. Proceed as described in To Render the Animation.
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20.2 Displaying a Live Video Output

The image displayed in the Viewer can be transferred directly to the video outputs of supported video cards, for

previewing images on a broadcast monitor, or transferring single frame images directly to video.

20.2.1 To Select Live Video Output

1. On the Video menu, click Video Device setup.... The Video Board option in the Video section of the Options

dialog box is displayed:

Options

--DEM
- Database
Locations
- Attribution
- Map Legend
- Map Projection
- Virtual Earth
Digital Globe
- Locations
[=- File Formats

- Numbering
[+ Paint
- Material

i Brush Tools
[=- Storage

- R&M Limits

- Flipbook.

‘- Video Board

m

A video |/0 board can be used to show a live video preview, to play
movies, and to drive a video flipbook.

&

Video board to use [No Video Device

[V] Show live video output

[V]i&pply flicker filter to live video outpuk

2. Select your video board from the drop-down menu.
3. Select Show live video output.

The Apply flicker filter option adds a slight vertical blur to the image, to prevent flickering of very fine horizontal
images such as roads and rivers.
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20.3 Exporting 3D Models

An option is available to allow you to output a 3D model of the land relief in a specified 3D object file format to allow
you to import it into a suitable 3D package such as Maya, Softimage XS, 3D Studio Max, ORAD CyberGraphics, or
Discreet Frost. Alternatively you can export the 3D model to Viz Artist.

The texture can be output at the same time, to color the relief, and this can optionally be scaled up to provide more
detail on the resulting 3D model:

This section contains information on the following procedures:

® To Export the Currently Selected Map Layer as a 3D Model
® To Preview the 3D Model

20.3.1 To Export the Currently Selected Map Layer as a 3D Model

1. On the File menu, click Export 3D Model. The 3D Export dialog box allows you to specify the filenames for
the model and texture, and optionally preview the result in the 3D Viewer:
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[ 3D Export - Creates a 3D Model and associated texture of the current map @

30 Model Export
[V Expoit 3D Model Export 20 Modelto | Curious 30 Animator [¢3d) | ~ |

Model File  foo.c2d Browse...

Grid Resolution Smocthing
. 70 : Solten Shaipen

Y . —
S76 v || Allows Hesghts below Sea Level

Texture Export
[V Export Testure for Model Export Material Fle

File: Browse..

Foemat -

Seltings

Frame Size... | NTSC [Square Pirels A), 720 x 540
(e 4

Curious 30 Animator

|V’ Create Projgect | Export Labels Remove Labels from Texture
ararie e
| Preview Resut in 20 Anmator ' Espont | | Closs

. Select the 3D object file format from the Export 3D Model to drop-down menu.

. In the 3D Model Export section, click the Browse... button, and specify a name for the 3D model.

. If required, edit the Grid Resolution and Smoothing, to determine the mesh used for the 3D model.

. In the Texture Export section leave Export Texture for Model selected if you want to export a texture

bitmap, and select Export Material File if you also want to export the texture as a material file.

. Choose the format from the Format drop-down menu.
. Click the Browse... button, and specify a name for the texture file.

¢ The Frame Size... button gives you the option of scaling the image to a different frame size; for
example to provide greater detail on the resulting model. Note that this produces a true optical
scaling of the image, whereas changing the project size leaves features, such as road and river line
thicknesses, unchanged.

* For certain formats the Format Options... button gives you control over of the parameters of the
format.

. Select Preview Result in 3D Viewer to preview the exported files in a 3D viewer.
. Click the Export button to export the model.
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20.3.2 To Preview the 3D Model

If you checked Preview Result in 3D Viewer in the 3D Export dialog box, the 3D model is displayed in the 3D Viewer for
previewing.

1. Drag the model to change the viewpoint.

2. Hold down CTRL and drag up and down to zoom in and out respectively.

3. Hold down SHIFT and drag up and down to increase or decrease the scale of the relief.

4. Hold down ALT and drag left and right to rotate the model about the viewpoint.

5. Click the Play button in the toolbar, or choose Play from the File menu, to rotate the model continuously.
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¢ Platform Application

* PCFCoder 2GIF

20.4 Creating GIF Images

Viz World Classic cannot create or render GIF format images by default. It works with some commercially available
third-party GIF creation applications to allow creation of GIF images.

Supported applications are as follows:

* Mac Lemke Software Graphic Converter

20.4.1 To Set up Viz World Classic for GIF Image Creation

1. Purchase and install one of the supported GIF creation applications. If you are running Viz World Classic on
Windows, then you must specify the location of the 2GIF application.

2.0n the View menu, click Options....

3. In the File formats section click Gif.

4. Click the Browse... button and select the path of the 2GIF application:

Options

- DEM

- Database

- Locations

- Attribution
Map Legend

- Map Projection

- Wirtual Earth
Digital Globe

- Locations

[=- File For[nats

- Num e;ing
[=)- Paint
- Material
- Undo
i Brush Tools
[=- Storage
- R&M Limits
i Flipbook
- Video Board

m

&

Specify the location of the "2GIF" application here. This will be used ta

convert images to GIF format.

The GIF file format and associated options are then available in image save, export, and render windows.
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21 Working with Street Maps

Viz World Classic allows you to import street data for towns and cities, to create maps from the whole world down
to a single street corner or building. The Street Data format is supplied and configured with appropriate labels for
each of the features, and so using it is simply a matter of adding it to your map. Viz World Classic also supports map
data in ESRI Shape File format; for more information see the Working with ESRI Shape Files section.

This section contains information on the following topics:

® Using Street Data
¢ Loading Street Data
® Tracing Street Data

21.1 Using Street Data

A wide range of street data designed especially for use with Viz World Classic is available for most parts of the world
from Vizrt.

For more details, and to order, please contact your local Vizrt representative.

21.2 Loading Street Data

To use street data for a particular town or city you first need to install the street data into an appropriate directory
on your disk, and then add a license for the data. For more information about adding a license see the Installing Viz
World Classic section.

This section contains information on the following procedures:

¢ To Specify the Location of Street Data
To Load Street Data

To Use Street Data

To Display Street Data

To Highlight Individual Features

To Label a Feature

21.2.1 To Specify the Location of Street Data

When you install street data it is copied to the Street Data location specified in the Options dialog box. This is
initially set to a default location, but you can change it as follows:

1. On the View menu, click Options..., then click the Locations tab to display the Locations panel of
the Options dialog box. The Street Data field shows the directory used for street data files.

2. Click the corresponding Browse... button and select the appropriate location to change the directory used
for street data files.

21.2.2 To Load Street Data

1. On the Import menu, click Street Data... The Street Data Management dialog box shows the street data
sets you have available:
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Street Data Manager

The following street data sets are installed:
Display only sets which [ | are visible in the current map layer

Selected Set:

Concord, New Ham...hire Sample Data
¥ Japan-2009
¥ StreetData
¥ japan_09.02.01
aichi
akita
aomori
chiba
ehime
fukui
fukuoka

gifu
gunma
hiroshima
hokkaido
hyogo

Name En..ed |Loaded |Startup |

P

] Load Now
Unload Now

[ &lways load at start-up

Licenses:

Requires a CDataCSJP_FUKUSHIMA 9.02 license.

Your Standard license for this data expires in 179 days.

_?l Install More Data ...

Close

2. Click the Install More Data... button to install additional street data sets from disk or CD-ROM, or by
scanning the street data directory for new data. The following dialog box is displayed:

Street Data Installation

Street Data is installed in this directory:

C:\Program Files [x

Choose where to look for new data:

() Copy new data from some other directory or disk

\Curious Software\Curious World Maps\MapD ata\StreetData

&, Scan the directory where Street Data is already installed,
= to look for new data and to check for data which has been deleted

[ Cancel ] [ Scan Now

¢ Either select Copy new data from some other directory or disk, click the Choose Folder button,

and locate the source of the new data.

¢ Or select Scan the directory where Street Data is already installed ... to automatically locate new

data. Then select the data set you want to load and click the Load Now button.

° Tip: You can also select Always load at start-up to load the specified street data each time you run Viz

World Classic.

3. Repeat for any other street data sets you want to load.
4. Click the Close button to close the dialog box.
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1. Click the Streets tab in the map layer Contents panel to display the street data sets you have loaded.
2. Select the street data set in the left list to show the features it contains:

| Explorer | Search | Streets | Imported Data | Overlays |
Find Find
(=) Concord, New Hampshire Sampl » | |5 ‘_' BOUTON ST -
&-Roads _||[F> cenTraL ST L4
- Highways =
| Primary Roads || T DANIEL WEBSTER HWY
| Secondary Roads 1 DANIEL WEBSTERHWY
- Local Roads 47 DEPOT ST
5 i.. Other Roads i = DOVER RD
3. | andAMarke =
] v ||§T FISHERVILLE RD -
[ visible Data 4o [ visible [ﬂ B

3. Select which features you want to display from the pop-up menu below the features list. This includes

different road categories, railways, rivers and lakes, and a range of other urban features.

21.2.4 To Display Street Data

| Explorer | Search | Streets | Imported Data | Overlays |
Find Find
(= Concord, New Hampshire Sampl ~ “”“_' BOUTON ST -
& R?fdﬁm!! || [P centraLsT (3
~Primary R Add to map HWY
: Fit map jwY
; Other Rc Center map
< |% Load More Street Data... -
[ visible Data ) [ Visible Steet Data...| [y [+

e Click the street data set name with the right mouse button and click Fit map on the pop-up menu. The
street data is drawn, scaled to fit within the image window:
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A\ Note: The style sheet specified for the map layer determines which lakes, rivers, roads, and railways are
drawn on the map. You can override this for the current map layer by clicking the Map Features button in
the top right corner of the Contents panel.

21.2.5 To Highlight Individual Features

You can add a feature to the Details list so you can modify its appearance, to highlight it on the map.

Either:
¢ Select the feature in the features list and click the Add Feature To Details button.
Or:

e Click the feature with the right mouse button and click Add to map on the context menu:
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Properties | Contents | Paint | Lighting | Layer Fx | Keybars |

Explorer | Search | Streets | Imported DatalOverIays| Details Style Sheet
Find ]
EIA-C‘onmrd, New Hampshire Sampl »
R e E T CENTRAL ST @
E mg,R':ads T DANIEL WEBSTER HWY
. Secondary Roads 1 DANIEL WEBSTERHWY
~Local Roads S DEPOT ST
| -OtherRoads - |5 poverrD
3.1 andMarke =
(el I PHRLLED

[ visible Data ] visile X Scale abels with mep (&) ()

Area features, such as lakes and parks, are initially drawn with a label. Line features, such as roads and

rivers, are initially drawn unlabeled. You can add a label at a specific position as described in the next
section.

21.2.6 To Label a Feature
2

A

1. Select the Browse Street/Shape Data tool. As you move this over the map a tool-tip shows you the name of
each street data feature:

2. Click with the right mouse button and choose the appropriate label option from the pop-up menu:
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New Label...

Filter

Add BOUTON ST
Label BOUTON'ST |

Clear Selection

e Add: Adds the feature without a label, so you can highlight it by editing its style.
* Label: Adds the feature with the label positioned at the point you clicked. If you are labeling a line
feature the label will be drawn aligned with the direction of the feature.

3. Use the Text tool to move or rotate the label as desired.

21.3 Tracing Street Data

You can use the shape tools to trace street data in order to add lines and area shapes to your street maps.

For example, you could trace streets to draw a line shape showing the route of a carnival. Alternatively, you could
trace an area of a city to create an area shape showing a proposed traffic-free zone.
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See Also

® To Draw Shapes by Tracing Map Features
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